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Safety information

Important information

Read these instructions carefully and look at the equipment to become familiar 
with the device before trying to install, operate, service or maintain it. The 
following special messages may appear throughout this bulletin or on the 
equipment to warn of potential hazards or to call attention to information that 
clarifies or simplifies a procedure.

The addition of either symbol to a “Danger” or “Warning” safety label indicates that an 
electrical hazard exists which will result in personal injury if the instructions are not 
followed.

This is the safety alert symbol. It is used to alert you to potential personal injury hazards. 
Obey all safety messages that follow this symbol to avoid possible injury or death.

Please note

Electrical equipment should be installed, operated, serviced and maintained only by 
qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction, 
installation, and operation of electrical equipment and has received safety training to 
recognize and avoid the hazards involved.

DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in death 
or serious injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result in 
death or serious injury.

CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result in 
minor or moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury.
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Notices
Legal information

The Schneider Electric brand and any registered trademarks of Schneider Electric 
Industries SAS referred to in this guide are the sole property of Schneider Electric SA 
and its subsidiaries. They may not be used for any purpose without the owner's 
permission, given in writing. This guide and its content are protected, within the 
meaning of the French intellectual property code (Code de la propriété intellectuelle 
français, referred to hereafter as "the Code"), under the laws of copyright covering 
texts, drawings and models, as well as by trademark law. You agree not to reproduce, 
other than for your own personal, noncommercial use as defined in the Code, all or part 
of this guide on any medium whatsoever without Schneider Electric’s permission, given 
in writing. You also agree not to establish any hypertext links to this guide or its content. 
Schneider Electric does not grant any right or license for the personal and 
noncommercial use of the guide or its content, except for a non-exclusive license to 
consult it on an "as is" basis, at your own risk. All other rights are reserved.

Electrical equipment should be installed, operated, serviced and maintained only by 
qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material.

As standards, specifications and designs change from time to time, please ask for 
confirmation of the information given in this publication.

FCC

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures. 

– Reorient or relocate the receiving antenna.

– Increase the separation between the equipment and receiver. 

– Connect the equipment to an outlet on a circuit different from that to which the 
receiver is connected.

– Consult the dealer or an experienced radio/TV technician for help.

The user is cautioned that any changes or modifications not expressly approved by 
Schneider Electric could void the user’s authority to operate the equipment.

This digital apparatus complies with CAN ICES-3 (B) /NMB-3(B).

This device complies with FCC radiation exposure limits set forth for general 
population. This device must be installed to provide a separation distance of at least 20 
cm from all persons and must not be co-located or operating in conjunction with any 
other antenna or transmitter.
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This equipment complies with Part 68 of the FCC rules and the requirements adopted 
by the Administrative Council for Terminal Attachments (ACTA). On the side of this 
equipment is a label that contains, among other information, a product identifier in the 
format US: AAAEQ##TXXXX. If requested, this number must be provided to the 
telephone company.

This equipment uses the following Universal Service Order Codes (“USOC”) jacks: 
RJ11. 

A plug and jack used to connect this equipment to the premises wiring and telephone 
network must comply with the applicable FCC Part 68 rules and requirements adopted 
by the ACTA. A compliant telephone cord and modular plug or compliant modular jack 
is provided with this product.

The REN is used to determine the number of devices that may be connected to a 
telephone line. Excessive RENs on a telephone line may result in the devices not 
ringing in response to an incoming call. In most but not all areas, the sum of RENs 
should not exceed five (5.0). To be certain of the number of devices that may be 
connected to a line, as determined by the total RENs, contact the local telephone 
company. The REN for this product is part of the product identifier that has the format 
US: AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal 
point (e.g., 03 is a REN of 0.3). 

If this equipment, Digital Power Meter with Internal Modem, causes harm to the 
telephone network, the telephone company will notify you in advance that service may 
be temporarily discontinued. When advance notice is not practical, the telephone 
company will notify you as soon as possible. You will also be advised of your right to 
file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or 
procedures that could affect the operation of this equipment. If this happens, the 
telephone company will provide advance notice in order for you to make necessary 
modifications to maintain uninterrupted service.

If you experience trouble with this equipment, Digital Power Meter with Internal Modem, 
please contact Schneider Electric at 615-287-3400. If this equipment is causing harm 
to the telephone network, the telephone company may request that you disconnect this 
equipment until the problem is resolved.

There are no user serviceable parts in this equipment. 

Connection to party line service is subject to state tariffs. Contact the state public utility 
commission, public service commission or corporation commission for information.

If your premises has specially wired alarm equipment connected to the telephone line, 
ensure that the installation of this Digital Power Meter with Internal Modem does not 
disable your alarm equipment. If you have questions about what will disable alarm 
equipment, consult your telephone company or a qualified installer.

Industry Canada

Under Industry Canada regulations, this radio transmitter may only operate using an 
antenna of a type and maximum (or lesser) gain approved for the transmitter by 
Industry Canada. To reduce potential radio interference to other users, the antenna 
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type and its gain should not be so chosen that the equivalent isotropically radiated 
power (e.i.r.p) is not more than that necessary for successful communication.

This device complies with Industry Canada license-exempt RSS standard(s). Operation 
is subject to the following two conditions: (1) this device may not cause interference, 
and (2) this device must accept any interference, including interference that may cause 
undesired operation of the device.

This device complies with Industry Canada RF radiation exposure limits set forth for 
general population. This device must be installed to provide a separation distance of at 
least 20 cm from all persons and must not be co-located or operating in conjunction with 
any other antenna or transmitter.

Network compatibility notice for the internal modem

The internal modem in meters equipped with this option is compatible with the 
telephone systems of most countries in the world, with the exception of Australia and 
New Zealand. Use in some countries may require modification of the internal modem’s 
initialization strings. If problems using the modem on your phone system occur, please 
contact Schneider Electric Technical Support.
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Chapter 1 Safety precautions
Installation, wiring, testing and service must be performed in accordance with all local 
and national electrical codes.

NOTE: Do not perform Dielectric (Hi-Pot) or Megger testing on the ION8650 because
its internal surge protection circuitry starts functioning at levels below typical Hi-Pot
voltages. Contact your local Schneider Electric representative for more information on
device specifications and factory testing.

NOTE: See IEC 60950-1:2005, Annex W for more information on communications and
I/O wiring connected to multiple devices.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH
• Apply appropriate personal protective equipment (PPE) and follow safe 

electrical work practices. See NFPA 70E in the USA, CSA Z462 or applicable 
local standards.

• Turn off all power supplying this device and the equipment in which it is 
installed before working on the device or equipment.

• Always use a properly rated voltage-sensing device to confirm that all power 
is off.

• Treat communications and I/O wiring connected to multiple devices as 
hazardous live until determined otherwise.

• Do not exceed the device’s rating for maximum limits.
• Never short the secondary of a potential/voltage transformer (PT/VT).
• Never open circuit a current transformer (CT).
• Always use grounded external CTs for current inputs.
• Do not perform Dielectric (Hi-Pot) or Megger testing on this device.
• Connect protective ground (earth) before turning on any power supplying this 

device.
• Do not use the data from the meter to confirm the power is off.
• Replace all devices, doors and covers before turning on power to this 

equipment.

Failure to follow these instructions will result in death or serious injury.

WARNING
UNINTENDED OPERATION
Do not use the meter for critical control or protection applications where human 
or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death or serious injury or 
equipment damage.
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WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND 
CONFIDENTIALITY
• Change default passwords to help prevent unauthorized access to device 

settings and information.
• Disable unused ports/services and default accounts, where possible, to 

minimize pathways for malicious attacks.
• Place networked devices behind multiple layers of cyber defenses (such as 

firewalls, network segmentation, and network intrusion detection and 
protection).

• Use cybersecurity best practices (for example: least privilege, separation of 
duties) to help prevent unauthorized exposure, loss, modification of data and 
logs, interruption of services, or unintended operation.

Failure to follow these instructions can result in death or serious injury or 
equipment damage.
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Chapter 2 Introduction
PowerLogic™ ION8650 meters provide revenue-accurate, true RMS measurements of 
voltage, current, power and energy, and are complemented by extensive I/O 
capabilities, comprehensive logging, and advanced power quality measurement and 
compliance verification functions. The meters come with an extensive selection of 
preconfigured data screens and measurements, so you can use the meters with their 
default configuration after you perform basic setup. You can also customize the meter 
to fit your unique requirements.

ION8650 meters give you the tools to manage complex energy supply contracts that 
include commitments to power quality. You can also integrate the meters with energy 
management solutions such as StruxureWare™ Power Monitoring Expert (originally 
ION Enterprise), SCADA, automation and billing systems via Internet communications 
and multiple industry-standard communication channels and protocols including MV-90 
and IEC 61850.

In this chapter
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Measured Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13
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ION8650 meters
The meter is suited to a wide range of applications. The meters can be used as stand-
alone devices, but their extensive capabilities are fully realized when used as part of an 
enterprise energy management (EEM) system. The ION8650 is available with the 
following feature sets:

NOTE: For complete details of the ION8650 meter feature sets, see the ION8650
Datasheet available from www.schneider-electric.com.

ION8650 naming convention

In the serial number and ANSI bar code area of the meter’s front panel you can view 
the feature set, form factor and any special order options available with the meter. For 
example:

When there are differences between the models (such as a feature specific to one 
model), it is indicated with the appropriate model number in this document.

Model Feature set

ION8650A 128MB memory, 50 data recorders (800 channels), 4-30 Class A + EN50160 
power quality analysis (waveforms and transient detection)

ION8650B 64MB memory, 45 data recorders (720 channels), 4-30 Class S + EN50160 
power quality monitoring

ION8650C 32MB memory, 5 data recorders (80 channels)

S8650A0C0H6E0B0A
S8650 Brand and model H6 Power supply and system frequency
A0 Feature set and form factor E0 Communications
C0 Voltage/current inputs B0A I/O, security and special options



7EN02-0306-03 13

ION8650 User Manual Chapter 2 - Introduction 

ION8650 in enterprise energy management systems
Applications that include the meter typically require additional equipment. Display and 
analysis software tools are almost always used to manage, interpret and distribute the 
data measured or logged by a meter. There are usually a variety of tools used, and 
often these tools are connected using different communications standards and 
protocols.

The meter can adapt to many situations. Advanced communications allow data to be 
shared simultaneously across multiple networks, built-in I/O provides monitoring and 
non-critical control capabilities, and a variety of display and analysis tools can be used 
to monitor your power system.

The meter is factory-configured and ready to operate
Your meter is preconfigured to provide most of the functionality needed in many 
applications. After you perform the installation and basic setup, all of the basic 
measurements, energy calculations and recording functions are ready to operate. The 
meter can also be fully customized if necessary to meet your needs.

Measured Parameters

The meter provides fully bi-directional, 4-quadrant, revenue accurate energy metering. 
The following sections list some of the parameters measured by the meter.

On-site setup
- 240 by 64 pixel LCD
- ION Setup
- LED Pulsing

Remote data 
display
- Vista
- WebReach

Communications
- RS-232 and high speed RS-485
- Internal modem: 56K or cell modem
- Optical infrared
- 100 Base-T Ethernet
- Interoperability
- Protocols: ION, Modbus Master, 
Modbus RTU, Modbus/TCP, DNP 3.00, 
ModemGate (modem to RS-485 
gateway), EtherGate (Ethernet to RS-
485 gateway), GPS: Arbiter, GPS: 
Arbiter-Vorne, GPS: True Time/Datum, 
DLMS, IEC 61850, FTP, Syslog

Internet connectivity
- Email functionality
- WebMeter functionality
- XML compatibility
- FTP compatibility
- Alerts and notifications

Power system connections
Phase voltage, phase current, ground current, 
and neutral current from Wye, Delta, or single-
phase power systems

Input/output
- Pulses
- Breaker status
- Energy pulses

Data analysis tools
- Power Monitoring Network
- Third-party software for Modbus, 
DNP 3.00, MV-90, DLMS, 
COMTRADE

I/O Expander

Corporate network
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Energy
The meter provides all common active, reactive and apparent energy parameters.

• kWh, kVARh, kVAh delivered and received

• kWh, kVARh, kVAh net (delivered - received)

• kWh, kVARh, kVAh total (delivered + received)

• Volt-hours and amp-hours

• Integration of any instantaneous measurement

Energy registers can be logged automatically on a programmed schedule. All energy 
parameters represent the total for all three phases.

Demand
The meter supports standard demand calculation methods, including block, sliding 
window (rolling block), and predicted demand. It can measure demand on any 
instantaneous value and record peak (maximum) and minimum demand with date and 
timestamps to the second. Peak demand registers can be reset manually (password 
protected) or logged and reset automatically on a programmed schedule.

Measurements include:

• kW, kVAR, kVA demand, min/max

• Amps, Volts demand, min/max

• Demand on any instantaneous measurement

Instantaneous
The meter provides highly accurate, 1 second or 1/2 cycle measurements, including 
true RMS, per phase and total for:

• Voltage and current

• Active power (kW) and reactive power (kVAR)

• Apparent power (kVA)

• Power factor and frequency

• Voltage and current unbalance

• Phase reversal

Harmonics
Complete harmonic distortion metering, recording and real-time reporting, up to the 
63rd harmonic for all voltage and current inputs.

• Individual harmonics (including magnitude, phase and inter-harmonics)

• Total even harmonics and total odd harmonics

• Total harmonics (even + odd)

• K-factor, Crest factor

Min/Max recording
The meter records each new minimum and new maximum value with date and time-
stamp for the following parameters:

• Voltage and current min/max
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• kW, kVAR, and kVA min/max

• Power factor

• Frequency

• Voltage unbalance

• Plus any measured value

Power quality
The meter measures and records the following parameters:

• Sag/Swells

• Transients (ION8650A only)

The meter also has the following power quality features:

• Disturbance direction detection: This allows the meter to analyze disturbance 
(sag/swell) information to help determine the direction of the disturbance relative to 
the meter.

• EN50160: ION8650A and ION8650B meters have a default framework that 
measures and presents EN50160 compliance according to guidelines defined by 
Eurelectric (UNIPEDE).

• IEC 61000-4-30: The meter complies with the IEC 61000-4-30 power quality 
standard as follows:

– The ION8650A complies with IEC 61000-4-30 Class A.

– The ION8650B complies with IEC 61000-4-30 Class S.

• COMTRADE: ION8650A meters can save waveform data in COMmon Format for 
TRAnsient Data Exchange (COMTRADE) format, which is then available for 
download via FTP. This is intended for use in conjunction with IEC 61850 and is only 
available on ION8650A meters with an Ethernet port.

Data display and analysis tools

The meter integrates seamlessly with display and analysis software available from 
Schneider Electric™, such as Power Monitoring Expert that lets you analyze and 
monitor your system and produce reports for any department in an organization. Power 
Monitoring Expert is designed to make use of your meter’s advanced capabilities. You 
can also use data acquired by the meter in a variety of third-party systems.

The front panel
Local monitoring and standalone applications are facilitated by the meter’s front panel 
interface. The front panel combines real-time display features with basic device 
configuration functions. The front panel is often used in combination with Power 
Monitoring Expert or ION Setup, providing an interface for field personnel.

WebMeter internal web server feature
WebMeter™ provides quick and easy access to real-time energy and basic power 
quality information without special software using an on-board web server combined 
with an Ethernet port. The built-in web pages display a range of energy and basic power 
quality information through the web-enabled device; these pages also support basic 
meter configuration tasks.
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Meter internal email server feature
You can configure your meter to automatically email high-priority alarm notifications or 
scheduled system-status update messages to an external email address. Specify the 
type of event that triggers an email alert, such as power quality disturbances or logged 
data at any pre-determined interval, and have your Power Monitoring Expert or 
ION Setup administrator program the meter to respond with an email message when 
these events occur. Email messages from your meter can be received like any email 
message. 

XML compatibility
The meters can exchange information using industry-standard XML format. This simple 
machine-readable format supports integration with custom reporting, spreadsheet, 
database, and other applications.

Power Monitoring Expert software
Power Monitoring Expert allows the meter to be part of a fully networked information 
system with other meters and local and wide-area computer networks. Power 
Monitoring Expert is recommended for all power monitoring systems where advanced 
analysis and non-critical control capabilities are required.

Power Monitoring Expert provides tools for managing your power monitoring network, 
logging data, analyzing real-time and logged data, generating power system reports, 
and creating custom functionality at the meter level.

Power Monitoring Expert also offers ways to remotely view information through a web 
browser: for example, through the WebReach and Web Reporter components of Power 
Monitoring Expert, and through Microsoft Terminal Services.

See the Power Monitoring Expert Help for more information.

ION Setup device configuration tool
ION Setup is a meter configuration tool designed specifically to configure and test 
meters. ION Setup offers a graphical interface for performing basic meter setup, 
installing templates into meters, upgrading firmware, viewing real-time and reset 
accumulated values, verifying meter accuracy and measurements, and setting up 
advanced security.

You can download ION Setup from www.schneider-electric.com. It is recommended 
that you always upgrade to the latest version of ION Setup to help properly configure 
the features available on your device.

MV-90
MV-90 software (by Utility Translation Systems) is a multi-vendor translation system 
that can collect and analyze data from a variety of different brands of meters, each with 
unique database formats. MV-90 manipulates this data without extensive knowledge of 
the device of origin. 

For more information on using the meter in an MV-90 system, see the MV-90 and ION 
Technology technical note.

IEC 61850
IEC 61850 is an Ethernet-based protocol designed for electrical substations. It is a 
standard (vendor-independent) method of communications, developed to support 
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integrated systems composed of multi-vendor, self-describing devices. When properly 
configured, the meter acts as a server in an IEC 61850 system. This meter supports 
IEC 61850:2010 (Edition 2).

Alerting
The meter can be configured to send alerts in response to power system conditions 
that you define, such as a power quality problem (including surges, sags and swells), 
changes in relays, power outages or required equipment maintenance. This allows 
you to automatically advise key people of problems to allow quick remedial action, 
notify software so logs can be uploaded from the site that initiated the alert, or service 
equipment on schedule.

You can configure the meter to send alerts to email, pagers, outage notification servers 
or to software such as Power Monitoring Expert.

For more information on configuring alerting on the meter, see the ION meter alerts 
technical note and the Alert module description in the ION Reference. For more 
information on configuring alerting in Power Monitoring Expert, see the online Power 
Monitoring Expert help. 

For more information on Ethernet outage notification, see the Outage notifications on 
the PowerLogic ION8650 product option document.

Communications methods

The meter can be integrated into various industry-standard networks. Data from the 
meter can be made available to other devices using the Modbus™ Master, Modbus 
RTU, Modbus TCP, DLMS and DNP 3.0 protocols, as well the MV-90 translation 
system. You can also configure the meter to import data from devices on these 
networks. With these advanced communications functions, the meter operates in most 
existing power monitoring systems. Any data display and analysis software that works 
with these protocols also functions with the meter.

The standard meter includes a selectable RS-232/RS-485 port, a high-speed RS-485 
port, and an optical port for communications in the field. Order options include a 10/
100Base-T Ethernet port, 57.6 kbps internal modem (both FCC and CTR-21 compliant) 
and an internal cellular modem. Depending on the hardware options purchased, up to 
four separate ports can communicate simultaneously.

Security

This meter offers standard and advanced security. Standard security is enabled by 
default from the factory, and advanced security allows you to configure specific security 
settings. These include features such as adding users with unique access privileges, 
and communications lockouts.

There are also additional features available on the meter that are based on the North 
American Electrical Reliability Corporation Critical Infrastructure Protection (NERC 
CIP) standards, allowing this meter to assist in making your facility NERC CIP 
compliant. These additional features include advanced security through the front panel, 
communications and network port enabling and disabling, Ethernet port number 
assignment and event log loss preventative measures.
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Digital and analog I/O options

Onboard I/O
There are two optional onboard I/O configurations available, each providing different 
capabilities. The number and form of the digital inputs and outputs depend on the option 
you ordered; see your meter’s Installation Guide to determine the configuration 
available on your meter.

Additionally, two infrared ports (and corresponding LEDs) on the front panel are 
configured by default for energy pulsing. 

Digital inputs

The meter can be ordered with internally or externally-excited Form A digital inputs. 
They can be used for tariff inputs and other pulse counting applications.

Digital outputs

The meter can be ordered with both Form C and Form A solid-state outputs.

Expanded I/O
The I/O Expander option extends the meter’s I/O capabilities. The digital I/O Expander 
model provides four Form A digital outputs, four Form C digital outputs, and eight Form 
A digital inputs. The analog I/O Expander model replaces the four form A digital outputs 
with analog outputs.

Refer to the PowerLogic I/O Expander Installation Guide for details on the options and 
installation and operation instructions.
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Additional information
The most up-to-date documentation about your meter is available for download from 
www.schneider-electric.com. Available documentation includes:

Installation guides

This document is shipped with each meter. It details the mounting, wiring and basic 
setup of the device. There is a separate installation guide for the socket and the 
switchboard versions of the meter.

I/O Expander installation guide

This document describes the optional external I/O device that you can connect to the 
meter, for additional digital I/O and analog output ports.

Product option documents

These documents provide option-specific information about the various product options 
you can order for the meter. They usually ship with the product.

Online ION Setup help

The online ION Setup help has in-depth information on installation, setup and security 
of ION Setup. It also contains instructions on using the Setup Assistant to configure 
devices. 

ION Reference

This document describes ION architecture and provides detailed descriptions of all ION 
modules in all ION meters.

Online Power Monitoring Expert help

The Power Monitoring Expert online help system provides information and instructions 
on using Power Monitoring Expert components.

Technical notes

Technical notes such as the EN50160 technical note are available from the website, 
and provide instructions for using meter features and for creating custom 
configurations.

Protocol documents

Each protocol document contains information explaining how the product interacts with 
a protocol, such as DNP 3.0, DLMS, Modicon Modbus, IEC 61850 and MV-90.

ION device template reference

This document lists the default ION modules and their default configuration in the 
shipping template for the most recent firmware releases of ION meters.



Chapter 2 - Introduction  ION8650 User Manual

20 7EN02-0306-03



7EN02-0306-03 21

Chapter 3 Front panel
The front panel provides a user-friendly interface from which you can view system data 
or configure basic meter settings. A scrollable display and three distinct modes (NORM, 
ALT and TEST) provide easy access to a range of functions through a simple three-
button keypad.

This chapter describes the front panel and explains how to use it to display data, 
perform tests, and set up basic configuration options.

In this chapter

Front panel features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22
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Front panel features
The front panel includes a liquid crystal display (LCD) with detailed graphics and text, 
up and down arrow buttons for screen navigation and basic setup procedures, as well 
as LED pulsers for testing the meter. This section outlines the features available on the 
front panel of the meter.

LED pulsers
Two LED pulsers located near the top of the front panel represent WATT (to the left) 
and VAR (to the right). 

These LEDs are preconfigured for energy pulsing. The adjacent infrared outputs are 
connected to the LEDs and pulse at the same rate. Pulse rates can be adjusted by 
editing the settings of the Calibration Pulser module; for a detailed description of LED 
pulser operation, see “Energy pulsing with LEDs” on page 155.

Demand reset switch
Located on the front of the meter's external cover assembly, the demand reset switch 
resets the peak demand values logged in the meter. This switch can be activated with 
the cover on or off. When the meter is in TEST mode, the demand reset switch resets 
the test demand parameters. 

In most applications, the demand reset switch is sealed with an anti-tamper 
mechanism; a through-hole in the switch can accommodate either an external seal or 
a locking mechanism. See “Anti-tamper sealing methods” on page 78 for more 
information on anti-tamper sealing.

A Demand Lockout Time register sets the minimum time allowed between consecutive 
demand resets; the meter ignores any attempts to reset the demand outside the bounds 
of the register. The default value for the Demand Lockout Time is 25 days (2160000s). 
For details on the Demand Lockout Time setup register, see “Configuring demand reset 
lockout time” on page 138.

A Watt pulser: A set of LEDs (infrared, red) used for real energy pulsing.

B VAR pulser: A set of LEDs (infrared, red) used for reactive energy pulsing.

C Demand reset switch: Resets the peak demand values in the meter. Can be 
activated with the cover on or off.

D
Round button (Alt/Enter): Press to select a highlighted option. Also used to 
toggle between Norm and Alt display modes. Press and hold for 3 seconds 
to access Setup menu.

E

Navigation buttons: Press the up or down buttons to scroll and highlight a 
different menu item or to increase/decrease the value of a highlighted 
number. Press and hold the up button for 3 seconds to move the cursor to 
the left. Press and hold the down button for 3 seconds to move the cursor to 
the right.

F Test mode button: Located under the front label, this places the meter into 
Test mode, ceasing accumulation of billable quantities.

G
Master reset button: Located in a recessed pinhole under the front label to 
prevent accidental activation. You must remove the meter cover and its 
label to access it.

H Meter LCD screen

A B

H

D

C

F

G

E
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Navigation buttons
The navigation buttons are the up and down arrow buttons and the round ALT/ENTER 
button. Press the up or down arrow buttons to manually scroll back or forth through the 
available displays and temporarily halt the display screen’s automatic scrolling function. 
Press ALT/ENTER to toggle between NORM and ALT display modes. The automatic 
scrolling function restarts 60 seconds after a button was last pressed. 

Hold the ALT/ENTER button for approximately three seconds to display the setup 
menu. You can then use the navigation buttons to view the device's configuration or edit 
basic settings. See “Setup menus” on page 32 for further instruction on modifying the 
device's configuration using the front panel buttons.

Optical port
An optical port facilitates infrared communication with the device. For details on how to 
configure and use this port, see “Configuring the optical port” on page 91.

Master reset button
You must remove the meter’s cover as well as the front panel label to access the master 
reset button; it is located in the lower left of the faceplate. This button is recessed to 
prevent accidental activation. For instructions on removing the meter cover and 
performing a master reset, and information on what parameters are reset, see 
“Performing a master reset from the front panel” on page 207. 

Use the master reset button to delete most accumulated values and all derived revenue 
measurements from the meter.

TEST mode button
The TEST mode button is located under the meter's external cover assembly; it places 
the meter into TEST mode. While in TEST mode, the meter stops accumulating billable 
quantities; energy and demand measurements are accumulated in TEST mode 
registers.

See “TEST mode” on page 27 for more details on this mode of operation. 

MASTER
RESET

TEST
MODE
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Display screen types
The front panel displays measurements, event logs, phasor diagrams, bar graphs, 
harmonics histograms, configured settings and configuration data. The types of display 
screens are described below. 

As shown in the graphics in the following sections, the display screen is divided into two 
sections: the main display area and the status bar. The main display area presents 
meter data and status information; the status bar provides time, date, phase, quadrant, 
and mode information. During normal operation, the main display area automatically 
cycles through a series of several displays. If you prefer, you can use the up or down 
arrow buttons to step manually through these displays. By default, the automatic 
scrolling resumes 60 seconds after you have pressed a button.

NOTE: To adjust the contrast, hold down the up and down arrow buttons
simultaneously. When the contrast reaches the desired level, release the buttons.

For information on customizing the display on your meter, see “Configuring front panel 
displays” on page 187.

The status bar
The status bar runs along the bottom of the front panel display and contains information 
about the following settings:

• Date and time (in 24 hour format).

• Voltage phases present. The labels and rotation of phases correspond to the 
configuration of the power monitoring system.

• Quadrant where the system power factor resides.

• Mode (NORM, ALT or TEST).

• Time remaining in the sliding window (or rolling block) demand interval. If the interval 
has counted to zero the letters EOI (End Of Interval) appear on the status bar.

Numeric displays
All NORM mode data and some of the ALT mode display screens use numeric displays. 
Numeric displays show up to four parameters at a time. If no numeric values are 
available for a parameter, N/A is displayed.

Status barMain display



7EN02-0306-03 25

ION8650 User Manual Chapter 3 - Front panel 

 

By default, the front panel automatically scales the units for basic measurements (such 
as voltage, current and power parameters). For example, a measurement of 2,000 
Watts is displayed as 2 kW. A measurement of 2,000,000 Watts is displayed as 2 MW. 
The meter makes these conversions using your PT and CT ratios. 

The meter only performs automatic unit scaling if the displayed measurement is derived 
solely from the Power Meter module’s output and the display units are set to default. 
See “Displays” on page 185 for more information.

Nameplate display and event log
Nameplate displays and event logs appear in ALT mode and are organized in tabular 
format. Nameplate displays show owner, meter and power system details:

The Event Log displays recent high priority events (you must use software such as 
ION Setup to retrieve all logged event data):

Histogram displays
Harmonic content is displayed in histogram format. The 2nd to the 63rd harmonics (31st 
on the ION8650C meter) are displayed in the histogram. The total harmonic distortion 
(THD) is displayed above the histogram.

Phasor diagram displays
Phase information can be displayed in phasor diagram format. Phasor diagrams are 
accompanied by tables that show phase, voltage and current magnitudes. In cases 
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where a phase vector is too small to be represented graphically, it is shown as a table 
entry only.

Disk simulator
This display simulates the behavior of a mechanical watt-hour meter indicating power 
received or delivered by the direction of the pulse.

Time and date
This displays supports time and date formats, enabling displays with nothing but date 
and/or time and/or time remaining in the current interval.

Time-stamped values
Up to three timestamped parameters can be displayed on the same screen. The 
timestamp indicates when the displayed parameter was last updated.
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Modes of operation
The meter has three modes of operation: NORM, ALT and TEST. Both NORM and ALT 
are display modes, providing various power system data and meter properties screens. 
TEST mode is used to perform diagnostics, verify the meter’s accuracy, and verify 
meter functions.

NOTE: You can customize the display screens and alter the front panel’s scrolling
characteristics by editing the meter’s Display and Scroll modules – refer to“DISPLAY
SETUP menu” on page 37 for information on changing display settings and “Displays”
on page 185 for information on customizing the displays.

Basic operation (NORM mode)
The meter defaults to NORM mode when powered up, and remains in this mode until 
you manually switch to ALT or TEST.

NORM mode screens are described in “NORM mode display screens” on page 192.

Meter configuration and NORM mode

• For meters without the hardware lock, all of the settings available in the front panel 
SETUP menu can be changed while the meter is in NORM mode, provided you 
have the correct password.

• For meters with the hardware lock, only the basic communications parameters in the 
COM Setup menu can be changed in NORM mode. You must enter TEST mode to 
change other meter parameters on the hardware-locked meter — see “Additional 
revenue metering security” on page 77 for more details.

ALT mode
ALT mode provides scrolling display screens that show power system data, billing 
information and meter properties such as nameplate information. 

ALT mode screens are described in “ALT mode default display screens” on page 192.

Switching to ALT mode

Press the ALT/ENTER button to switch to ALT mode. Press the ALT/ENTER button 
again to switch back to NORM mode at any time. If no buttons are pressed, the meter 
automatically reverts to NORM mode after five minutes. As with any mode, pressing 
any button temporarily suspends display screen scrolling, allowing you to press the up 
or down arrow buttons to manually browse the available screens.

TEST mode
NOTE: If your meter has the optional hardware lock, you must remove the meter’s
cover to put it into TEST mode. See “Security overview” on page 54 for more
information. 

TEST mode is typically used for meter function verification. The meter is usually reading 
data from a test power supply while these functions are performed. 

All of the billing quantities that are recorded when the meter is in NORM and ALT mode 
stop accumulating when the meter is switched to TEST mode — the data is sent to 
special TEST mode registers instead. The values accumulated in these test registers 
are displayed on the front panel (and in the Vista component of Power Monitoring 
Expert). 
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The regular NORM/ALT mode billing registers are unaffected while the meter is in 
TEST mode; accumulation of billing data resumes as soon as you exit TEST mode. All 
test registers are reset to zero when you exit TEST mode.

For detailed information on TEST mode, see “Switching to TEST mode” on page 199.

NOTE: The meter always returns to NORM mode when you exit TEST mode, even if
you entered TEST mode from ALT mode.
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Configuring the meter with the front panel
Using the meter’s front panel, you can navigate through different menus to perform 
basic setup on your meter. 

NOTE: If you have a hardware-locked meter, only the basic communications
parameters can be changed in NORM mode. You must enter TEST mode to change
other meter parameters on the hardware-locked meter. See “Additional revenue
metering security” on page 77 for more details.

Accessing the SETUP menu
To access the SETUP menu, press and hold the front panel's ALT/ENTER button while 
the meter is displaying power system data. Within the SETUP menu is a list of sub-
menus that contain the meter’s configurable settings. The menu items are described in 
“Front panel features” on page 22. 

Press the up or down arrow buttons to navigate through the menu. Highlight a menu 
item and press the ALT/ENTER button. When you select an item from the SETUP 
menu, you are presented with another menu of the settings in the meter. You may need 
to navigate several layers of menus to access the setting you want to change. 

The following diagram shows how the buttons are used to navigate the menus:
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The settings contained in the SETUP menu are:

Each of the main setup screens and the settings you can configure are discussed in 
“Setup menus” on page 32. 

NOTE: Your display may appear differently than shown, depending on your meter’s
model and configuration.

NOTE: The ENABLED COM PORTS setup menu only appears on the ION8650C.

SETUP

BASIC SETUP

COM2 SETUP

COM3 SETUP

VOLTS MODE
PT PRIMARY
PT SECONDARY
CT PRIMARY
CT SECONDARY
VA POLARITY
VB POLARITY
VC POLARITY
IA POLARITY
IB POLARITY
IC POLARITY
PHASE ROTATION

PROTOCOL

TRANSMIT DELAY
UNIT ID
SERIAL PORT
RS232 or RS485
RT/CTS HANDSHAKE
RS485 BIAS

BAUD RATE

PROTOCOL

TRANSMIT DELAY
UNIT ID

BAUD RATE

PROTOCOL

TRANSMIT DELAY
UNIT ID
SERIAL PORT

BAUD RATE

COM4 SETUP

PROTOCOL

TRANSMIT DELAY
UNIT ID
SERIAL PORT
RS485 BIAS

BAUD RATE

NETWORK SETUP

IP ADDRESS

GATEWAY
SMTP ADDRESS
MAC ADDRESS
PORT ENABLE

MASK

CELL SETUP

IP ADDRESS

PROTOCOL 1-6
PORT NUMBER 1-6

MEID

COM1 SETUP

FORMAT SETUP

PHASE LABELS
PF SYMBOL
DIGIT GROUP
DATE FORMAT
SHOW DST
VOLTS DECIMAL
CURRENT DECIMAL
POWER DECIMAL

DISPLAY SETUP

UPDATE RATE
CONTRAST
BACKLIGHT TO
DMD LOCK TO
TEST MODE TO
DISPLAY SCALE
SCALING MODE
DELTA VECTORS

SECURITY

MODIFY PASSWORD
DISABLE SECURITY
WEB CONFIG

ENABLED COM PORTS

COM1

COM3
COM4
ETHERNET
UNDO & RETURN
REBOOT

COM2
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Navigating the front panel screens
Use the up and down arrow buttons to scroll through the menu items. When the setting 
you want to change is highlighted, press the ALT/ENTER button.

To return to a previous screen, use the up or down arrow button to highlight the 
RETURN menu item and then press the ALT/ENTER button.

Configuring parameters using the navigation buttons
Use the up or down arrow buttons to change the value (if numeric) or the setting (if 
enumerated) of the highlighted parameter.

To change the position of the cursor, press the up or down arrow buttons for about one 
second. The up arrow button moves the cursor one position to the left and the down 
arrow button moves the cursor one position to the right. Once you have the value you 
want, press the ALT/ENTER button to select it.

NOTE: When setting Ethernet values (IP address, default gateway, etc.), press the up
arrow button to insert additional digit spaces. Press the down arrow to remove digit
spaces (see “NETWORK SETUP menu” on page 35 for more information).

OUT OF RANGE screen

When editing numeric data, the numbers displayed on the screen below MIN and MAX 
indicate valid entry bounds. If you enter a value outside valid bounds, you are presented 
with a message stating that the value is out of range. You can then either return to the 
register you were editing or choose to exit.

Entering the front panel password with basic security enabled
With basic security enabled on the meter, you are presented with the password screen 
when you attempt to change a setting on the front panel. After you enter the correct 
password, you do not have to re-enter it for other any other changes unless you exit the 
configuration session or the session has elapsed.

To enter the password:

1. Use the arrow buttons to change the value of the highlighted digit. The up arrow 
increments the number and the down arrow decrements it.

2. Hold down an arrow button for about one second to change the position of the 
cursor. The up arrow moves the cursor left one position and the down arrow moves 
the cursor right one position.

ENTER PASSWORD

HOLD ARROW KEY TO MOVE CURSOR
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3. Press the ALT/ENTER button once you have the value that you want.

Advanced security username and password
 If advanced security has been enabled on your meter, you are required to provide your 
username and password when changing the meter’s settings through the front panel. 
See “Entering advanced security username or password when accessing the device via 
the front panel” on page 58 for more information.

Confirming configuration changes
The CONFIRM CHANGE screen appears when you attempt to change the meter’s 
settings through the front panel. This allows you to cancel an unwanted configuration 
change. The front panel also informs you when an entry is out of range. Select YES to 
confirm your change or NO to cancel it, then press the ALT/ENTER button to return to 
the previous setup screen.

Setup menus

The following sections describe the setup menus in more detail.

BASIC SETUP menu
The BASIC SETUP menu lets you set volts mode, potential transformer (PT) and 
current transformer (CT) ratios and various other settings (such as voltage and current 
polarities) so that you can ensure that your meter is adequately set for your application. 

To access the BASIC SETUP menu with the meter’s front panel:

1. Press and hold the ALT/ENTER button on the front panel of the meter. After about 
three seconds the SETUP screen appears.

2. Use the up or down arrow buttons to navigate to the BASIC SETUP menu. Press 
the ALT/ENTER button.

3. Press the up or down arrow buttons to navigate to the appropriate parameter, then 
press the ALT/ENTER button to edit the parameter.

Many of these settings are configured when the meter is initially put into service (the 
device will not operate properly until Volts mode and PT and CT ratios are set), but 
some settings may need to be changed to refine the device’s operation.

NOTE: If you have a hardware-lockable meter, you must put the device into TEST mode
prior to making changes to the BASIC SETUP parameters. For TEST mode
information, see “TEST mode” on page 27.

The BASIC SETUP menu has the following settings:

Menu item Setting options Default Description

Volts mode1

– 9S - 4 Wire Wye/Delta
– 29S - 4 Wire Wye
– 35S - 3 Wire
– 36S - 4 Wire Wye
– Demo

*See note

The power system’s configuration and supported form factor. 
36S - 4 Wire Wye is only available on the socket meter.

Note: The default setting varies depending on the meter form factor. Ensure you 
verify that the correct option is selected for your power system before putting the 
meter into service.

PT Primary1 1.0 to 999999.00 120 The Potential Transformer’s primary winding rating

PT Secondary1 1.0 to 999999.00 120 The Potential Transformer’s secondary winding rating

CT Primary1 1.0 to 999999.00 5 The Current Transformer’s primary winding rating
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1 These registers are typically set when the device is commissioned. Changing the values of these registers 
while the device is in service is not recommended.

COM port setup menus
See “The following illustration shows the connections to the communications card.” on 
page 82 for more information on configuring meter communications.

To make changes to communications settings with the meter’s front panel, hold down 
the ALT/ENTER button for three seconds to enter the SETUP menu, then press the 
down arrow button to select the COM SETUP you want. 

Depending on the communications options ordered with your meter, the following menu 
items are available: 

NOTE: For hardware-locked meters, you must be in TEST mode to alter these COM
port settings.

Serial COM port settings

There are three main parameters that you must set or verify if your meter is connected 
to a serial network (including modem communications): Unit ID, Baud Rate, and 
Protocol.

NOTE: Other parameters such as TRANSMIT DELAY are used in advanced
configuration or fine-tuning your system. The main parameters are the most common
parameters required to get your meter communicating.

CT Secondary1 1.0 to 999999.00 5 The Current Transformer’s secondary winding rating

VA Polarity
– Normal
– Inverted

NORMAL The polarity of the Potential Transformer on V1

VB Polarity
– Normal
– Inverted

NORMAL The polarity of the Potential Transformer on V2

VC Polarity
– Normal
– Inverted

NORMAL The polarity of the Potential Transformer on V3

IA Polarity
– Normal
– Inverted

NORMAL The polarity of the Current Transformer on I1

IB Polarity
– Normal
– Inverted

NORMAL The polarity of the Current Transformer on I2

IC Polarity
– Normal
– Inverted

NORMAL The polarity of the Current Transformer on I3

Phase Rotation
– ABC
– ACB

ABC The expected rotation of the voltage phases (ABC or ACB)

Menu item Setting options Default Description

Menu item Description
COM1 Setup Settings for the selectable RS-232 or RS-485 communications port. 
COM2 Setup Settings for the internal modem port. 
COM3 Setup Settings for the optical communications port located on the meter’s front panel.
COM4 Setup Settings for the COM4 RS-485 port.
Network Setup Settings for the Ethernet communications port. 
Cell Setup Settings for the cellular modem port.

Enabled COM 
Ports

Set which two COM ports are enabled for communication, in addition to COM3 
(front optical port) which is always enabled. This menu is only available on the 
ION8650C.
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To configure the COM port settings:

1. Press and hold the ALT/ENTER button on the front panel of the meter. After about 
three seconds the SETUP screen appears.

2. Use the up or down arrow buttons to navigate to the COM port that you want to 
configure. Press the ALT/ENTER button.

3. Press the up or down arrow buttons to navigate to parameter you want to edit then 
press ALT/ENTER.

4. Use the up and down arrow buttons to change the value of the parameter then press 
ALT/ENTER.

The menu items, and their setting options and default configurations, are listed in the 
following table for COM1 (selectable RS-232 or RS-485), COM2 (modem), COM3 
(optical port) and COM4 (RS-485). 

1 Select None from the Protocol setting options to disable the COM port.
2 See “Time synchronization” on page 131 for more details about GPS settings. See also the Time 

Synchronization & Timekeeping technical note for further details on using the meter’s time synchronization 
functions.

3 Modbus Master is not available on the ION8650C.
4 See “Configuring Ethernet connections” on page 93 and “Internal modem connections” on page 99 for 

more details.
5 Unit ID for COM1 is based on the meter’s serial number. For example, if the serial number is 

PA-0009B263-01, the Unit ID is set in the factory to 9263.

Applies to... Menu item Setting options Default Description

All Protocol

All COM ports: None1, ION, Modbus 
RTU, DNP V3.00, DLMS, 
GPS:TrueTime/Datum2, GPS Arbiter2, 
GPS Arbiter-Vorne2, Factory
Additional protocols on COM1 and 
COM4: Modbus Master3, EtherGate4, 
ModemGate3

ION Specifies the protocol used by the 
communications port.

All Baud Rate 300, 1200, 2400, 4800, 9600, 19200, 
38400, 57600, and 115200 bps

9600 bps Specifies the baud rate of the serial 
port. Ensure all devices on the same 
loop are configured to use the same 
baud rate.

All Transmit Delay 0.0 to 1.0 s. 0.01s (10ms)
The amount of time in seconds that the 
meter waits for communications 
acknowledgments.

All Unit ID 1 to 9999

COM1: Unit ID is 
based on the serial 
number5.
COM2: 101
COM3: 102
COM4: 103

Sets the meter Unit ID.
A unique Unit ID is required for each 
device (including all the devices on a 
ModemGate or EtherGate serial loop).

COM1 RS232 OR RS485  RS232 or RS485 RS485 Specifies the communications mode 
used by COM1.

COM1
(RS-232 only)

RTS/CTS 
Handshake RTS/CTS or RTS with Delay RTS with Delay Specifies the flow control used by the 

communications port.
COM1
(RS-485 only) 
and COM4

RS485 Bias OFF or ON OFF
Enables or disables RS485 biasing. 
See “RS-485 biasing” on page 89 for 
more information.

COM1, COM3 
and COM4 Serial Port 8O1, 8O2, 8N1, 8N2, 8E1, 8E2 8N1

Sets the parity and data format. For 
example, 8N1 is eight (8) data bits, no 
(N) parity bit and one (1) stop bit. 
Ensure that all devices on the same 
loop are set to the same format.
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NETWORK SETUP menu
There are two main parameters that you must set or verify if your meter is connected to 
an Ethernet network: IP address and subnet mask address.

NOTE: There are other parameters, such as GATEWAY ADDRESS and SMTP
ADDRESS, that are used in advanced configuration or in fine tuning your system. The
main parameters are the most common parameters required to get your meter
communicating.

The menu items, and their setting options and default configurations, are as follows:

Most network settings can be configured through the front panel; all network settings 
can be modified in Power Monitoring Expert or ION Setup. See “Configuring Ethernet 
connections” on page 93 for more information.

NOTE: Configuring the IP Address, Mask, Gateway, and Port Enable settings
incorrectly can cause network disruptions. See your network administrator for more
information.

Typically, your network administrator provides you with the appropriate IP address for 
the meter. The subnet mask and gateway settings are only required if you have 
communications between multiple Ethernet networks and if subnetting is implemented.

Use the navigation buttons to edit the values of the network settings so that they match 
your system addresses. As you configure the network addresses, the front panel 
automatically discards unnecessary leading zeros from each three-digit grouping. The 

Menu item Setting options Default Description
IP Address 0.0.0.0 to 255.255.255.255 None Sets the IP address for the meter.

Mask 0.0.0.0 to 255.255.255.255 None
Used if subnet masking applies to your network
– see your network administrator to determine if subnet mask is 
used.

Gateway 0.0.0.0 to 255.255.255.255 None Used in multiple network configurations 
– see your network administrator to determine if gateway is used.

SMTP Address 0.0.0.0 to 255.255.255.255 None

Sets the IP address for the SMTP mail server that is configured to 
forward mail from the meter to the final destination
– see your network administrator to determine if the SMTP mail 
server is used.

MAC Address Read-only factory-set 
hexadecimal value The MAC address is read-only and provided for information purposes only.

Port Enable

– Webserver
– FTP
– DNP over TCP
– ION over TCP
– MODBUS over TCP
– MODBUS TCP
– Telnet

Yes Specifies whether the network ports are enabled or disabled.

NOTICE
DATA LOSS
Ensure you maintain sufficient access to communicate to and configure your 
device.

Failure to follow these instructions can result in data loss.
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hidden leading zeros appear (and disappear again) as you move the position of cursor 
across the network address.

In the example above, the highlighted zero is discarded as soon as you change the 
position of the cursor.

CELL SETUP menu
The CELL SETUP menu contains the following values that configure the cellular 
modem:

NOTE: To disable the connection to a port, set the Protocol to None. This allows you to
restrict the number of simultaneous connections to the meter through the cell modem.

ENABLED COM PORTS menu (ION8650C only)
Up to three COM ports can be active simultaneously on the ION8650C. COM3 (the front 
optical port) is always enabled. The ENABLED COM PORTS menu allows you to select 
the other two COM ports that you want enabled. 

NOTE: A meter restart is required to change the enabled communications ports.

The default settings vary depending on your order option. See your meter’s Installation 
guide for details.

See “ION8650C communications options” on page 84 for details on changing the 
enabled COM ports.

FORMAT SETUP menu
The FORMAT SETUP contains the following values that set labeling and formatting 
preferences:

89.123.40. 560

Menu item Setting options Default Description

IP Address 0.0.0.0 to 255.255.255.255 Not configurable Displays the IP address assigned to the cell modem by the 
network

MEID/CCID Not configurable Not configurable Displays Mobile Equipment Identifier

Protocol 1-6 None, ION, Modbus TCP, DNP 
3.0 None Specifies the protocol used for connection 1–6

Port Number 1-6 1 - 65535 0 Specifies the port number to establish connection 1–6

Menu item Description
COM1 Specifies whether COM1 (RS-232/RS-485) is enabled or disabled.
COM2 Specifies whether COM2 (modem) is enabled or disabled.
COM3 COM3 (front optical port) is always enabled.
COM4 Specifies whether COM4 (RS-485) is enabled or disabled.
Ethernet Specifies whether the Ethernet port is enabled or disabled.
Undo & Return Exits the menu with no changes to the COM ports. No meter restart required.
Reboot Restarts the meter. The changes are applied when the meter restarts.

Menu item Setting option Default Description
Phase Labels ABC, 123, RWB, RYB, XYZ, or RST ABC Specifies how phases are labeled.
PF Symbol LD/LG, +/-, or CAP/IND LD/LG Specifies the symbol pair used to indicate power factor.



7EN02-0306-03 37

ION8650 User Manual Chapter 3 - Front panel 

DISPLAY SETUP menu
You can configure the following display preferences:  

SECURITY menu
The settings in the front panel SECURITY menu allow you to: 

• modify the existing meter password or reset it to the factory default.

• disable the basic password security check.

• enable web browser configuration on the meter.

A valid password is required in order to enter the SECURITY menu. The default 
password is 0 (zero).

See “Security” on page 53 for information on meter security, including security 
recommendations, password best practices and instructions on configuring security 
through the front panel.

Digit Group 1000.0, 1,000.0 or 1 000,0 1000.0

Numbers of three digits or greater can be grouped in any of 
the following three formats: 1000.0 (no commas, no spaces) 
or 1,000.0 (commas, no spaces) or 1 000.0 (no commas, 
spaces).

Date Format YYYY/MM/DD, MM/DD/YYYY or DD/
MM/YYYY MM/DD/YYYY Specifies how dates are displayed.

Show DST Do not display DST or Display DST Display DST You can choose to display Daylight Savings Time (DST) or 
not.

Volts Decimal 1. to 123456789.XXX 1.XX
Number of decimal places displayed for voltage values (up to 
9 digits before the decimal place and up to 3 digits after the 
decimal place).

Current Decimal 1. to 123456789.XXX 1.XXX
Number of decimal places displayed for current values (up to 
9 digits before the decimal place and up to 3 digits after the 
decimal place).

Power Decimal 1. to 123456789.XXX 1.XXX
Number of decimal places displayed for power values (up to 
9 digits before the decimal place and up to 3 digits after the 
decimal place).

Menu item Setting option Default Description

Menu item Setting options Default Description
Update Rate 1s, 2s, 3s, 4s, 5s, or 6s 1s The front panel can update its data from every one to every six seconds. 

Contrast 0 to 9 5

A front panel display contrast level can be set from zero to nine where 
higher numbers represent a sharper level of contrast. You can adjust the 
contrast level at any time by pressing and holding down both up and down 
arrow buttons simultaneously.

Backlight TO 0 to 7200 300
Backlight timeout: this selection allows you to make the backlight turn off 
automatically after zero to 7200 seconds (two hours). If this value is set to 0 
(zero), the backlight is always on. 

DMD Lock TO 0 to 5184000 2160000
Demand lockout time (in seconds) controls the minimum allowable time 
between consecutive demand resets. You can select values from 0 
(disabled) to 5184000 (60 days).

TEST mode TO 60 to 21600 1800

If there are no front panel key presses, the meter exits TEST mode 
automatically; the TEST mode timeout setting defines how long the meter 
remains in TEST mode before switching to norm mode. While in TEST 
mode, the value on the bottom right of the status bar indicates the amount 
of time before TEST mode times out.

Display Scale 1.0 to 999999.0 1000 Scale applied to values before they are displayed.

Scaling Mode Multiply or Divide Divide Specifies whether values are divided or multiplied by the Display Scale 
before being displayed.

Delta Vectors System or Instrument Instrument Specifies how vector diagrams are displayed when in Delta mode.
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If your device’s front panel or user passwords are lost, you must return the device for 
factory reconfiguration, which resets your device to its factory defaults and destroys all 
logged data.

NOTICE
DATA LOSS
Record your device’s front panel and user password information in a secure 
location.

Failure to follow these instructions can result in data loss.
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Chapter 4 Templates and firmware
Your meter comes installed with a preconfigured default template. This template 
contains various frameworks which provide all the power measuring and analyzing 
functionality of the meter. The default templates and frameworks can be used 
immediately without any user configuration. They can also be customized, 
reconfigured, and pasted from one meter to another.

For more information on templates, frameworks and ION modules, see the 
ION Reference. 

Firmware is your meter’s operating system. When newer firmware is available for your 
meter, simply upgrade to the latest version for all the added features and functionality.

In this chapter

Factory information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
Factory Module settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
How to TAG your meter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40

Updating or restoring the template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
Meter I/O module behavior . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
Using the front panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
Using ION Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
Using Designer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42

Upgrading your meter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44
General upgrading considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

Upgrading to compatible firmware and template versions  . . . . . . . . . . . . . . . .  44
Recording your device’s usernames and passwords  . . . . . . . . . . . . . . . . . . . .  44
Using a laptop computer to upgrade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44
Upgrading devices via a ModemGate connection  . . . . . . . . . . . . . . . . . . . . . .  45
Meter behavior when an upgrade fails  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Meter I/O module behavior . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Accumulated energy values and upgrades . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45

Upgrading firmware using ION Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Upgrading firmware using Power Monitoring Expert  . . . . . . . . . . . . . . . . . . . . . . . .  46

Before using Device Upgrader  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46
Using Device Upgrader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46
Editing accumulated energy values using ION Setup . . . . . . . . . . . . . . . . . . . .  47
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Factory information
The Factory module displays firmware version, serial number and other device 
information in read-only setup registers (read-only registers can be viewed but not 
changed) or configurable information in read/write setup registers.

Factory Module settings
The device information provided is as follows:

1 The MAC address of your meter cannot be changed, and is for information only.

The Factory module also holds the alternate PT and CT values, which can scale 
operational values on revenue-locked meters (see “Scaled operational values” on 
page 79) and numerous read-only setup registers that hold the calibration constants 
used at the factory.

How to TAG your meter
Three configurable read/write setup registers are provided for you to enter your 
company name and other text information you want stored in the meter:

• Owner - This is a text register for storing user information (for example, company 
name). It can be up to 255 characters in length.

• Tag 1 - This is a text register for storing user information (for example, device 
location). It can be up to 15 characters in length.

• Tag 2 - This is a text register for storing user information (for example, device 
number or identifier). It can be up to 15 characters in length.

NOTE: Tag 2, if entered, it is used as the default MV-90 Device ID. Refer to the MV-90
and ION Technology technical note for more information.

Setup register Description
Device Type A device type identifier (for example, “8650” for the ION8650)
Compliance A statement of whether the device is ION compliant or not
Options Shows model number of meter
Revision The meter’s firmware version
Serial Num The meter’s serial number
ION Version The ION version supported by the device
Template The name of the template (framework) installed on the device at the factory
Nom Freq The expected frequency of the power system being monitored

MAC Address Media Access Control address1

Feature Set The feature set of the meter (ION8650A, ION8650B or ION8650C)
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Updating or restoring the template
You may need to update or restore the meter’s template:

• If there is a new template with additional features or if you have configured one 
meter and want to configure others with the same settings.

• If you have made changes and want to return to the original configuration. The basic 
setup of the device can be retained, so the meter does not need to be taken out of 
service for a long period of time.

If you restore the factory configuration, all recorded data and any custom features that 
you have created (such as custom alarms or custom data recorders) are lost.

Use Power Monitoring Expert or ION Setup to upgrade or restore the template.

Meter I/O module behavior
Your meter’s I/O modules may change state during a firmware upgrade. The meter’s 
I/O behavior is determined by how it is configured in the new template that has been 
loaded.

Using the front panel
You cannot restore the factory configuration from the meter’s front panel.

Using ION Setup
1. Obtain the meter template that you want to update or restore:

– Download your meter’s factory template or an update template from 
www.schneider-electric.com. 

– Save a template you have configured on another meter. See the ION Setup Help 
for instructions. 

Save the .DCF file. The default template file location is .../ION Setup/TEMPLATE.

2. Start ION Setup.

NOTICE
DATA LOSS
• Ensure all important data from the device has been retrieved before you 

restore the factory configuration.

Failure to follow these instructions can result in data loss.

WARNING
HAZARD OF UNINTENDED OPERATION
• Do not use the meter for critical control or protection applications where human 

or equipment safety relies on the operation of the control circuit.
• Be aware that an unexpected change of state of the digital outputs may result 

when the supply power to the meter is interrupted or after a meter firmware or 
template upgrade.

Failure to follow these instructions can result in death, serious injury or 
equipment damage.
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3. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

4. Select the Template screen. 

5. Click the Send to Meter tab then click Send. The Open ION8650 DCF file dialog 
box appears. Navigate to the location where you saved the .DCF file.

6. Select the .DCF file and click OK. The Template Paste Options dialog box 
appears. Select the check boxes for the settings you want to retain (not overwrite) 
and click OK.

Rapid Meter Programming pastes the template onto your meter. A dialog box 
confirms the paste was successful.

Using Designer
See the Power Monitoring Expert help for detailed instructions on updating and 
restoring templates and frameworks.

NOTE: The time required to complete the steps in this procedure can vary depending
on your connection and the meter configuration. Some steps may take several minutes
to complete. 

1. Open your meter in Designer. Ensure that the meter’s main Configuration screen 
is displayed.

2. Click Edit > Select All then press DELETE.

A confirmation dialog box appears explaining that some modules will not be deleted 
(core modules cannot be deleted — scroll down in the dialog to see which standard 
modules will be deleted).

3. Click OK on the confirmation dialog box. 

The modules are deleted (other than persistent and core modules). You may get a 
message stating that persistent modules could not be deleted. Click Continue. 

The main meter Configuration screen is blank except for a folder that contains the 
modules which cannot be deleted.

4. Click Edit > Select All to select the Frameworks folder. This selects all sub-folders 
and modules within the folder.

5. Click Edit > Paste from Framework, then select the appropriate .fwn file from the 
folder \ION Enterprise\config\fmwk\nd\. Click Open.



7EN02-0306-03 43

ION8650 User Manual Chapter 4 - Templates and firmware 

NOTE: The Factory module’s Default Template register tells you the filename for the
default factory framework. For details about framework files, contact Technical Support
or visit www.schneider-electric.com.

The Paste Summary dialog box appears. 

6. Click on the first module, scroll down to the last module, hold the SHIFT key and 
click on the last module. This selects all of the modules.

7. Continue holding the SHIFT key and click on the check box to the left of the module 
name. A lock icon with a green check mark appears; this performs a lock-paste of 
the modules. 

NOTE: Persistent modules can be overwritten in Designer. When pasting a default
framework onto a meter, use lock-paste on the Persistent modules, not free-paste. A
list of Persistent modules is available from Technical Support.

8. Select the Maintain external inputs check box and click OK.

A message appears indicating that Designer is pasting modules. All modules are 
selected when the paste is complete. Click anywhere in the background of the node 
diagram to deselect all of the modules. 

9. Click the Power Meter shortcut in the Basic Configuration area to select it. Click the 
Reset icon or select Edit > Reset. This reverts the Power Meter to the settings it 
had before you deleted any modules (retaining your original basic setup).

10. Click File > Send & Save. If you receive an message stating that the operation is 
incomplete, click Continue then click File > Send & Save again. 
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Upgrading your meter
You can upgrade the firmware (operating software) and template on your meter using 
either Power Monitoring Expert or ION Setup. 

General upgrading considerations

Upgrading to compatible firmware and template versions
Ensure that the firmware version that you are upgrading to is compatible with your 
meter and that the version number is greater than your existing firmware (or else you 
will downgrade your meter). 

Ensure that the template you are upgrading to matches the feature set of your meter (in 
other words, if your meter is an ION8650A, the template must be an 
A-variant template). The variant is indicated in the template filename.

You can download meter firmware and templates from www.schneider-electric.com.

Recording your device’s usernames and passwords
Ensure that you record your device’s usernames and passwords prior to upgrading the 
device firmware. 

If your device’s front panel or user passwords are lost, you must return the device for 
factory reconfiguration, which resets your device to its factory defaults and destroys all 
logged data.

See “Security” on page 53 for more information on the device’s security settings.

Using a laptop computer to upgrade
Laptop computers generally have different default power properties than desktop 
computers. Incorrect power options can adversely affect device upgrading because the 
connection between the laptop and the device must be maintained in order to complete 
the upgrade successfully. If the laptop’s hard disk shuts down or the laptop enters 
system standby mode, this connection is broken and the upgrade procedure must be 
restarted. 

If you are upgrading a meter using a laptop computer, follow these guidelines:

• Plug the laptop computer into a wall outlet. Do not run the laptop on its battery.

• Configure the hard disks so that they do not shut down after a certain period of time 
(for example, set to “never”).

• Turn off power suspension (for example, system stand-by) and hibernate options.

• Disable options that power down the laptop when it is closed. This prevents a shut 
down if the laptop is accidentally closed.

• Disable the screen saver; screen savers can burden the CPU.

NOTICE
DATA LOSS
Record your device’s front panel and user password information in a secure 
location.

Failure to follow these instructions can result in data loss.
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Upgrading devices via a ModemGate connection
The maximum acceptable baud rate for upgrading via ModemGate is 56.6 kbps. Ensure 
that the baud rate on the ModemGate communications port and the baud rate on the 
meter to be upgraded are set to this or lower.

Meter behavior when an upgrade fails
The meter allows three consecutive attempts to upgrade the meter. If the third attempt 
fails, an error is generated and you must power cycle the meter before you try again. 
Wait 30 seconds for the meter to reset after power cycling it before you try to upgrade 
again.

Meter I/O module behavior
Your meter’s I/O modules may change state during a firmware upgrade. The meter’s 
I/O behavior is determined by how it is configured in the new template that has been 
loaded.

Accumulated energy values and upgrades
The firmware upgrade process clears accumulated energy values in the meter.

If you want to retain these values across a firmware upgrade, you can use the Register 
Edit feature in ION Setup to manually restore pre-upgrade values back to your meter.

Upgrading firmware using ION Setup

Performing a device upgrade in ION Setup involves:

• upgrading the device firmware, and

• upgrading the device template.

You can download your device’s latest firmware and template fromwww.schneider-
electric.com. Save the files in the .../ION Setup/TEMPLATE folder for easy access.

Upgrading the device firmware and template

1. Open the Setup Assistant for your meter in ION Setup. See the ION Setup Help for 
instructions.

2. Select the Template screen.

3. Click the Firmware Upgrade tab, then click Upgrade. Enter your meter password 
(if prompted) and click OK.

WARNING
HAZARD OF UNINTENDED OPERATION
• Do not use the meter for critical control or protection applications where human 

or equipment safety relies on the operation of the control circuit.
• Be aware that an unexpected change of state of the digital outputs may result 

when the supply power to the meter is interrupted or after a meter firmware or 
template upgrade.

Failure to follow these instructions can result in death, serious injury or 
equipment damage.
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NOTE: If you want to retain customized meter template settings, other than those listed
in the Template Paste Options dialog box (see Step 6), click on the Save to PC tab and
click Save. Save your template as a .DCF file. Select this file in Step 5 instead of the
file obtained from the website. 

4. Browse to the .UPG file (device firmware) that you downloaded from the website 
and click Open. Type your ION Setup password when prompted and click OK.

5. Browse to the .DCF file (device template) that you downloaded from the website (or 
saved from your meter in Step 3) and click Open. The Template Paste Options 
dialog box appears. 

6. Select the options that you do want to be retained and clear any options that you 
do not want to retain then click OK. 

7. Track the progress of the upgrade. 

After the firmware download is complete, ION Setup attempts to verify the firmware. 
If the verification fails, contact Technical Support.

8. Click Exit when you get a message that the upgrade is complete.

Upgrading firmware using Power Monitoring Expert

Power Monitoring Expert includes the Device Upgrader utility for upgrading devices.

NOTE: Supervisor-level access (level 5) is required to upgrade the device.

Before using Device Upgrader
Data stored in the meter's memory is lost during the firmware upgrade. This includes 
waveforms, Min/Max values, and information stored in the Data Recorder and 
Integrator modules. Ensure you save your meter’s data before you upgrade your meter.

You need the applicable upgrade (.upg) files for your meter, which are available from 
www.schneider-electric.com. Save these files in a folder that is accessible from your 
Power Monitoring Expert computer.

For more information about using Device Upgrader, refer to the Power Monitoring 
Expert online help.

Using Device Upgrader
1. Stop the ION Log Inserter Service and the ION Virtual Processor Service.

2. Start Management Console.

3. Select Tools > System > Device Upgrader. Type your username and password 
in the login prompt. 

A dialog box displays recommendations and warnings regarding the upgrade 
operation. Make sure you read and understand these warnings before you click OK. 
If you need to implement any changes because of the recommendations and 
warnings, close Device Upgrader, make the changes then re-open Device Upgrader 
and continue.

The Device Upgrader utility appears.

4. Select your meter type from the List Devices of Type box.
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5. Select the appropriate meter from Select Devices to Upgrade box. To select 
multiple devices, hold down CTRL while clicking each device. 

6. Click Select File in the Select Revision section. Locate and select the upgrade 
(.upg) file that you downloaded from the website, then click Open.

7. Select or clear the Save/Restore Framework check box (selected by default). If 
selected, this keeps a copy of your current framework template during the upgrade. 
After the firmware upgrade is complete, Device Upgrader restores your framework 
template.

NOTE: Device Upgrader loads new meter firmware that does not contain any
framework templates. If you want to preserve customizations that you have made to
your device framework, make sure you select Save/Restore framework. However, if
you intend to replace the existing meter framework with a new one (for example, a new
default meter template that you downloaded), clear Save/Restore framework.
If you intend to replace the meter’s framework configuration with a new template, it is
recommended that you upgrade using ION Setup. See “Upgrading firmware using
ION Setup” on page 45 for information.

8. Specify how Device Upgrader responds to an unsuccessful upgrade in the Failure 
Handling section (you only need to do this if you are upgrading multiple devices):

– Select Halt After, then enter a number in the box to specify how many attempts 
you want Device Upgrader to make before stopping during an unsuccessful 
upgrade. By default, the utility is set to stop after the first unsuccessful upgrade. 

– Select Ignore All to attempt to upgrade all of the selected devices regardless of 
the number of devices that do not upgrade successfully. 

NOTE: Firmware upgrade error codes are described in the Power Monitoring Expert
online help.

9. Click Select File in the Select Revision section. Navigate to the upgrade (.upg) file 
that you want to use and click Open. 

This file will be downloaded to all the devices that are highlighted in the Select 
Devices to Upgrade list.

10. Click Upgrade to upgrade the selected device(s).

The Upgrade Status box shows each stage in the upgrade process. The completed 
progress bar indicates what percentage of the upgrade is complete. Each completed 
upgrade is noted in the Upgrade Status box.

11. Restart the ION Log Inserter Service and the ION Virtual Processor Service.

NOTE: If connection to the device is lost, or if power to the device is interrupted during
an upgrade, restart the Device Upgrade utility procedure.

Editing accumulated energy values using ION Setup

You can edit energy values such kWh and kVARh using ION Setup.

NOTE: Ensure you have recorded accumulated energy values before upgrading your
meter’s firmware. You can then re-enter these values after the upgrade.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Select the Template screen.
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4. Click the Register Edit tab, click Energy then click Display. Enter your meter’s 
password (if prompted) and click OK.
The Register Editor screen displays.

5. Click Edit to enable editing.

6. Enter values for kWh, kVAh and kVARh as required. Click Send to finish.
Only values that have the checkbox selected will be sent to the meter.

7. Click Close to close the Register Editor screen.
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Chapter 5 Basic setup
This chapter explains how to perform basic meter setup using the front panel, Power 
Monitoring Expert or ION Setup.

In this chapter
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Introduction
Basic configuration of the meter is provided by the Power Meter module. The Power 
Meter module is the main connection between the power system measurements and 
all other ION modules in the device. This module reports the values for all voltage, 
current and power measurements. The Power Meter module’s setup registers describe 
details of the power system being monitored. 

Basic setup is typically performed when the meter is initially put into service, although 
the device cannot operate properly until the Volts Mode and PT and CT ratios are set. 
After this basic setup is performed the meter operates properly, and there is generally 
no need to make further changes to the basic setup.

Other advanced parameters can be configured, if needed. See the description of the 
Power Meter module in ION Reference for more information.

Basic setup parameters

1 These registers are typically set when the device is commissioned. Changing the values of these registers 
while the device is in service is not recommended.

Configuring basic setup

Use the front panel, Power Monitoring Expert or ION Setup to perform basic meter 
setup.

Menu item Setting options Default Description

Volts mode1

– 9S - 4 Wire Wye/Delta
– 29S - 4 Wire Wye
– 35S - 3 Wire
– 36S - 4 Wire Wye
– Demo

*See note

The power system’s configuration and supported form factor.
36S - 4 Wire Wye is only available on the socket meter.

Note: The default setting varies depending on the meter form factor. 
Ensure you verify that the correct option is selected for your power 
system before putting the meter into service.

PT Primary1 1.0 to 999999.00 120 The Potential Transformer’s primary winding rating

PT Secondary 1.0 to 999999.00 120 The Potential Transformer’s secondary winding rating

CT Primary1 1.0 to 999999.00 5 The Current Transformer’s primary winding rating

CT Secondary1 1.0 to 999999.00 5 The Current Transformer’s secondary winding rating

VA Polarity
– Normal
– Inverted

NORMAL The polarity of the Potential Transformer on V1

VB Polarity
– Normal
– Inverted

NORMAL The polarity of the Potential Transformer on V2

VC Polarity
– Normal
– Inverted

NORMAL The polarity of the Potential Transformer on V3

IA Polarity
– Normal
– Inverted

NORMAL The polarity of the Current Transformer on I1

IB Polarity
– Normal
– Inverted

NORMAL The polarity of the Current Transformer on I2

IC Polarity
– Normal
– Inverted

NORMAL The polarity of the Current Transformer on I3

Phase Rotation
– ABC
– ACB

ABC The expected rotation of the voltage phases (ABC or ACB)

ScaleRevParam
– ON
– OFF

ON Whether or not PT/CT correction is applied to displayed and recorded 
meter data 
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Using the front panel
Access the BASIC SETUP menu to configure the power system settings. See “BASIC 
SETUP menu” on page 32 for instructions.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select the Basic Setup screen and click the PT/CT Ratios tab.

3. Configure each register as required by selecting the parameter and clicking Edit.

NOTE: Scaled Rev Param determines if the PT/CT correction is applied to displayed
and recorded meter data. By default, Scaled Rev Param is set to ON and PT/CT
corrections are applied.

Using Designer
Open your meter in Designer and navigate to the Basic Configuration Framework. 
Right-click on the Power Meter module to edit.
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Chapter 6 Security
ION8650 meters offer standard and advanced device security. Standard security is 
enabled by default from the factory. Advanced security allows you to configure more 
specific security settings, such as configuring advanced security through the front 
panel, communications lockouts to limit the number of invalid login attempts, and to add 
up to 50 users, each with unique access privileges. Procedures for changing these 
security settings using the front panel, Power Monitoring Expert or ION Setup are 
detailed in this chapter.

There are also security features available for revenue meters. The scaled operational 
values (SOV) feature, which allows scaling of non-revenue data on revenue-locked 
meters, is described in this chapter.

In this chapter
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Security overview
Your Schneider Electric product is equipped with security-enabling features.

These features arrive in a default state and can be configured for your installation 
needs. Please note that disabling or modifying settings within the scope of these 
individual features can impact the overall security robustness of the device and 
ultimately the security posture of your network in either positive or negative ways.

Review the security intent and recommendations for the optimal use of your device’s 
security features.

Products are hardened to increase security robustness. This is an ongoing process 
consisting of secure development practices, inclusion of security features and testing 
at our security test facilities. Following system hardening best practices is also 
necessary to help ensure your overall system security.

See the Cybersecurity Hardening Best Practices white paper for suggested best 
practices.

Security features on your device

Your device comes with security features that you can configure to help protect against 
unauthorized configuration and access to your device’s data through its user interfaces 
or communications.

Standard meter security
Anytime you make configuration changes to your device, you must enter a password. 
Standard security is enabled by default from the factory. See “Standard meter security” 
on page 61.

Advanced meter security
Advanced security allows you to: 

• Enable or disable Modbus programming.

• Configure communications lockouts to limit the number of invalid login attempts 
permitted for each protocol and set the priority of associated device events.

• Add up to 50 users, each with unique access privileges. 

• Enable advanced security access through the front panel.

See “Advanced meter security” on page 62.

Revenue meter security 
Your meter can be protected by hardware-lock security and anti-tamper sealing. See 
“Additional revenue metering security” on page 77.

Software security
Power Monitoring Expert or ION Setup add another layer of access-level security to the 
device. With Power Monitoring Expert or ION Setup, you can configure multiple users 
with different passwords and specify access rights. Power Monitoring Expert or 
ION Setup security only applies to users who are accessing the device using the 
software. 



7EN02-0306-03 55

ION8650 User Manual Chapter 6 - Security 

For more information on Power Monitoring Expert or ION Setup security, refer to the 
software’s online help.

Network port control
This feature provides you with the ability to enable and disable individual network ports 
and to change port numbers from their default values.

Leaving unused ports open provides additional attack surfaces for a potential attacker. 
Minimizing the number of ports open on the device reduces the likelihood of 
unauthorized intrusions by providing fewer entry points.

Once your meter is configured, all network ports related to unused protocols should be 
placed in the OFF state/position. Minimize the number of open ports, temporarily 
opening ports for activities such as periodic firmware / software downloads when 
required.

Network ports that remain open should be changed from their default values wherever 
possible.

Event logging
Your meter records meter functions, events and changes to meter parameters and logs 
them as entries in the event log.

Event logs entries are timestamped and user-related events are associated with the 
username that was logged into the meter. Security-related events such as resets, 
successful or unsuccessful login attempts, user lockout or meter configuration changes 
are also recorded in the event log along with a timestamp and the username associated 
with the event. The event log can be used to monitor system events, assist in confirming 
security compliance, or assist in tracking unauthorized intrusion attempts.

Syslog
This feature allows you to push event log information to a centralized syslog server.

When the event log of a meter is full, new log entries can overwrite existing entries. By 
pushing the event log information to a syslog server, older event log information can be 
preserved and used as part of an information storage and retrieval strategy.

NERC CIP 

The North American Electric Reliability Corporation (NERC) has created Critical 
Infrastructure Protection (CIP), a set of standards that can assist in monitoring and 
protecting the assets that make up the power transmission system in North America. 
NERC CIP is made up of standards that cover aspects such as critical cyber asset 
identification, electronic security perimeters, and systems security management.

This meter has incorporated security features that can assist in making a facility 
NERC CIP compliant.

Related topics
For more information about NERC or the CIP standards, refer to the documentation 
located at http://www.nerc.com.
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Time synchronization security considerations

Depending on the software security settings, a workstation that connects to the device 
may send a time synchronization signal to synchronize the device's internal clock with 
the workstation's clock. This can cause overlaps in the demand intervals, and 
timestamps in the data logs may not be accurate.

The Time Sync Source setup register, located in the Clock module, identifies the only 
communications port that will accept time synchronization broadcasts. You can 
configure this setup register through ION Setup or the Designer component of Power 
Monitoring Expert.

Refer to the Time synchronization & timekeeping technical note for more information on 
implementing time synchronization.

Recommended device security configuration

The following meter configuration is recommended to help improve security on your 
meter:

• Enable front panel security on your device.

• Enable advanced security on your device. 

– Disable web server programming to help prevent configuration access to your 
device over the web.

– Disable Modbus programming to help prevent access to your device using 
Modbus. This disables write access to all Modbus registers, and only allows read 
access to the registers in the Modbus Slave modules.

– Configure the protocol lockouts to help minimize access to your device.

– Ensure that the Factory user is disabled.

– Configure users and passwords to help minimize access to your device.

• Disable all unused network ports.

• Disable all unused communication ports.

• Configure the protocol controls to set the appropriate read/write access and change 
port numbers.

• Change connection ports from their default values wherever possible.

• Change the designated reader from USER0 to a different user.

If your device’s front panel or user passwords are lost, you must return the device for 
factory reconfiguration, which resets your device to its factory defaults and destroys 
all logged data.

NOTICE
DATA LOSS
Record your device’s front panel and user password information in a secure 
location.

Failure to follow these instructions can result in data loss.
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Password best practices

• Change your device’s front panel password from the default factory value of 
0 (zero).

• Make your meter’s front panel and user-specific passwords as complex as possible. 
For passwords created in ION Setup, there is a password strength indicator. 
Password strength ranges from Very weak to Very strong. 

• Schedule regular changes to your device’s front panel and user passwords.

• Record the device’s front panel and user passwords in a secure location.

If your device’s front panel or user passwords are lost, you must return the device for 
factory reconfiguration, which resets your device to its factory defaults and destroys all 
logged data.

Additional security recommendations

• For the highest level of security, use a hardware-locked, sealed device with 
advanced security enabled and configured for minimum access.

• Protect all Ethernet devices with a properly configured firewall that prevents Telnet 
access over port 23.

• Save a copy of your device’s security configuration (.scf) file in a secure location in 
addition to the password and user information.

• Set device communication ports to the Factory protocol only when necessary to 
permit access by Schneider Electric Technical Support, and return the ports to their 
original settings as soon as possible.

• Set the device’s time synchronization source to a secure communications port, and 
disable time synchronization on all other ports. See the Time synchronization & 
timekeeping technical note for more information.

Default security settings

The meter ships from the factory with standard security enabled and a default password 
of 0 (zero). Default device security values for devices shipping from the factory are 
defined in the following table. If you upgrade an existing device to use the latest 
firmware, your device’s existing security values are not affected; the values will retain 
their current settings.

NOTICE
DATA LOSS
Record your device’s front panel and user password information in a secure 
location.

Failure to follow these instructions can result in data loss.

Security setting Value
Allow Web Server programming Disabled (not allowed)

Allow Modbus programming1 Disabled (not allowed)

Protocol lockout attempts Eight (for all protocols)
Session timeout 30 minutes
Lockout duration 1440 minutes (24 hours)
Valid login event priority 0
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1 This setting only applies to advanced security.

Unless otherwise noted, these security settings apply regardless of whether the device 
has standard or advanced security enabled; for example, if you change the lockout 
duration to 720 minutes (12 hours), that is the lockout duration for the device in 
standard security or in advanced security.

Entering the front panel password
When you attempt to change a setting on the front panel with basic security enabled, 
you are presented with the password screen. After you enter the correct password, you 
do not have to re-enter it for other any other changes unless you exit the configuration 
session or the session has elapsed.

To enter the password:

1. Use the arrow buttons to change the value of the highlighted digit. The up arrow 
increments the number and the down arrow decrements it.

2. Hold down an arrow button for about one second to change the position of the 
cursor. The up arrow moves the cursor left one position and the down arrow moves 
the cursor right one position.

3. Press the ALT/ENTER button once you have the value that you want.

Entering advanced security username or password when 
accessing the device via the front panel
When you attempt to change a setting through the front panel of a device that has 
advanced security enabled, you are prompted for a username and password. See 
“Configuring meter security in ION Setup” on page 65 for information regarding setting 
advanced security on your meter.

If the access level associated with the user is not sufficient to change the setting, the 
NOT AVAILABLE message is displayed. 

NOTE: The printable ASCII character set is used when entering an advanced security
password through the front panel. If a password created through ION Setup contains
any of the extended ASCII character set, that password cannot be entered through the
front panel.

Invalid login event priority 128
Lockout event priority 255
Protocols selected for security All protocols (ION, HTTP, FTP, Telnet, Factory, Front panel)
Factory user Disabled
Factory Access Minutes 0

Security setting Value

ENTER PASSWORD

HOLD ARROW KEY TO MOVE CURSOR



7EN02-0306-03 59

ION8650 User Manual Chapter 6 - Security 

To enter the username and password through the front panel:

1. Use the arrow buttons to change the highlighted character in the username. The up 
arrow moves the cursor forward through the list of available characters and the 
down arrow moves the cursor backward. Hold the up arrow to move the cursor one 
position to the left or hold the down arrow to move the cursor one position to the 
right.
NOTE: Usernames are fixed as USER1 through USER50. USER0 is the 
designated front panel user and is not a valid user through advanced security. The 
meter ignores leading zeros. For example, USER1, USER01 or USER001 are all 
recognized by the meter as User1.

2. Press the ALT/ENTER button once you have the value that you want. The ENTER 
PASSWORD message appears.

3. Use the arrow buttons to change the value of the highlighted character. The up 
arrow increments the number and the down arrow decrements it. Hold the up arrow 
to move the cursor one position to the left or hold the down arrow to move the cursor 
one position to the right.

4. Press the ALT/ENTER button once you have the value that you want.

If the username or password is not correct, the INVALID LOGIN message is 
displayed. All invalid access attempts are logged in the event log.

Entering a username or password when accessing the device via 
software
When you attempt make changes through software to a device that has security 
enabled, you are prompted for a username and password (if advanced security is 
enabled) or a password (if standard security is enabled).

1. Select a user or enter a valid username (if advanced security is enabled).

2. Enter the appropriate password and click OK. 

NOTE: Depending on your software’s security settings, you may also be prompted for
a software username and password.

ENTER PASSWORD

HOLD ARROW KEY TO MOVE CURSOR

ENTER USER ID

HOLD ARROW KEY TO MOVE CURSOR

USER1
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Allowing Power Monitoring Expert Windows services access to 
devices with Advanced security enabled 
If you are using your device with Power Monitoring Expert, many Power Monitoring 
Expert Windows services need constant access to the device. These services include 
the ION Log Inserter Service, the ION Virtual Processor Service and ION Site Service.

When advanced security is enabled on the device, these services may not have 
sufficient access rights to perform their operations. You must specify a user with 
sufficient access rights for these services. These services can access devices with 
standard security enabled without further configuration. For more information on these 
services, see the online Power Monitoring Expert Help.

NOTE: You can configure a separate user for allowing services access. 
If you encounter difficulties with Power Monitoring Expert accessing the device:
- these services may not have access rights to the device;
- the original username and password may have changed; 
- the user configured to allow the services access to the device may be locked out as a
result of invalid login attempts; see “Communications protocol lockout feature” on
page 66.

1. Start Management Console and click Devices in the System Setup Pane.

2. Select the device (or select multiple devices) that has advanced security enabled, 
right-click and select Security. The Meter Security Settings dialog box appears.

3. Select the username you want from the dropdown list. The Change Password 
button becomes active. Select the check box if you want to allow this user to send 
time synchronization signals to the device. Click OK.

4. Enter the valid password, re-type the password to confirm and click OK.
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Device security configuration
Security configuration overview

There are three main components in configuring device security:

Use the front panel to configure basic security or use the ION Setup (version 3.0 and 
later) Setup Assistant security wizard to configure standard or advanced security. 

You can also use ION Setup advanced mode or the Designer component of Power 
Monitoring Expert to configure security settings. See the software’s online Help for 
more information.

Standard meter security
Standard meter security is enabled by default on the meter; all configuration functions 
are password-protected. 

• If you make configuration changes to the meter using the front panel, the meter 
prompts you for its password before accepting any configuration changes. You do 
not need to re-enter the password for each subsequent change. However, if you 
perform no additional configuration changes for five minutes, the meter exits setup 
mode; to make any further changes, you need to re-enter the Setup menu and 
provide the valid meter password.

Configure device security Enable/disable factory access

1. Set basic security options:

2. Configure communications protocol lockout options:

– Change the front panel password.
– Disable Web Server programming.
– Disable Modbus programming.

2a. Select the protocols to configure.

2b. Configure protocol-specific settings:
– Set the number of attempts before the protocol is 

locked out.
– Set the session timeout.

3. Configure users:
– Determine user access.
– Set user passwords.

1. Configure factory access minutes.

2. Enable/disable factory user (for devices with 
advanced security enabled).

See “Set basic security options” on page 65.

2c. Configure global lockout settings:
– Enter a lockout duration.
– Set the priority of meter access events.

See “Configuring communications protocol lockout” on 
page 67.

See “Configure users” on page 70.

Follow security best practices

1. Implement recommended device security 
configuration.

2. Follow password best practices.

3. Follow the additional device security 
recommendations.

See“Recommended device security configuration” on 
page 56

See “Password best practices” on page 57.

See “Additional security recommendations” on page 57.

See “Configuring the factory access minutes setup 
register” on page 73.

See “Configure users” on page 70.



Chapter 6 - Security  ION8650 User Manual

62 7EN02-0306-03

If you make any configuration changes using ION Setup or Power Monitoring Expert 
software, you are prompted by the meter for its password (in addition to the password 
used to access the software). 

After you enter the correct meter password and confirm the new configuration, the 
change is set on the meter.

Advanced meter security
Advanced security allows you to: 

• Enable or disable Modbus programming. Disabling Modbus programming disables 
write access to all Modbus registers, and only allows read access to the registers in 
the Modbus Slave modules.

• Add up to 50 users, each with unique access privileges. 

• Configure communications protocol lockouts to limit the number of invalid login 
attempts permitted for a user using a particular password, protocol and 
communications method combination and set the priority of login-related meter 
events.

• Enable advanced security functions through the front panel.

Configuring basic meter security using the front panel

This section describes the security configuration options available to front panel users. 
Instructions are provided on the following procedures:

• Changing the meter password.

• Disabling (and enabling) the basic security password security check.

• Resetting the meter password.

• Enabling and disabling web configuration.

Changing the basic security password
By default, the basic security password is set to 0 (zero). The password can be changed 
to any number up to eight digits long. It is highly recommended that you change the 
password from the default value. See “Password best practices” on page 57 for 
recommendations.

To change the basic security password:

1. Hold down the ALT/ENTER button to access the SETUP menu.

2. Use the up and down arrows to highlight SECURITY then press the ALT/ENTER 
button.

3. Use the up and down arrows to highlight MODIFY PASSWD then press the ALT/
ENTER button.
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4. Enter the current meter password when prompted (see “Entering the front panel 
password” on page 58). After you enter the current password, you are able to modify 
the password:

5. Use the up and down arrow buttons to change the value of the highlighted digit. The 
up arrow increments the number and the down arrow decrements it.

6. Hold down an arrow button for about one second to change the position of the 
cursor. The up arrow moves the cursor left one position and the down arrow moves 
the cursor right one position.

7. Press the ALT/ENTER button once you have the value that you want. You are 
prompted for your current password before the new password is saved.

If your device’s front panel or user passwords are lost, you must return the device for 
factory reconfiguration, which resets your device to its factory defaults and destroys 
all logged data.

Enabling and disabling the basic security password security check
Disabling the password security check allows changes to all the meter's settings 
through the front panel and software without a security check. This procedure is not 
recommended but may be necessary in some rare cases (for example, if the 
communications interface you are using does not support the meter’s security 
protocols).

The enable/disable password feature is used with basic security only. If advanced 
security has been enabled on your meter, a NOT AVAILABLE message is displayed on the 
meter’s front panel when you attempt to disable the basic security password.

NOTE: It is highly recommended that any devices in the field have the password
security check enabled. Non-secure access to critical settings in the meter, such as PT
and CT ratios, is not advisable. 

Disabling the password security check

1. Press the ALT/ENTER button to enter the SETUP menu. 

2. Use the arrow buttons to scroll down the menu and select SECURITY, then press 
ALT/ENTER.

3. Enter the valid meter password at the password prompt. You are then presented 
with the SECURITY menu.

NOTICE
DATA LOSS
Record your device’s front panel and user password information in a secure 
location.

Failure to follow these instructions can result in data loss.

MODIFY PASSWORDMODIFY PASSWORD

HOLD ARROW KEY TO MOVE CURSOR
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4. Use the arrow buttons to scroll down the menu and select DISABLE SECURITY 
then press the ALT/ENTER button.

5. Select PROCEED, then select YES at the prompt to confirm the change.

Your meter’s password is now disabled; changes to settings in the meter do not 
require a valid password. To re-enable the password security check, see “Enabling 
the password security check”, below).

6. Press the ALT/ENTER button to return to the SETUP menu.

Enabling the password security check

When you re-enable the password security, you are required to enter a new password. 

To re-enable password security:

1. Press the ALT/ENTER button to enter the SETUP menu. 

2. Use the arrow buttons to scroll down the menu and select SECURITY, then press 
ALT/ENTER.

3. Select MODIFY PASSWD then press the ALT/ENTER button.

The message FAC DEFAULT appears in the middle of the screen. If you want to use 
the factory default password, press the ALT/ENTER button. If you want to set the 
password to a different number, use the instructions in “Changing the basic security 
password” on page 62.

4. Press the ALT/ENTER button after you enter your new password.

5. Select YES to confirm the change and return to the SETUP menu.

The password security check is re-enabled. All changes to the device's configuration 
require the new meter password.

Resetting the front panel password
In the event that you forget or lose your meter password, you can reset the meter’s front 
panel password to the factory default value of 0 (zero). Resetting the password requires 
that the meter be in TEST mode. 

• If your meter has the password security check disabled, you can put the meter into 
TEST mode using Power Monitoring Expert or ION Setup. 

• If your meter has the password security check enabled (or your meter has the 
hardware lock security option enabled), you must remove the meter's outer cover to 
access the TEST mode button.

Refer to “Switching to TEST mode” on page 199 for details on putting the meter into 
TEST mode.

To reset the front panel password to the factory default:

1. Put your meter into TEST mode.

2. Press and hold down the ALT/ENTER button and the demand reset switch 
simultaneously.

Continue to press and hold the button and switch until a message appears on screen 
stating that the password has been reset to the default (this might take a few 
seconds). Password security is now enabled and the front panel password is 0 (zero).
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Enabling and disabling web configuration
To enable or disable the ability to configure your meter remotely via a web browser:

1. Press the ALT/ENTER button to enter the SETUP menu.

2. Use the arrow buttons to scroll down the menu and select SECURITY, then press 
ALT/ENTER.

3. Enter the valid meter password at the password prompt. You are then presented 
with the SECURITY menu.

4. Use the arrow buttons to scroll down the menu and select WEB CONFIG, then 
press the ALT/ENTER button.

5. Select ENABLED or DISABLED as appropriate then press ALT/ENTER.

6. Select YES to confirm the change and return to the SETUP menu.

Configuring meter security in ION Setup

You can fully configure standard and advanced security on your meter using 
ION Setup.

In order to change security settings, you must be logged into ION Setup with an 
appropriate ION Setup user level. You must also have the appropriate meter-level 
security access to configure meter security.

If your meter’s display (front panel) or user passwords are lost, or if you disable front 
panel programming and then configure communications so that you cannot 
communicate to or configure your meter, you must return the meter to the factory, 
where your meter is reset to its factory defaults and all logged data is lost.

Set basic security options
1. Start ION Setup.

2. Open the Setup Assistant for your device. 

3. Navigate to Security. Select Security Mode and click Edit. The open dialog box 
appears.

4. Select the appropriate security configuration file (*.scf) to configure your meter:

– Standard: allows you to configure basic security, TCP/IP port settings, and 
communications protocol lockout.

NOTICE
DATA LOSS
• Record your device’s display and user password information in a secure location.
• Do not change communications ports settings with the Allow Front Panel 

Programming setting cleared (unchecked).
• Ensure you maintain sufficient access to communicate to and configure your 

device.

Failure to follow these instructions can result in data loss.
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– Advanced: includes the standard security features and adds user access/
password security settings.

NOTE: If a setting is not supported by the existing firmware, a message is 
displayed indicating some settings will not be programmed

5. The standard options or advanced options configuration screen appears. Configure 
the security parameters as required, some parameters can only be configured 
using advanced security:

NOTE: Changing communications port settings with Allow Front Panel Programming
cleared (unchecked) may cause a loss of communications with your device, and render
it inoperable.

6. Click Next or Finish.

Click Next if you are configuring advanced security. The Select protocol lockout 
options screen appears; see “Configuring communications protocol lockout” on 
page 67.

Click Finish if you are configuring standard security. A prompt appears asking if you 
want to save your security settings in a file. Click Yes to save the settings or click No 
if you want do not want to save your security settings to a file.

Communications protocol lockout feature
The communications protocol lockout advanced security feature allows you to set the 
number of invalid login attempts that each user can make using a particular protocol 
and communications method before being locked out (a user is defined as a user login 
and password combination). For protocols that are not session-based (ION and HTTP), 
you can configure how often the device registers invalid login attempts. You can also 
configure the lockout duration for all configurable protocols. By default, all protocols are 
set to eight invalid attempts and a 24-hour lockout duration.

Once a user is locked out, the device will not accept login attempts from that user on 
that protocol and communications method until the lockout duration has passed. Invalid 
login attempts accumulate until the user has completed a valid login or been locked out. 

Parameter Standard/advanced Details

Meter password Standard/advanced Default meter password is 0 (zero)

Allow front panel 
programming Standard/advanced This option allows you to enable or disable the ability to configure 

your device using the display. 

Allow broadcasting 
time synchronization Advanced only This option can only be disabled in advanced security and is 

enabled for standard security.

NOTICE
DATA LOSS
• Record your device’s display and user password information in a secure 

location.
• Do not change communications ports settings with the Allow Front Panel 

Programming setting cleared (unchecked).
• Ensure you maintain sufficient access to communicate to and configure your 

device.

Failure to follow these instructions can result in data loss.
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For example, once USER01 has been locked out using ION over Ethernet, USER01 
cannot access the device using ION over Ethernet until the lockout duration has 
passed, even if USER01 enters the correct password. However, if the user enters the 
correct USER/password combination before being locked out, the invalid attempt 
counter is reset to zero. Even if the user is locked out using ION over Ethernet, that user 
can still access the device by entering the correct USER/password combination over a 
different protocol and communications method (for example, connecting to the device’s 
front optical port using ION protocol).

You can also configure the event priority for device access and protocol lockout events, 
so they can be viewed in the device’s event log. By default, the invalid login event 
priority is set to 128 and the lockout event priority is set to 255. The device access event 
priorities can be configured by clicking Events on the protocol lockout screen.

Configuring communications protocol lockout

See “Communications protocol lockout examples” on page 68 for examples of how 
these settings affect login and communications. 

NOTE: These settings apply regardless of whether standard or advanced security is
enabled on your device.

1. Select the check boxes beside the protocols for which you want to enable 
communications protocol lockout.

2. Highlight a selected protocol and click Edit to modify the lockout values for that 
protocol. 

– Protocol lockout specifies the number of invalid login attempts allowed per 
user/password combination before access is denied to that user over that 
protocol and communications method. This value can range from 0 to 255.

NOTE: If Protocol lockout attempts is set to 0, there is no limit to the number of invalid
login attempts and that protocol will never be locked out. However, the invalid login
attempt events are recorded if the meter access events are configured to record invalid
access attempts.

– Session timeout specifies the active duration for a protocol; during this time, 
repeated invalid login attempts using the same USER/password combination are 
not registered (repeated invalid attempts with different combinations are still 
registered). This only applies to protocol which are not session-based and send 
credentials with each packet. Configuring this setting prevents accidental 
lockouts and filling the device’s event log with protocol access events. This value 
can range from 1 minute to 43200 minutes (30 days). 
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Click OK. Repeat for all protocols on which you want to enable communications 
protocol lockout.

3. Type the lockout duration, in minutes. The lockout duration specifies how long the 
meter ignores communication attempts by a user that is locked out. The lockout 
duration value applies to all lockout-enabled protocols.

Once a user is locked out, the user cannot access the meter using the same protocol 
and communications method, regardless of whether or not the user enters the correct 
USER/password combination.

4. Click Events to enter the event priority for valid login attempts, invalid login 
attempts and protocol lockouts. The event priorities apply to all lockout-enabled 
protocols. Enter 0 (zero) to disable event logging for a particular type of login 
attempt.

5. Click Next. The Define individual users/passwords screen appears. See 
“Configure users” on page 70 for the next step in configuring advanced security.

Communications protocol lockout examples
In the following examples: 

• The configured users and their valid passwords are:

– USER01/password 11

– USER02/password 22

• For the ION protocol: 

– Protocol Lockout is configured to allow 3 invalid login attempts by a particular 
user/password combination before locking the user out. 

– Session timeout is set to 30 minutes. 

• For all protocols that can be locked out:

– Lockout duration is set to 1440 minutes (one day). 

– The meter is configured to log invalid event entries and lockouts.
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Scenario 1

This example illustrates what happens when a user repeatedly enters the same 
incorrect password when attempting to access the meter. 

1. An access attempt is made using ION over Ethernet by USER01 but with a 
password of 0. 

The user is informed of the invalid attempt and cannot access the meter. The invalid 
attempt is logged in the event log and the counter of invalid attempts is incremented 
to 1. 

2. The user attempts to access the meter again 10 minutes later with USER01/
password 0. 

The user cannot access the meter but the event is not logged and the counter of 
invalid attempts is not incremented, because the session timeout has not elapsed. 

3. The user attempts to access the meter again with the invalid USER01/password 0 
combination 30 minutes after the initial attempt. 

Because the session timeout has elapsed, the event is logged and the counter of 
invalid login attempts is incremented to 2. 

4. The user attempts to login again after 30 minutes has elapsed with the same invalid 
USER01/password 0 combination, the event is logged and the counter of invalid 
attempts is incremented to 3. 
USER01 is locked out for the duration of the lockout time (1440 minutes), and cannot 
connect to the meter using ION over Ethernet, regardless of whether or not they 
subsequently try to login with the correct user/password combination. The lockout 
event is logged by the device. USER01 can access the meter through another 
communications method (for example, ION over serial) if they enter the correct 
USER/password combination.

Regardless of the invalid attempts of USER01, USER02 can access the meter using 
ION over Ethernet if they enter the correct password; they are not affected by the 
lockout. 

T=0
Invalid login 
counter = 1

T=10
Invalid login 
counter = 1

T=32
Invalid login 
counter = 2

T=65
Invalid login 
counter = 3

Session timeout = 30

Protocol lockout event
USER01 locked from using 
ION over Ethernet for 1440 
minutes (1 day)
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Scenario 2

This example illustrates what happens when different invalid combinations of user and 
password are entered. 

1. An access attempt is made using ION over Ethernet by USER01 but with a 
password of 0. 

The user is informed of the invalid attempt and cannot access the meter. The invalid 
attempt is logged in the event log and the counter of invalid attempts is incremented 
to 1. 

2. The user attempts to access the meter again with USER01/password 3. 

The user is informed of the invalid attempt and cannot access the meter. In this case, 
this is considered a new invalid attempt because it is a different combination of user 
and password. It is logged in the event log and the counter of invalid attempts is 
incremented to 2.

3. The user attempts to access the meter again with USER01/password 4. 

The user is informed of the invalid attempt and cannot access the meter. This is 
considered a new invalid attempt because it is a different combination of user and 
password. It is logged in the event log and the counter of invalid attempts is 
incremented to 3. The device logs a lockout event.
USER01 is locked out for the duration of the lockout time (1440 minutes), and cannot 
connect to the meter using ION over Ethernet, regardless of whether or not they 
subsequently try to login with the correct user/password combination. USER01 can 
access the meter through another communications method (for example, ION over 
serial) if they enter the correct USER/password combination. 

Regardless of the invalid attempts of USER01, USER02 can access the meter using 
ION over Ethernet if they enter the correct password; they are not affected by the 
lockout. 

Configure users
Advanced security allows configuration of up to 50 users, each with unique access 
rights to the meter. 

NOTE: User names are fixed as USER01 through to USER50.

T=0
USER01
Password 0
Invalid login 
counter = 1

T=10
USER01
Password 3
Invalid login 
counter = 2

T=22
USER01
Password 4
Invalid login 
counter = 3

Session timeout = 30

Protocol lockout event
USER01 locked from using 
ION over Ethernet for 1440 
minutes (1 day)
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1. Select the check boxes of the users you want to configure (USER01 through 
USER50). Select the appropriate access for each user: 

Ensure that there is at least one user that can perform full meter security configuration.

NOTE: Regardless of user permissions, a hardware-locked device can only be placed
into test mode using the front panel. You cannot place a hardware-locked meter in
TEST mode using Power Monitoring Expert or ION Setup.

When configuring users, in most cases, you must set Read Access to YES. However, 
you can set up a user without read access; for example, you can create a user who 
can only timesync the meter. In some cases (such as advanced security 
configuration access), you must set multiple access options to YES. When you are 
configuring advanced security, the software rejects unacceptable or unsecure user 
configurations.

2. Select a user, then click Password to set a password for that user. Type the 
password in the New password and Confirm new password fields and click OK. 
See “Password best practices” on page 57 for more information on setting 
passwords.

If your device’s front panel or user passwords are lost, you must return the device for 
factory reconfiguration, which resets your device to its factory defaults and destroys 
all logged data.

NOTE: Select Show password when user selected to display the password
associated with that user. This feature is intended to help ensure that the correct
password is entered for each user.

Access Description

Time sync The user can set the meter’s time and time synchronization parameters.

Read The user can view all parameters except the security configuration.

Peak demand reset The user can reset peak demand values.

Comm Configure The user can configure the communication settings.

Test mode The user can put the meter into test mode.

Full meter config The user can configure all aspects of the meter except demand resets, test mode or 
security.

Security config The user can configure security.

NOTICE
DATA LOSS
Ensure you maintain sufficient access to communicate to and configure your 
device.

Failure to follow these instructions can result in data loss.

NOTICE
DATA LOSS
Record your device’s front panel and user password information in a secure 
location.

Failure to follow these instructions can result in data loss.
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3. Click Finish when you are done configuring users to apply the security settings to the 
device. A prompt appears asking if you want to save your security settings in a file.

– Click Yes to save your settings in a file.

– Click No if you do not want to save your security settings in a file.

NOTE: Save your device’s security settings file under a descriptive name in a secure
location, along with your device’s user and user password information. Your device’s
security settings file can be used to configure additional devices with the same settings,
and can also assist with device troubleshooting or password recovery.
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Factory access
Factory access is restricted to Schneider Electric Technical Support, and should only 
be enabled when requested by Schneider Electric authorized personnel.

The factory access security feature interacts with standard and advanced security to 
enable factory-level access to the device for the specific period of time entered in the 
Factory Access Minutes setup register, located in the Security Options module. The 
Factory Access Minutes register value can range from one minute to 19 years. Setting 
it to 0 (zero) disables all factory access.

If the device uses standard security, when you press any of the device’s front panel 
buttons, power cycle the device, or edit the Factory Access Minutes setup register, 
factory-level access is enabled on the device for the duration specified in the Factory 
Access Minutes setup register. If the device has advanced security enabled, the 
Factory user must also be enabled. The device will only permit factory-level access, 
with the correct login credentials, for the period specified in the Factory Access Minutes 
setup register.

Configuring the factory access minutes setup register

You must use ION Setup in advanced mode to configure the Factory Access Minutes 
setup register, located in the Security Options module. In order to change security 
settings, you must be logged into ION Setup with a Supervisor level user account with 
permissions to change these settings.

1. Connect to your device in advanced mode in ION Setup. See the ION Setup Help 
for more information.

2. Navigate to the Security Options Modules folder and double-click on the module in 
the right-hand pane.

3. Select the Setup Registers tab.

4. Select Factory Access Minutes and click Edit. A dialog box appears.

5. Enter the desired duration (in minutes) for factory access to be enabled. Select 
Elapsed Interval Format from the dropdown list to enter day, hour and minute 
values. 

You can also use the Designer component of Power Monitoring Expert to configure the 
register. See the Power Monitoring Expert Help for more information.

Factory access and standard security

If a user tries to login to factory-level access (using Telnet or Hyperterminal) on a device 
with standard security, both of the following conditions must be met before the device 
can proceed with subsequent checks:

1. Factory Access Minutes setup register is not 0 (zero).

2. The user and password information for factory-level access has been entered 
correctly.
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If both conditions are met, the device checks the following to determine if access will be 
granted:

• Front panel button: if the time since one of the device’s front panel buttons was 
pushed is less than the Factory Access Minutes register value, the user is given 
access.

• Power cycle: if the time since the device was powered up is less than the Factory 
Access Minutes register value, the user is given access.

• Factory Access Minutes edit: if the time since the Factory Access Minutes register 
value was edited is less than the Factory Access Minutes value, the user is given 
access.

If any one of these conditions are met, the user is given access. If none of these 
conditions are met, the user is not given factory-level access on a device with standard 
security even if they entered appropriate user and password information.

Factory access and advanced security

If a user tries to login to factory-level access (using Telnet or Hyperterminal) on a device 
with advanced security, all three of the following conditions must be met before the 
device can proceed with subsequent checks:

1. Factory Access Minutes setup register is not 0 (zero).

2. The user and password information for factory-level access has been entered 
correctly.

3. The Factory user has been enabled. See “Configure users” on page 70 for 
instructions.

NOTE: The Factory user can be enabled and disabled on the user configuration screen
of the ION Setup advanced security wizard. 

If all three of these conditions are met, the device checks the following to determine if 
access will be granted:

• Front panel button: if the time since one of the device’s front panel buttons was 
pushed is less than the Factory Access Minutes register value, the user is given 
access.

• Power cycle: if the time since the device was powered up is less than the Factory 
Access Minutes register value, the user is given access.

• Factory Access Minutes edit: if the time since the Factory Access Minutes register 
value was edited is less than the Factory Access Minutes value, the user is given 
access.

If any one of these conditions are met, the user is given access. If none of these 
conditions are met, the user is not given factory-level access on a device with advanced 
security even if they entered appropriate user and password information.
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Factory access examples

Scenario 1
This example illustrates how factory access functions on a device using standard 
security, with a Factory Access Minutes setup register value of 10, over a protocol that 
is not session-based.

NOTE: A protocol that is not session-based actively communicates login credentials
while you are connected to the device (for example, ION and HTTP). 

1. The user pushes a front panel button on the device (T=0). This starts the factory 
access duration of ten minutes.

2. Two minutes after the button press (T=2), Schneider Electric Technical Support 
requests factory-level access to the device, with the correct login credentials, over 
HTTP. Factory-level access is granted.

3. Ten minutes after the button press (T=10), factory-level access expires, and the user 
is automatically logged out. 

Any attempt to connect to the device using factory-level access is now denied.

NOTE: With protocols that are not session-based (for example, ION and HTTP), the
access expires when the time since the factory access was activated equals the
duration specified in the Factory Access Minutes setup register.

Scenario 2
This example illustrates how factory access functions on a device using advanced 
security, with a Factory Access Minutes setup register value of 5, over a serial port (a 
session-based protocol).

1. The user connects to the device using ION Setup with Supervisor-level access. 

– In the advanced security wizard, he enables the Factory user.

– In the Communications tab, he sets the protocol of the appropriate serial port to 
Factory.

2. The user power cycles the device (T=0). This starts the factory access duration of 
five minutes.

3. Two minutes after the power cycle (T=2), Schneider Electric Technical Support 
requests factory-level access to the device, with the correct login credentials, over 
the serial port. Factory-level access is granted.

4. An hour after the power cycle (T=60), Schneider Electric Technical Support logs off 
factory-level access.

NOTE: With protocols that are session-based, once factory-level access has been
granted, it does not matter if the logged-in time exceeds the value of the Factory Access
Minutes setup register.

The factory-level access period has expired, and must be restarted by pushing one 
of the device’s front panel buttons, power cycling the device, or modifying the Factory 
Access Minutes setup register.

5. The user connects to the device using ION Setup with Supervisor-level access. 

– In the advanced security wizard, he disables the Factory user.
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– In the Communications tab, he changes the serial port protocol from Factory back 
to its original setting.

Scenario 3
This example illustrates how remote factory access functions on a device using 
advanced security, over a protocol that is not session-based.

NOTE: A protocol that is not session-based actively communicates login credentials
while you are connected to the device (for example, ION and HTTP). 

1. The customer contacts Schneider Electric Technical Support to request that they 
connect to a device using factory-level access using the following information:

– the username and password of an advanced security user that has device 
security configuration access, and the front panel password of the device.

– the device’s Ethernet connection information.

2. Technical Support connects to the device using ION Setup, entering the advanced 
security username and password provided.

– In the advanced security wizard, he enables the Factory user.

– Using the advanced mode of ION Setup, he changes the Factory Access 
Minutes setup register from 0 (default) to 30 (T=0).

3. Two minutes after editing the Factory Access Minutes setup register (T=2), 
Schneider Electric Technical Support requests factory-level access to the device, 
with the correct login credentials, over HTTP. Factory-level access is granted.

4. Twenty minutes after editing the Factory Access Minutes setup register (T=20), 
Schneider Electric Technical Support finishes working on the device and logs off 
factory-level access. 

5. Technical Support connects to the device using ION Setup, entering the advanced 
security username and password provided.

– In the advanced security wizard, he disables the Factory user.

– Using the advanced mode of ION Setup, he changes the Factory Access 
Minutes setup register back to 0 (zero).

Schneider Electric Technical Support contacts the customer to indicate they are 
finished working on the device and have restored the security settings, and 
recommends that the customer update their advanced user password information and 
store their password information and device security configuration file in a secure 
location.
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Additional revenue metering security
To meet government regulations and utility security requirements, the ION8650 
revenue meter incorporates additional security elements:

• a hardware-locked security system that prevents modification of revenue quantities 
after the meter is sealed.

• traditional anti-tamper mechanical seals on the meter base unit and reset switch.

Hardware-lock security option

The hardware-locked security feature is an ordering option for some meters that locks 
the ION module parameters specific to revenue data so that these parameters cannot 
be altered. This hardware lock is set at the factory. To make configuration changes to 
billing parameters on a hardware-locked meter, you must first place the meter into 
TEST mode. The TEST mode button is located under the anti-tamper sealed outer 
cover, and the cover must be removed to access the TEST mode button. You cannot 
switch a hardware-locked meter to test mode from software.

The hardware-lock option, when combined with advanced security and physical anti-
tamper sealing, offers the highest level of security. Hardware-locked meters operate as 
follows:

• With the meter in Normal mode, and with standard or advanced security applied, 
ION modules that generate revenue data are locked and cannot be altered. Users 
can modify unlocked ION modules depending on their level of password-protected 
access through software or the front panel.

• With the meter in TEST mode (which requires removing the cover and breaking any 
anti-tamper seals), users can modify ION modules depending on their level of 
password-protected access through Power Monitoring Expert, ION Setup or the 
front panel.

Typical values that are hardware locked include:

• kWh, kVARh, kVAh delivered, received, del-rec, del+rec.

• kW, kVAR, kVA Sliding Window demand min and max values.

• Digital Outputs controlling the energy pulsing applications.

• All Power system settings, including PT and CT ratios.

Press this button to 
enter TEST Mode
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Locked module listings
For a complete list of locked modules specific to your meter and its firmware, see the 
ION Device Template Reference.

Anti-tamper sealing methods

The following sections describe the anti-tamper sealing methods used by the ION8650 
revenue meter option.

Demand reset switch seal

The demand reset switch located on the front panel can be sealed by a wire seal or lock 
inserted through the side of the switch. This seal does not have to be broken to remove 
the meter's cover.

Socket seals

A standard ANSI C12.7 type socket-sealing ring can be used to hold the socket meter 
to the socket. When removing the outer cover, the sealing ring must first be removed. 
Some socket sealing rings facilitate wire seals.

Outer cover/case seals

For socket models, the outer cover of the meter is factory sealed to its backplate with a 
T-type seal. Depending on the installation, this seal may be inaccessible after the meter 
is installed until you remove the device from the socket.

For switchboard models, the outer case can be sealed by a wire seal or lock inserted 
through the sealing point.

In certain countries the meter is no longer revenue certified if the anti-tamper seals are 
broken.

NOTICE
LOSS OF COMPLIANCE
Ensure that you re-certify your meter with the appropriate revenue metering 
authorities if you remove the anti-tamper seals.

Failure to follow these instructions may render your device non-compliant 
for billing purposes.

Demand reset 
switch seal

Socket 
sealing ring

Outer cover

Outer cover 
T-type seal

Socket

Outer case 
sealing point
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Scaled operational values
The scaled operational values (SOV) feature is intended for hardware-locked meters 
where the Power Meter module’s PT and CT ratios are 1:1.

The SOV feature allows you to enter alternate PT and CT values through the Vista 
component of Power Monitoring Expert, in order to obtain scaled non-revenue data for 
analysis. The alternate scaling registers are stored in the Factory module and have a 
default value of 1.

The Power Meter module’s PT and CT primary and secondary values are compared 
against the Factory module’s alternate values by a series of Arithmetic modules. The 
Arithmetic modules determine if the SOV feature is enabled (the Power Meter module’s 
scaling ratios are all 1:1). 

• If the SOV feature is disabled, the Arithmetic modules output the Power Meter 
module’s PT, CT, and kVA ratios.

• If the SOV feature is enabled, the Arithmetic modules output the alternate PT, CT, 
and kVA ratios. These ratios are applied to the outputs of the MU (Metering Units) 
Power Meter module to generate scaled operational values. The scaled operational 
values can be viewed and analyzed using the Vista and Web Reporter components 
of Power Monitoring Expert.

NOTE: Scaled operational data can only be accessed through Power Monitoring
Expert.

The following diagram shows how scaled operational values are generated.

1. Alternate PT and CT primary and secondary values are loaded into the first series 
of Arithmetic modules. 
Example: Alternate PT Primary = 240, Alternate PT Secondary = 120

2. Power Meter PT and CT primary and secondary values are loaded into the first 
series of Arithmetic modules. 
Example: PT Primary = 120, PT Secondary = 120

NOTE: All the Power Meter module’s ratios must equal 1:1 to enable the SOV feature.

3. Because the Power Meter module’s ratios are 1:1, the alternate scaling registers 
are used to generate the PT, CT, and kVA ratios, which are loaded into the second 
series of Arithmetic modules. 
Example: PT ratio = 2:1

Factory Module

Power Meter 
Module

Alt PT Primary
 = 240
Alt PT Secondary
 = 120

Alt PT Primary
 = 120
Alt PT Secondary
 = 120

Arithmetic 
Module
Source

PT Ratio = 2:1

MU Power 
Meter Module

Vln a = 30 V

Arithmetic 
Module

Two Arithmetic modules are 
used: SetRatios1 and SetRatios2

Source
Vln a = 60 V

Four Arithmetic modules are used: 
ScaledOpVals1 thru ScaledOpVals4

Power Monitoring Expert Server

Alt PT Prim

Alt PT Sec

Alt CT Prim

Alt CT Sec

PT Prim

PT Sec

CT Prim

CT Sec

SOV On

PT Ratio

CT Ratio

kVA Ratio
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4. MU Power Meter module per phase voltage, current and energy values, and total/
average voltage, current and energy values are loaded into the second series of 
Arithmetic modules. 
Example: VLN a = 30 V 

5. The second series of Arithmetic modules apply the PT, CT, and kVA ratios to the MU 
Power Meter values to output operational scaled values to your Power Monitoring 
Expert database. 
Example: VLN a = 60 V

The following 1-second data values are scaled by the SOV feature: 

The following are derived from scaled operational data values:

• Maximum/minimum,

• Historic high/low/mean, and

• Waveforms.

NOTE: The Sag/Swell and Transient modules are not affected by the SOV feature. The
nominal voltage register in the Sag/Swell module must be set to the unscaled voltage
value.

The Harmonics Measurement module outputs are only scaled by the SOV feature when 
the Display Mode register is set to Engineering units. No other harmonics modules are 
affected.

Because total harmonic distortion (THD), total even harmonic distortion (TEHD) and 
total odd harmonic distortion (TOHD) are expressed as percentages, these values are 
not affected by the SOV feature.

Configuring scaled operational values

You can configure the alternate PT and CT values in the Vista component of Power 
Monitoring Expert. 

1. Open your meter in Vista. 

2. Select the Power Quality tab and click the Setup icon to open the Power Quality 
Setup screen.

The Power Quality Setup screen contains fields where you can enter the alternate 
scaling register values, along with an indicator showing whether the SOV feature is 
enabled or disabled.

NOTE: The alternate scaling registers are set to 1 by default.

3. Enter the alternate PT and CT values to provide the desired scaling. 

When the SOV feature is enabled and the alternate PT and CT values are configured 
(no longer equal to 1), the Vista screens indicate if the data values displayed are scaled 
operational values or not.

Vln a Vln b Vln c Vln avg Vll ab
Vll bc Vll ca Vll avg I a I b
I c I avg kW a kW b kW c
kW total kVAR a kVAR b kVAR c kVAR total
kVA a kVA b kVA c kVA total
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Chapter 7 Communications
This chapter includes general instructions for connecting and configuring all the 
communication ports on your meter. 

For specific installation steps and meter specifications, consult your ION8650 
Installation Guide.

NOTE: If you cannot communicate as expected with an ION8650C, ensure that you
have enabled the communications port that you are using and that you have power
cycled the meter. See “ION8650C communications options” on page 84 for more
information.

In this chapter
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Communications overview
The following illustration shows the connections to the communications card.

Communications options

ION8650 meters have numerous communication possibilities depending on your 
ordering options and, in the case of the ION8650C, the enabled communications ports. 

+–
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servicing to qualified
service personnel.

I32 I22 I12

I31 I21 I11 V2

V1V3

Vr ef

9 7 5 3 1

10 8 6 4 2

MODEM

COM 2 or 4

COM 1

R S -485

C4

SWITCHBOARD BREAKOUT PANEL
DIGI TA L O UT DIGIT AL IN

IRIG-B
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DO NOT TIN WIRE LEADS
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Serial COMs and 
Expanded I/O: Molex 
Micro-Fit 24 pin male 
connector. See 
“Communications 
options” on page 82.

Optional I/O Expander for serial 
communications (and expanded I/O). 
Ordered and shipped separately. For 
more information, see the 
I/O Expander documentation. 
Serial COMs 
COM1: RS-232 or RS-485
COM4: RS-485

Optional communications 
breakout cable for serial 
communications. Ordered 
separately.
COM1: RS-232 or RS-485.
COM4: RS-485. 
See “Communications 
breakout cable” on 
page 89. 

ANSI Type II 
Magnetic Optical 
Communications 
Coupler on COM3. 
This port is located 
on the front panel. 
See “Configuring the 
optical port” on 
page 91.

Communications 
wiring on switchboard

Back view of 
the meter

Communications wiring 
on breakout panel

Ethernet 10/
100Base-T: RJ45
 connector. See 
“Configuring 
Ethernet 
connections” on 
page 93.

Cell modem 
option: SMA 
connector. See 
“Internal cell 
modem” on 
page 104.

Modem on 
COM2: RJ11 
male connector. 
See “Internal 
modem 
connections” on 
page 99.

 IRIG-B GPS Time 
Synchronization.
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Not all models have exactly the same communications options available. Contact your 
Schneider Electric sales representative for the latest ordering options and 
documentation. You can use all communications ports simultaneously on the 
ION8650A and ION8650B; you can use the front optical port plus two other ordered 
communications ports simultaneously on the ION8650C.

Socket and switchboard meters communication options

Optional switchboard breakout panel communication options
See the ION8650 switchboard installation guide for wiring instructions.

NOTE: The communications ports on an I/O Expander are not enabled when
connected to a breakout panel. Use the RS-485 and RS-232 connectors provided on
the breakout panel.

Communications accessories
The following accessories are currently available as separate products:

I/O Expander

The I/O Expander connects with the male Molex connector on the meter to provide I/O 
capabilities as well as access to standard serial communications ports. Refer to the I/O 
Expander Installation Guide for details about this device.

Communications breakout cable

The communications breakout cable connects with the male Molex connector on the 
meter. This is a pre-made cable that provides access to the standard serial 
communications ports on the meter. Cable length is 5 feet (152 cm).

Molex extension cables

Molex extension cables can be ordered in both 5 and 15 feet (1.5 or 4.5 meter) lengths.

Port Available options Notes
COM1 RS-232 / RS-485 User selectable RS-232 or RS-485

COM2 Internal Modem RJ11 Maximum 57.6 kbps baud rate modem RJ11 
connection

COM3 Optical Port ANSI Type II optical port located at front of meter
COM4 RS-485 —
Cell Modem Internal cell modem available on socket meter only
Network Ethernet RJ45 (10/100Base-T) —
IRIG-B Captured wire connector Format is unmodulated IRIG-B time code

Connector type
A Ethernet (option)
B Modem (option)
C I/O Expander (option)
D COM1 RS-232
E Chassis ground
F Digital inputs
G IRIG-B
H Digital outputs

I COM1 RS-485 & COM2 
or COM4 RS-485

J Auxiliary power supply 
(option)

B

F

C
H

G

E

D

I

A

J
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Optical probe

The optical probe attaches to the optical port on the front of the meter and allows on-
site communications (for example, with a laptop computer).

ION8650C communications options

The ION8650C supports concurrent communications on the optical port (COM3) and a 
maximum of two other communications ports for a total of three simultaneous 
communications connections. If your ION8650C has three communications ports 
enabled, you must disable one of the active communications ports before you can 
enable another one in its place. For example, if you have an ION8650C with optional 
Ethernet enabled, you must disable the Ethernet port in order to communicate over both 
serial ports (COM1 and COM4).

The default settings vary depending on your order option. See your meter’s Installation 
guide for details.

NOTE: Switching the active communications ports requires a meter reboot before the
changes can take effect.

Enabling and disabling ION8650C communications ports using the front panel

1. Press the ALT/ENTER button to enter the SETUP menu.

2. Use the arrow buttons to scroll down the menu and select ENABLED COM PORTS, 
then press ALT/ENTER. Select CONTINUE and press ALT/ENTER when 
prompted.

3. Select the active communications port you want to disable (for example, Ethernet) 
and press ALT/ENTER. Select DISABLED and press ALT/ENTER. If prompted, 
enter the meter password to confirm the change.

4. Select the communications port you want to enable (for example, COM1) and press 
ALT/ENTER. Select ENABLED and press ALT/ENTER. Confirm the change if 
prompted.

5. Select REBOOT and press ALT/ENTER. Enter the meter password and confirm 
the change if prompted. This power cycles the meter and applies the change.

NOTE: Select UNDO & RETURN to exit the ENABLED COM PORTS setup menu
without making any changes. Your meter will not reboot.

Enabling and disabling ION8650C communications ports using ION Setup

NOTE: You must manually power cycle the meter to have the changes take effect.

WARNING
HAZARD OF UNINTENDED OPERATION
• Do not use the meter for critical control or protection applications where human 

or equipment safety relies on the operation of the control circuit.
• Be aware that an unexpected change of state of the digital outputs may result 

when the supply power to the meter is interrupted or after a meter firmware or 
template upgrade.

Failure to follow these instructions can result in death, serious injury or 
equipment damage.
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1. Select Communications > Enable/Disable and click the Enabled Ports tab.

2. Select an available port to enable or disable.

You can only enable or disable communications ports that were ordered with the 
meter. Ports that were not ordered appear in the list as Not Installed (in the graphic 
above, COM2 was not ordered). 

Click Edit. Enter the meter password, if prompted. The Set Enabled Ports dialog 
box appears.

3. Select a checkbox to enable a listed port or clear a checkbox to disable a listed port. 
You can enable a maximum of two of the ports listed in the dialog box. 

4. Click OK to return to the Setup Assistant. Changes will take effect the next time the 
meter is power cycled, either manually or in a power outage.

WARNING
HAZARD OF UNINTENDED OPERATION
• Do not use the meter for critical control or protection applications where human 

or equipment safety relies on the operation of the control circuit.
• Be aware that an unexpected change of state of the digital outputs may result 

when the supply power to the meter is interrupted or after a meter firmware or 
template upgrade.

Failure to follow these instructions can result in death, serious injury or 
equipment damage.
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Serial connections
The ION8650 provides RS-232 and RS-485 serial communications connections, 
located on the back of the meter, as well as an optical port, located on the front of the 
meter.

Refer to the ION8650 Installation Guide for information on determining the serial port 
options available on your meter.

If the meter’s COM1 port is set to RS-232, you can connect this port to a remote 
modem, which in turn is connected to a computer. You must use a null-modem RS-232 
cable to connect the meter to an external modem. One end of the cable must be 
equipped with a Micro-Fit 3.0 Molex female connector for mating with the Molex male 
connector on the meter. 

You can connect numerous meters’ COM1 ports by selecting RS-485 and using an RS-
232 to RS-485 converter to create a serial network.

NOTE: You cannot use both RS-232 and RS-485 ports on the meter’s COM1
simultaneously.

You can configure your local and remote modems with Power Monitoring Expert or 
ION Setup. You can also use ION Setup or Power Monitoring Expert to schedule 
regular connection times to collect meter data.

Extension cables with Molex connectors are available for your meter. Pin assignments 
for the Molex connector are provided in the ION8650 Installation Guide that ships with 
the meter (also available at www.schneider-electric.com).

NOTE: The total number of possible serial connections is limited by the number of
physical serial ports on the meter. The meter has two physical serial ports (not counting
the front optical port). 

RS-232 connections

Refer to the ION8650 Installation Guide for the meter’s RS-232 specifications and 
specific wiring instructions. 

Because of the wiring configuration between pins 2 and 3, the meter is considered a 
DTE (Data Terminal Equipment) device in all RS-232 connections. Please see “Meter 
connections to single devices” on page 87.
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Communications settings for the RS-232 port are accessible through the front panel 
SETUP menu, Power Monitoring Expert or ION Setup.

Meter connections to single devices

Meter connections to a serial loop

RS-485 connections

Refer to the ION8650 Installation Guide for RS-485 specifications and wiring 
instructions.

The breakout cable’s twisted pair provide connections for both of the meter’s 
RS-485 serial communications ports. The first set is for COM1 RS-485 connections. 
The second set is for COM4 RS-485 communications.

DB9 null modem 
wiring diagram

DCE 
(computer)

DTE 
(meter)

A DB9 direct connect to computer
B DB9 direct connect to external modem

C Molex direct connect to I/O Expander connected to 
computer

D Molex direct connect to I/O Expander connected to 
external modem

A

B

C

D

A RS-232 
50 feet (15.2 m) maximum

B RS-232 to RS-485 converter
C RS-485 loop

A

B

C
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Up to 32 devices can be connected on a single RS-485 bus. Use a good quality 
shielded twisted pair cable for each RS-485 bus, AWG 22 (0.33 mm2) or larger. The 
overall length of the RS-485 cable connecting all devices cannot exceed 4000 feet 
(1219 m). The RS-485 bus can be configured in straight-line or loop topologies.

Straight-line topology 

Loop topology 

General bus wiring considerations
Devices connected on the bus, including the meter, converter(s) and other 
instrumentation, must be wired as follows: 

• Connect the shield of each segment of the cable to ground at one end only. 

• Isolate cables as much as possible from sources of electrical noise.

• Use an intermediate terminal strip to connect each device to the bus. This allows for 
easy removal of a device for servicing if necessary.

• Install a ¼ Watt termination resistor (Rt) between the (+) and (-) terminals of the 
device at each end point of a straight-line bus. The resistor should match the 
nominal impedance of the RS-485 cable (typically 120 ohms – consult the 
manufacturer’s documentation for the cable’s impedance value).

RS-485 connection methods to avoid
Avoid any device connection that causes a branch in the main RS-485 bus. This 
includes star and tee (T) methods. These wiring methods can cause signal reflections 
that can lead to interference. At any connection point on the RS-485 bus, no more than 
two cables should be connected. This includes connection points on instruments, 
converters, and terminal strips. Following this guideline ensures that both star and tee 
connections are avoided.

Wiring color codes for the Molex cable 
are provided in the ION8650 Installation 
Guide that ships with the meter and is 
available at 
www.schneider-electric.com

RS-232 to 
RS-485 
converter

 Shield

Termination 
resistor

RT

RT

RS-232 to 
RS-485 
converter

 Shield

Termination 
block
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RS-485 biasing
The RS-485 +/- wires are floating (ungrounded) so there can be voltage signals on the 
wires even when there is no device communicating on the bus. The amount of floating 
voltage depends on many factors, such as capacitive effects in the RS-485 bus and 
noise in nearby systems. If the floating voltage is high enough, it can be incorrectly 
interpreted as an RS-485 signal and cause your meter to stop communicating. The 
meter has an RS-485 biasing option to prevent the RS-485 bus from floating when 
devices are not sending data. 

Setting RS-485 biasing using the front panel

1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu 
appears.

2. Use the navigation buttons to highlight the RS-485 COM port that you want to 
configure (COM1 or COM4) and press ALT/ENTER to select.

3. Use the navigation buttons to highlight RS-485 BIAS and press ALT/ENTER to 
select.

4. Select either ON (RS-485 biasing applied) or OFF (RS-485 biasing not applied).

Setting RS-485 biasing using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions 

2. Select Communications > Serial Settings.

3. Click the COM1 or COM4 tab. Select RS485 Bias and click Edit.

4. Select ON to apply RS-485 biasing or OFF to not apply RS-485 biasing.

5. Click OK.

Communications breakout cable
Refer to the ION8650 Installation Guide for the DB9 serial pin assignments for the 
optional breakout cable female DB9 connector. A communications breakout cable 
facilitates communications connections by connecting to the Molex male connector on 
your meter. The cable splits to a standard DB9 female connector and two RS-485 
shielded, twisted pairs.

Avoid 3-way “T” 
connection point

Avoid 3-way “Star” 
connection point
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Configuring RS-485

Using the front panel
1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu 

appears.

2. Use the navigation buttons to highlight the RS-485 COM port that you want to 
configure (COM1 or COM4) and press ALT/ENTER to select.

3. Configure the settings (for example, Protocol, Baud Rate and Unit ID) to match your 
communication system. 

Disabling the COM port using the front panel

You have the option of disabling the COM port through the front panel when the port is 
not being used. 

1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu 
appears.

2. Use the navigation buttons to highlight the RS-485 COM port that you want to 
configure (COM1 or COM4) and press ALT/ENTER to select.

3. Use the navigation buttons to highlight the Protocol setting and press ALT/ENTER 
to select.

4. Select None from the list of available protocols. 

5. Select YES to confirm the change.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Serial Settings.

3. Click the COM1 or COM4 tab and configure the settings (for example, Protocol, Baud 
Rate, and Unit ID) to match your communications system.

Molex male from 
the meter

Two RS-485 
twisted pairs

RS-485 shield

DB9 female 
connector
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Disabling the COM port using ION Setup

You have the option of disabling the COM port through ION Setup when the port is not 
being used.

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Serial Settings.

3. Click the COM1 or COM4 tab, select Protocol from the list and click Edit.

4. Select None from the dropdown list and click OK.

Configuring the optical port

Refer to the ION8650 Installation Guide for optical port specifications. 

The optical port available on ION8650 meters is compatible with standard magnetic 
optical communications couplers, or optical probes (ANSI Type II). Optical probes are 
available both from Schneider Electric and other suppliers as a separate product; 
contact Schneider Electric for a list of suppliers. The original equipment manufacturer’s 
warranty applies. See the Optical Magnetic Couplers technical note for more detailed 
information. 

Optical probes can communicate real-time measurements via the ION, RTU, DLMS, 
DNP 3.0, Factory, or GPS protocols. You can configure the optical port communications 
settings with the front panel, Power Monitoring Expert or ION Setup.

Using the front panel
1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu 

appears.

2. Use the up or down arrow buttons to select COM3 SETUP.

3. Press the ALT/ENTER button to access COM3 SETUP parameters.

4. Configure the settings (for example, Baud Rate, Unit ID, and Protocol) to match your 
communications system.

Disabling the COM port using the front panel

You have the option of disabling the COM port through the front panel when the port is 
not being used.

1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu 
appears.

2. Use the navigation buttons to highlight the optic port (COM3) and press ALT/
ENTER to select.

3. Use the navigation buttons to highlight the Protocol setting and press ALT/ENTER 
to select.

4. Select None from the list of available protocols. 

5. Select YES to confirm the change.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Serial Settings.
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3. Click the COM3 tab and configure the settings (for example, Baud Rate, Unit ID, 
and Protocol) to match your communications system.
To enable communications from the optical port, you must configure the COM3 
communications. The Protocol, Baud Rate and Unit ID settings must properly match 
your system. When creating a site, ensure RTS Control setting is disabled for the 
COM3 serial site.

Disabling the COM port using ION Setup

You have the option of disabling the COM port through ION Setup when the port is not 
being used.

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Serial Settings.

3. Click the COM3 tab, select Protocol from the list and click Edit.

4. Select None from the dropdown list and click OK. 

Using Power Monitoring Expert
1. Open Management Console and add a Direct Site.

2. Set the Serial Port to COM3 and ensure that the settings properly match your system. 
Ensure that RtsCts is disabled for the optical port site in Management Console. Refer 
to the Management Console section of the online Power Monitoring Expert help for 
details.
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Configuring Ethernet connections
This section only applies if your meter has the Ethernet option. Refer to the ION8650 
Installation Guide for Ethernet port specifications and information on determining the 
options available on your meter.

Ethernet connections are made via the RJ45 modular jack on the rear of the unit. Use 
high quality Category 3, 4 or 5 UTP cable (RJ45 female to RJ45 male) if you require an 
extension. The optional Ethernet port is capable of data rates up to 10 Mbps and 
supports TCP/IP, FTP, ION, Telnet, and Modbus/TCP protocols. The meter supports a 
maximum of eight simultaneous Ethernet connections with additional dedicated 
connections for Modbus master over TCP/IP and IEC 61850.

NOTE: Some features, such as IEC 61850, COMTRADE and Ethernet outage
notification, require that your meter has an Ethernet connection.

You can configure Ethernet communications using the front panel, Power Monitoring 
Expert or ION Setup. In each case, you must configure the IP Address, Subnet Mask, 
Gateway, SMTP Server and SMTP Connection Timeout to properly match your system. 
You must also ensure that the network ports are either enabled or disabled, depending 
on your system configuration.

NOTE: The MAC address of your meter cannot be changed, and is provided for
information only.

Using the front panel
1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu 

appears.

2. Use the up or down arrow buttons to select NETWORK SETUP and press ALT/
ENTER.

Ethernet

TCP/IP Modbus master dedicated 
TCP connection. Connect with up to 
10 Modbus slave IP addresses. 
Refer to “Third party protocols” on 
page 109 for Modbus information.

8 simultaneous connections. 
Protocols include ION, DNP and 
Modbus/TCP.

IEC 61850 dedicated connection for 
up to 5 IEC 61850 clients.

1 FTP connection.

SMTP server (email), 
outgoing only.
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3. Configure the Ethernet Communications settings (for example, IP Address, Mask, 
Gateway, SMTP Address and Port Enable) to match your communications system. 

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Basic Ethernet and click the IPv4 and TCP/IP tabs.

3. Select a setting and then click Edit. Configure the settings as required. 

4. Select Communications > Advanced Ethernet and click the DNS and SMTP 
tabs.

5. Select a setting and then click Edit. Configure the settings as required 

Using Power Monitoring Expert
After you wire your meter to the Ethernet network and perform basic setup, add the 
meter to your Power Monitoring Expert network using Management Console.

To enable communications through the Ethernet port, you must configure the Ethernet 
Communications module. Start Designer and configure the IP Address, Subnet Mask, 
Gateway, SMTP Server and SMTP Connection Timeout registers to match your 
system. 

Parameter Values Description

IPv4 Address
Contact your local 
network administrator 
for parameter values.

Specifies TCP/IP Ethernet address.

Subnet Mask
Contact your local 
network administrator 
for parameter values.

The subnet IP address of your network.

Default Gateway
Contact your local 
network administrator 
for parameter values.

The gateway IP address of your network.

Rx Timeout
Contact your local 
network administrator 
for parameter values.

Specifies the number of seconds the meter 
will wait for communication 
acknowledgements.

Modbus Gateway 7801, 7802, 502 Specifies the port on which the Modbus 
Gateway will send and receive requests.

MAC Address Read-only
Your meter’s media access control (MAC)
address.

Parameter Values Description

Primary DNS
Contact your local 
network administrator 
for parameter values.

The IP address of your network’s primary 
DNS server, if your network uses DNS.

Secondary DNS
Contact your local 
network administrator 
for parameter values.

The IP address of your network’s primary 
DNS server, if your network uses DNS.

SMTP Server
Contact your local 
network administrator 
for parameter values.

The IP address of your SMTP server.

SMTP Connection 
Timeout

Contact your local 
network administrator 
for parameter values.

Specifies the number of seconds the meter 
will wait for communication from the SMTP 
server.



7EN02-0306-03 95

ION8650 User Manual Chapter 7 - Communications 

Adding an Ethernet device to your Power Monitoring Expert network

In Management Console, the Ethernet Device Options screen appears when you add 
an Ethernet device (meter). Use this screen to describe your meter’s Ethernet address 
and other communications information. Be sure to include:

• the server computer that communicates with the Ethernet device.

• the Ethernet device TCP/IP address.

Domain name resolution (DNS)

You can configure the meter as a DNS client in systems using a DNS server.

A DNS server maps domain names to IP addresses. If you configure the meter to use 
a DNS server, the meter can communicate with other network resources using their 
domain names, rather than their IP addresses, and vice versa. For example, if your 
network has an SMTP server with the domain name of smtp.company.com, you can 
enter smtp.company.com as the SMTP Server address in the meter’s communications 
settings.

Configuring EtherGate connections

The meter can function as an Ethernet gateway (EtherGate). EtherGate is a powerful 
communications tool that lets you communicate through a gateway meter to a serial 
network connected to the meter. When a meter installed on the Ethernet network has 
EtherGate enabled, a master device (such as a workstation running Power Monitoring 
Expert) can communicate through the gateway meter to a serial network of devices 
wired to the gateway meter’s COM port. The transfer of data between protocols is 
handled automatically. EtherGate is available on serial ports COM1 and COM4 in place 
of the ION, Modbus Master, Modbus RTU, or DNP 3.00 protocols. With EtherGate 
enabled, the meter permits the direct transfer of data from up to 62 devices (31 devices 
per COM port). 

Install the serial devices, configure them and connect them to your Ethernet-connected 
gateway meter. Ensure that each serial device is configured with the same baud rate 
and has a unique Unit ID. Then use the meter’s front panel, Power Monitoring Expert 
or ION Setup to change the COM1 or COM4 Protocol setting to EtherGate. You must 
then create an EtherGate site in Power Monitoring Expert or ION Setup, and add the 
serial devices to the EtherGate site. See The ION meter as an Ethernet gateway 
technical note for more information on setting up an Ethernet gateway.

A Gateway meter
B Ethernet
C Serial devices connected to the gateway meter

A
B

C
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Using the front panel to set the EtherGate protocol
1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu 

appears.

2. Use the up or down arrow buttons to select the COM port that you want to configure 
(COM1 or COM4) and press ALT/ENTER.

3. Scroll to PROTOCOL and press ALT/ENTER. Change the port’s PROTOCOL 
setting to ETHERGATE. 

4. Press ALT/ENTER to set the protocol.

Using ION Setup to create an EtherGate site
Follow the instructions below to communicate to the devices on the RS-485 loop with 
ION Setup.

In ION Setup:

1. Right-click on your workstation icon and select Insert Item. The New Network 
Item dialog box appears.

2. Select Site and click OK. The New Site dialog box appears.

3. Click the General tab.

4. Configure the site as follows:

– Type a site name.

– Select Ethernet from the Comm Link options.

– Select the Gateway check box. 

– Type the meter’s IP address and select a port in the Gateway Info fields. For the 
port, select either 7801 for COM1 or 7802 for COM4. 

Click OK.

5. Right-click on your newly created site and select Insert Item. The New Network 
Item dialog box appears. 

6. Select Meter and click OK. The New Device dialog box appears. 

7. Enter serial device information here and click OK. Your new device appears under 
your newly created site

8. Repeat steps 5 to 7 to enter each device on your serial network.

NOTE: Use a standard Ethernet connection in ION Setup to connect to and read data
from your EtherGate meter.

Using Power Monitoring Expert to create an EtherGate site
Follow the instructions below to communicate to the devices on the RS-485 loop with 
Power Monitoring Expert.

In Management Console:

1. Create an Ethernet gateway site.

2. Configure your Ethernet gateway site with the IP address of the gateway meter. 
Select the IP Port that matches the gateway meter’s COM port that is connected to 
the RS-485 loop (select 7801 for COM1 or 7802 for COM4).
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3. Add each of the devices on the RS-485 loop to the Ethernet Gateway site (you do not 
need to add the gateway meter as a device).

NOTE: Use a standard Ethernet connection in Power Monitoring Expert to connect to
and read data from your EtherGate meter.

Enabling and Disabling Ethernet ports

Through the front panel, you can enable or disable the Ethernet ports on your meter.

Changing Ethernet configuration parameters without another method of configuration 
enabled may cause loss of communications with your device. 

Follow the instructions below to enable and disable the Ethernet ports on your 
meter.Using the front panel

1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu 
appears.

2. Use the up or down arrow buttons to select NETWORK SETUP and press ALT/
ENTER.

3. Scroll to PORT ENABLE and press ALT/ENTER.

4. Select the port you want to change and press ALT/ENTER. Select Yes to enable the 
port and No to disable. 

5. Select YES to confirm the change. Enter the meter password if prompted.

Using ION Setup
See “Ethernet protocol control” on page 106 for instructions regarding enabling and 
disabling Ethernet ports through ION Setup.

Meter FTP server

The meter can function as an FTP server, supporting IEC 61850 protocols, 
COMTRADE formatted waveform files and TLS certificates. The FTP timeout period is 
90 seconds on a control port. Only one simultaneous FTP transfer connection is 
permitted. To connect to your meter, ensure that your FTP software is configured to 
only use a single FTP connection. The recommended FTP software is Windows 
Explorer or WinSCP running on a Windows-based machine.

NOTE: To connect to your meter using Windows Explorer, you must include the login
and password in the FTP connection string. For example, with standard meter security
(no user configured) and the a front panel password of 2, to connect to a meter with an
IP address of 123.45.6.78, the Windows Explorer connection string would be ftp://
0:2@123.45.6.78.

NOTICE
DATA LOSS
Ensure you maintain sufficient access to communicate to and configure your 
device.

Failure to follow these instructions can result in data loss.
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The meter communicates via FTP on the following ports:

File names are limited to ASCII characters that do not contain a blank space or /, \, “, *, 
?, <, >, and have a maximum length of 64 characters.

FTP folder structure
Your meter has the following FTP folder structure:

• CASTORE: you can add and delete TLS certificates in this folder.

• COMTRADE: you can read COMTRADE files from these folders, but you cannot 
delete or add files.

• IEC61850: you can add an IEC 61850 configuration (CID) file to this folder to 
activate the IEC 61850 protocol functions of your meter.

For more information about using FTP for IEC 61850 or COMTRADE, refer to the 
IEC 61850 protocol and ION Technology protocol document or the COMTRADE and 
ION Technology technical note. 

Port Description
21 Incoming commands connections
20 Active data connections
3000-3020 Passive data connections



7EN02-0306-03 99

ION8650 User Manual Chapter 7 - Communications 

Internal modem connections
This section only applies if your meter has the internal 56k modem or cell modem 
option. Refer to the ION8650 Installation Guide for internal modem specifications and 
information on determining the options available on your meter.

NOTE: The internal cellular modem option is only available on the ION8650 socket
meter.

56k universal internal modem

The 56k universal internal modem is accessed through COM2, supports all standard 
modem protocols at transmission rates from 300 bps to 57600 bps (300 bps is only 
recommended for paging applications) and can be shared by up to 31 devices on an 
RS-485 chain. It is available with a standard six-pin RJ-11 phone plug. If you have 
multiple meters linked on an RS-485 loop, only the first meter requires a 56k modem. 
This setup is referred to as a ModemGate (see “Configuring ModemGate connections” 
on page 101).You can configure the settings of the 56k modem with the front panel, 
Power Monitoring Expert or ION Setup.

To enable communications through the meter’s 56k modem, configure the COM2 
communications Baud Rate, Unit ID, Protocol, and ModemInit setup registers as 
required for your system. See “ModemInit setup register” on page 99 for more 
information on this register.

NOTE: When the meter is equipped with the Alert module, the modem can initiate calls.
Paging is supported through numeric paging and the TAP1 protocol. See the Power
Monitoring Expert online help for details on managing modem connections, setting up
periodic dial-out and configuring remote site event notification.

ModemInit setup register
The ModemInit setup register defines the initialization string for the internal modem with 
a maximum of 47 characters. Edit the ModemInit register and enter the desired 
initialization string. The string is sent to the modem as soon as you download the COM2 
module. Note that the string is also sent to the modem whenever the meter is powered 
up or the baud rate in the COM2 Communications module is changed.

NOTE: Changing the ModemInit or Baud Rate setup registers while the internal modem
is online causes the modem to disconnect from the phone line.

Modem initialization strings

Refer to the Modem AT Commands technical note for a complete list of AT commands 
for meter modems.

Telephone network
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NOTE: The Modem AT Commands technical note also contains instructions on how
you can determine your meter’s modem type based on the meter’s serial number.

Adjusting the modem initialization string for CTR-21 compliant modems

The table below shows the strings to add to the end of your modem configuration string 
setup register for each of three possible scenarios.

If your local modem (not the internal modem) is not already set up, configure it with the 
Remote Modem Setup utility in Power Monitoring Expert according to the instructions 
in the online help. After the meter is installed and the internal modem is connected to 
the telephone network, the COM2 module can be configured using the meter’s front 
panel, Power Monitoring Expert or ION Setup. For information on how to connect the 
internal modem to the telephone network, refer to your ION8650 Installation Guide.

Configuring COM2 through the front panel
1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu 

appears.

2. Use the up or down arrow buttons to select COM2 SETUP and press ALT/ENTER.

3. Configure the COM2 settings (for example, Baud Rate, Unit ID, and Protocol) to 
match your communications system.

Disabling the COM2 port using the front panel

You have the option of disabling the COM port through the front panel when the port is 
not being used.

1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu 
appears.

2. Use the navigation buttons to highlight the COM2 port and press ALT/ENTER to 
select.

3. Use the navigation buttons to highlight the Protocol setting and press ALT/ENTER 
to select.

4. Select None from the list of available protocols. 

5. Select Yes to confirm the change.

Configuring the meter and modem site using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Serial Settings and click the COM2 tab.

3. Select the setting that you want to configure and click Edit.

4. Configure the COM2 settings (for example, Baud Rate, Unit ID, and Protocol) to 
match your communications system.

Behavior Add to modem initialization string
Does not answer
(modem does not detect ring tone) *NC70

Does not dial
(modem does not detect dial tone)

 In order of preference:
*NC70, *NC70X0, *NC8 (Italy only)

Does not detect busy signal *NC70
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Disabling the COM2 port using ION Setup

You have the option of disabling the COM port through ION Setup when the port is not 
being used.

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Serial Settings.

3. Click the COM2 tab, select Protocol from the list and click Edit.

4. Select None from the dropdown list and click OK. 

Configuring the COM2 module using Designer
Before you can configure the COM2 module in Designer, you must add the meter (with 
the internal modem) and a modem site to your Power Monitoring Expert network. 

Adding a meter and a modem site to your Power Monitoring Expert network

In Management Console, add the meter with the internal modem and a modem site to 
your Power Monitoring Expert network. Describe how your remote modem is wired and 
other communications information on the options screens.

Either before or after adding the modem site, you must add a dialout modem to the 
server computer. The server computer dialout modem communicates to the modem at 
the modem site.

On the Modem Site Options screen, ensure that:

• you select the server computer that you want to communicate with the remote 
modem and that the server computer dialout modem is configured.

• you enter the remote modem telephone number.

• you set the baud rate of the modem site to the baud rate of the COM2 port to avoid 
communications errors.

See the Power Monitoring Expert online help for more information.

Configuring the COM2 Communications module in Designer

Start Designer and configure the COM2 Communications module Baud Rate, Unit ID, 
and Protocol setup registers to match your communications system. Configure the 
initialization string for the internal modem using the ModemInit register. Refer to 
“ModemInit setup register” on page 99.

Configuring ModemGate connections
ModemGate is a powerful feature that creates a communications connection between 
the telephone network and an RS-485 serial network of devices. When you specify the 
protocol for a meter’s COM port as MODEMGATE, all data received by the meter’s 
internal modem is automatically transferred to the serial network. ModemGate is 
available on either the COM1 or COM4 port; you cannot use the feature on both ports 
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simultaneously. The meter must have the COM2 modem option to function as a modem 
gateway.

NOTE: The baud rate used between connected modems is independent of the internal
baud rate used for communication between the meter and its modem.

Wire a serial connection between one or more meters and the meter COM port hosting 
the ModemGate (COM1 or COM4). You can make ModemGate connections through 
an RS-232 cable to a single device or through an RS-485 shielded twisted pair cable to 
multiple devices. ModemGate connections do not connect a workstation running Power 
Monitoring Expert (or other master device) to the gateway meter’s COM1 or COM4 port, 
but rather to the gateway meter’s internal modem port (COM2); the meter then transfers 
the data to the serial devices connected to COM1 or COM4.

Configuring the meter for ModemGate

1. Install the meter and connect the internal modem.

2. Use the front panel, Power Monitoring Expert or ION Setup to set up the internal 
modem and the serial communications port (COM1 or COM4) that is the 
ModemGate. You can enable ModemGate on either COM1 or COM4, not both 
simultaneously.

3. Set the internal modem COM2 Baud Rate, Unit ID and Protocol. The baud rate 
must be the same as the port hosting the gateway and all the devices connected to 
the gateway.

4. Set the protocol of the port connected to the RS-485 loop to MODEMGATE (either 
COM1 or COM4). For each device on the RS-485 loop, you must also:

– Set the baud rate to the same value as the modem baud rate (COM2).

– Configure each device, including the gateway meter, with a unique Unit ID. 

Configuring devices connected to the ModemGate meter

1. Use Power Monitoring Expert, ION Setup or the front panel to change and 
configure settings. Ensure each device connected to the meter has the same baud 
rate as the meter ModemGate port (either COM1 or COM4).

2. Ensure each device connected on the RS-485 network (including the meter 
modem) has a unique Unit ID. Record the serial baud rate of the modem site and 

A Workstation with Power Monitoring Expert 
and modem

B Telephone network

C ModemGate meter equipped with optional 
internal modem

D Devices on RS-485 loop

A

B

C

D
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the Unit IDs for every device in order to add the ModemGate and its meters to your 
network.

NOTE: Ensure RS-485 is selected for connections to multiple devices along the same
bus.

Using ION Setup to create a ModemGate site

1. Right-click on your workstation icon and select Insert Item. The New Network 
Item dialog box appears.

2. Select Site and click OK. The New Site dialog box appears.

3. Click the General tab.

4. Configure the site as follows:

– Type a site name.

– Select Modem from the Comm Link options.

– Click Modem configuration to access the Modem configuration wizard, which 
configures your local and remote modems.

– Enter the phone number of the modem you are connecting to in the Phone 
Number field. 

Click OK.

5. Right-click on your newly created site and select Insert Item. The New Network 
Item dialog box appears. 

6. Select Meter and click OK. The New Device dialog box appears. 

7. Enter serial device information and click OK. Your new device appears under your 
newly created site

8. Repeat steps 5 to 7 to enter each device on your serial network.

Using Power Monitoring Expert to create a ModemGate site

To communicate to the devices on the RS-485 loop using Power Monitoring Expert: 

1. Start Management Console and create a Modem Site.

2. Configure your modem site by typing in the appropriate fields or using the 
dropdown menus. Include the meter’s internal modem telephone number and 
ensure that the server computer’s dialout modem is configured. Refer to the online 
Power Monitoring Expert Help for information on adding a dialout modem.

Adding ModemGate meters to the Power Monitoring Expert network

1. Start Management Console and click Devices. Right-click in the Devices display 
window and select New > Serial Device on Direct Site.

2. Enter the information by typing in the appropriate fields or using the dropdown 
menus, remembering that:

– Unit ID: The value in the UNIT ID field identifies the meter on the RS-485 loop.

– Site: The ModemGate site that you created.



Chapter 7 - Communications  ION8650 User Manual

104 7EN02-0306-03

Internal cell modem

Configuration of the internal cell modem is accessible through the front panel and ION 
Setup. 

Two modems are available: CDMA and LTE. The CDMA modem supports the EV-DO 
Rev. A and CDMA2000 1xRTT standards at transmission rates up to 3.1 Mbps 
downlink/1.8 Mbps uplink. The LTE modem supports Cat 1 LTE standards at 
transmission rates up to 10 Mbps downlink/5 Mbps uplink. Both modems allow for up 
to six simultaneous protocol data connections.

The cell modem requires network activation. For information regarding the network 
activation for your region and modem, refer to the PowerLogic ION8650 cell modem 
product option document.

NOTE: The 56k modem and cell modem exist as separate ordering options. You
cannot have a 56k modem and a cell modem on the same device.
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Syslog
Syslog uses the User Datagram Protocol (UDP) to transport event log information from 
the meter directly to a centralized syslog server. The server can receive logs from many 
devices, then store and filter the logs as needed. You can use ION Setup to modify the 
syslog network settings for your device. Syslog is a useful feature to help maintain 
meter log information for extended periods of time.

NOTE: Ethernet is required to use the Syslog feature.

Configuring Syslog network settings using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Advanced Ethernet and click the SysLog tab.

3. Select Enable Syslog and click Edit. Select Yes to enable the syslog server or 
select No to disable. Click OK.

4. Select Syslog Server and click Edit. Enter the location for the syslog server. This 
value is entered as an IP address in the format aaa.bbb.ccc.ddd. Click OK.

5. Verify that the syslog server is receiving log information from the meter.

NOTE: If the Enable Syslog register is enabled but the Syslog Server register does not
contain an IP address, an event is created in the event log that informs you that syslog
is enabled with no server IP.

Syslog Server

Syslog is an open standard allowing you to use any one of a number of syslog servers 
applications currently available. The decision regarding which syslog server solution to 
use can be based on budget and your technical requirements. See the individual syslog 
server’s documentation for more information.

Event log priority to syslog severity

The table below shows the mapping between ION event priorities (0-255) and the 
Syslog severities. Only four of the syslog severities are used in the mapping.

ION event priority range ION event priority name Syslog severity
0-63 None 6 - Informational
64-127 Low 5 - Normal but significant condition
128-191 Medium 4 - Warning condition
192-255 High 2 - Critical condition
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Ethernet protocol control
The Ethernet protocol control feature allows you to enable, disable, or change the port 
number of the Ethernet protocols supported on your meter.

If you are connected to your device over Ethernet, changing Ethernet configuration 
parameters without another method of configuration enabled may cause loss of 
communications with your device and render it inoperable. In this case a factory 
reconfiguration of your device is required, which resets your device to its factory 
defaults and all logged data is lost..

NOTE: The protocol port number may not be configurable on all protocols.

Using the front panel
You cannot change the Ethernet port number assignments through the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Advanced Ethernet and click the Protocols tab.

3. Select a protocol from the list and click Edit.

4. Select the Enabled checkbox to enable the port.

NOTE: The IEC61850 port is enabled when a valid CID file is uploaded to the meter.
The port is disabled by removing the CID file. 

NOTE: The EtherGate port is enabled if the applicable serial port is set to EtherGate.
If the serial port is set to a different protocol, the EtherGate port is closed.

5. Select a port number from the Port Number dropdown list or by clicking in the Port 
Number field and entering a port number. Existing connections are not affected by 
the change, but any new connections must comply with the meter’s latest settings.

6. Click OK. If multiple ports are set to the same number, ION Setup responds with a 
message indicating that the port is already in use by another protocol.

NOTE: When configuring the FTP ports, the data connection port is automatically
assigned to the command connection port number minus 1. For example, if the
command connection port number is 21, the data connection port number is 20.

Default Ethernet ports

NOTICE
DATA LOSS
Ensure you maintain sufficient access to communicate to and configure your 
device.

Failure to follow these instructions can result in data loss.

Protocol Default port
ION 7700
DNP 200000
DLMS 4059
Modbus TCP 502
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Modbus RTU over Ethernet 7701
EtherGate (COM1) 7801
EtherGate (COM4) 7802
FTP 20 & 21
SMTP 161
NTP 123
IEC 61850 102
Telnet 23
HHTP 80

Protocol Default port
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HTTPS outage alerts
Your meter supports HTTPS for alert messages sent to outage notification servers. 

HTTPS uses Transport Layer Security (TLS) encryption to secure the communications 
channel and protect exchanged data between the client and the server. When 
configured to use HTTPS, the meter uses the self-signed certificate installed on its FTP 
server.
For more information on Ethernet outage notification, see the Outage notifications on 
the PowerLogic ION8650 product option document and the Alert module description in 
the ION Reference.

TLS certificate management

Only Privacy-Enhanced Mail (PEM) files are supported.

The meter supports a maximum of 10 certificates with a maximum total file size of 12 
kB for all certificates.

Managing certificates - using both ION Setup and FTP - requires the FTP protocol on 
the meter be enabled and the FTP server be accessible.

NOTE: The certificates on the meter cannot be read, only added or deleted.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Basic Ethernet and click the Certificates tab.

3. Click Add to add a new certificate to the meter.

4. Select a certificate and click Delete to remove a certificate from the meter.

Using FTP
1. Start your FTP software.

2. Connect to your meter via FTP by entering your meter’s IP address. Depending on 
your FTP software and meter security settings, you may be prompted for login 
credentials.
With standard meter security (no user configured), enter login credentials of 8650 
and the meter password to connect to the meter. For advanced meter security, 
enter a valid user and password.

3. Navigate to the CASTORE folder on your meter.

4. Add and delete certificates as required.

5. Close your FTP software to disconnect from the meter. The FTP connection 
automatically disconnects once the FTP timeout period has elapsed.
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Chapter 8 Third party protocols
This chapter explains how Modbus, DNP 3.0 and IEC 61850 protocols are implemented 
on the meter. 

It also contains brief instructions for configuring your meter to work with MV-90 
systems.

For additional instructions on using the meter with Modbus, DLMS, IRIG-B, IEC 61850 
and MV-90 protocols, see the following documents:

• Modbus protocol and register map for ION devices protocol document

• Modbus and ION Technology technical note

• DLMS/COSEM and ION technology protocol document

• IRIG-B GPS Time Synchronization technical note

• IEC 61850 and ION technology protocol document

• MV90 and ION technology technical note
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Overview
The meter supports DNP 3.0, DLMS, Modbus RTU and Modbus/TCP, and IEC 61850 
protocols.

Most Modbus, IEC 61850 and DNP modules that send meter data using these 
protocols are factory configured and only require basic configuration, such as 
communications setup.

• Your meter is preconfigured to send Modbus data (acting as Modbus slave). It is not 
ready to receive data as a Modbus master until you set up the necessary 
framework. 

• Your meter is preconfigured to send DNP 3.0 data to a DNP master. 

• You must use an IEC 61850 configuration tool and ICD file to configure the 
IEC 61850 aspects of your meter, with the exception of I/O and additional data 
values, which must be done through ION Setup.

NOTE: Changing the default third-party protocol frameworks (or creating new
frameworks to enable receive functionality) is an advanced procedure that requires an
understanding of the protocol and the meter’s internal operation before you proceed.
Refer to the descriptions in the ION Reference of the DNP, IEC 61850 and Modbus
modules. Refer to the Multiport DNP 3.0 and ION Technology, DNP 3.0 Device Profile,
IEC 61850 and ION Technology, and Modbus and ION Technology documents for
information on these protocols.

Communications protocol configuration

In order to use the pre-configured Modbus or DNP slave configuration, you must first 
assign the communications protocol that you want to use to the applicable port. By 
default, all communications ports are configured to use the ION protocol. Select the 
third-party protocol that you want from the list of available protocols for the 
communications port you are configuring. See “Communications” on page 81 for 
instructions. You do not have to assign a communications channel for IEC 61850 but 
your meter must have an Ethernet connection. 

NOTE: Modbus RTU is available on each of the meter’s communications ports, and
multiple ports can communicate using Modbus simultaneously. Modbus TCP is
available on the meter’s optional Ethernet connection. Up to three ports can use the
DNP 3.00 protocol at any one time.
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The meter as Modbus slave
Your meter can act as a Modbus slave, using both the Modbus RTU and 
Modbus/TCP protocols.

The meter can act as a Modbus slave device, making any real-time data available 
through the Modbus protocol. Modbus master devices connected to the meter can read 
this data or write data to your meter’s ION registers (for example, to make configuration 
changes).

NOTE: If you encounter issues reading or writing to the device using Modbus, ensure
that your device’s security settings allow Modbus programming. See “Security” on
page 53 for more information on device security.

Using the Modbus RTU protocol

The factory Modbus slave configuration
The meter makes data available to Modbus master devices using pre-configured 
Modbus Slave modules. These modules are linked to other modules in the meter that 
provide the energy, power and demand data. Once a communications channel is 
configured to use Modbus RTU protocol, the data is available to Modbus master 
devices.

NOTE: Connect to IP port 7701 for Modbus RTU communications over Ethernet. The
Modbus unit ID of the meter over Ethernet has a default value of 100.

As the data available through the Modbus Slave modules is in a specific format, 
knowledge of the Modbus protocol and an understanding of the settings used in the 
meter are required to interpret the data provided. 

Changing the Modbus configuration
If the factory Modbus configuration does not suit your needs, the existing Modbus Slave 
modules can be relinked to other parameters that you want to access through Modbus.

If your Modbus master device requires data in a format different than that provided by 
the factory Modbus configuration, you can edit the setup registers in the Modbus Slave 
modules. These setup registers specify the Modbus format, scaling and base address 
settings. Refer to the ION Reference for complete details on the Modbus Slave module.

Set the COM port to 
the Modbus RTU 
protocol

Communications port

Power Meter 
module

Modbus Slave 
module

Data is available 
to Modbus 
master devices

Modbus Slave 
module outputs data 
in Modbus format

Measured data is 
linked to the Modbus 
module’s input

VIn a 40011
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Configuring the meter as a Modbus slave

You cannot configure Modbus through the meter’s front panel; you can only assign the 
Modbus protocol to communication ports (see “Communications” on page 81 for 
details).

Use Power Monitoring Expert or ION Setup to perform full Modbus configuration.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > 3rd Party Protocols.

3. Click the Modbus Slave tab. 

4. Select the map name (for example, Default) and click Edit. The Modbus map editor 
appears.

5. Edit, add, or delete the Modbus Slave module registers or the name of the Modbus 
map.

6. Click OK.

Modbus Slave modules

All ION8650 meters have nine Modbus Slave modules. Meters with EN51060 support 
(ION8650A and ION8650B) have 11 additional modules. For a detailed Modbus map, 
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refer to the Modbus Protocol and Register Map for ION Devices document, available 
from www.schneider-electric.com.

Importing data using Modbus RTU
It is possible to bring data into the meter using Modbus. Various ION registers can be 
written to by Modbus master devices by correlating the Modbus register number with 
the address of the ION register you want to write to. When a Modbus register is written 
with a value, the corresponding ION register is written, provided the Modbus RTU 
protocol is active on the communications port that connects the Modbus master to the 
meter.

You can use the Modbus RTU protocol to write values into ION external numeric, pulse 
and Boolean registers, allowing you to enable, disable and reset meter functions. You 
can also use the Modbus protocol to change setup register values in various ION 
modules to configure the meter’s operation.

To bring data into the meter with Modbus RTU, you must disable the meter’s password 
security. 

Using the Modbus/TCP protocol

Modbus/TCP is an open Modbus protocol variant (formerly called MBAP). It defines the 
packet structure and connection port (port 502) for the industry standard TCP/IP 
protocol. The structure of Modbus/TCP is very similar to the Modbus RTU packet 
except that it has an extra six-byte header and does not use the cyclic redundancy 
check (CRC). Modbus/TCP retains the Modbus RTU limit of 256 bytes per packet.

NOTE: For Modbus RTU communications over Ethernet, connect to IP port 7701.

Modbus TCP communications
You can communicate to the meter using Modbus TCP. Your meter must have the 
optional Ethernet port. Configure the meter to connect using connection port 502 to use 
Modbus TCP communications protocols.

NOTE: You cannot form an EtherGate connection to the Modbus TCP network.
The Modbus unit ID of the meter over Ethernet has a default value of 100.

Connect to port 502
Ethernet
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The meter as Modbus master
ION8650 meters can act as a Modbus master using the Modbus RTU and Modbus/TCP 
protocols: 

• The meter can Modbus master using Modbus RTU over serial connections between 
the meter’s COM1 or COM4 ports and the Modbus slave devices. It can Modbus 
master over both COM1 and COM4 simultaneously. 

• Meters with an Ethernet connection can Modbus master over TCP/IP using up to ten 
available TCP connections. These TCP connections are dedicated to Modbus 
mastering, and are not included in the maximum of eight (8) Ethernet connections.

The meter acting as Modbus master can write data to (export) and read data from 
(import) Modbus slave devices. The data can be processed by the meter and sent out 
using other communications methods (email, Power Monitoring Expert, etc.). The 
meter can also send data directly to other devices on a Modbus network.

NOTE: Modbus master functionality is not available on the ION8650C.

For more information on Modbus mastering, see the Modbus and ION Technology 
technical note.

NOTE: If you encounter issues reading or writing to the device using Modbus, ensure
that your device’s security settings allow Modbus programming. See “Security” on
page 53 for more information on device security.

Configuring the meter as a Modbus master

This sections describes the ION modules involved in using the meter as a Modbus 
master and using ION Setup or Power Monitoring Expert.

The Modbus master configuration
There is no preconfigured Modbus master framework on your meter. This functionality 
must be enabled by configuring the following modules in your meter’s framework. 

Modbus master ION modules

Several ION modules work together to create Modbus master functionality on the 
meter. Your meter has some or all of these modules, depending on the model and 
firmware version. See the ION Reference for more information on these and other ION 
modules:

• Modbus Master Device module: reads data from a Modbus slave, which can be an 
ION meter or third-party device. This imported data can be used by other ION 
modules. The Modbus Master Device module references a Modbus Master Map 
module setup register to specify the Modbus format, scaling, and base address 
settings. 

• Modbus Master Map module: provides a common place to hold setup information 
(used to decode a Modbus response) for specific device types. This information 
can be referenced by multiple Modbus Master Device modules.

• Modbus Master Options module: maps any serial connection or Ethernet TCP 
socket from the Modbus Import, Modbus Export and Modbus Master Device 
modules to any serial communications port or unique IP address and port number.

• Modbus Export module: provides write functionality.

• Modbus Import module: provides read functionality. This data can then be used by 
other ION modules.
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NOTE: Modbus Export and Modbus Import modules are legacy modules and are
provided for backwards compatibility. 

See the Modbus and ION Technology technical note for more information on 
configuring Modbus master an the ION Reference for more information on the modules 
used in Modbus mastering.

Using the front panel
You cannot configure Modbus through the meter’s front panel. You can only assign the 
Modbus protocol to communication ports. See “Communications” on page 81 for 
details.

Use Power Monitoring Expert or ION Setup to perform full Modbus configuration.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > 3rd Party Protocols.

3. Click on the Modbus Master tab.

4. Click Add to add a Modbus slave device. The Modbus Device dialog box appears.

5. Type the slave device’s name and a label suffix (if applicable). Select the device 
type of the slave device from the Device Type list (in this example, an ION6200).

6. Type the unit ID of the slave device in the Slave ID box.

7. Select the serial or TCP connection you want to configure from the Connected via 
list. This is the connection used by the Modbus master to connect to that slave 
device. Click Connections. The Modbus Master Connections dialog box 
appears.
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8. Select the tab that corresponds to the connection you are configuring (for example, 
if you selected TCP Connection 1 from the Connected via list, select the TCP 1 
tab), and edit the text boxes as follows:

– Serial Connections: Select the port that is connected to the Modbus slave devices 
from the Assigned Port dropdown list.

– TCP Connections: Type the IP address of the Modbus slave device. Ensure that 
the IP port is 502. You can enter up to ten (10) Modbus slave device IP 
addresses.

NOTE: For Modbus mastering over RTU, the total number of possible serial
connections is limited by the number of physical serial ports on the meter that can
Modbus master. The meter has two physical serial ports that support Modbus master
(COM1 and COM4).
To Modbus master over Ethernet, the meter must have the optional Ethernet
connection.

Click OK when you have finished configuring connections to return to the Modbus 
Device dialog box.

9. Click OK to add the slave device. The device now appears in the list. Continue adding 
devices by clicking Add until all of your devices are entered.

NOTE: The meter as Modbus master over TCP/IP will attempt to communicate to a
slave for up to 100 seconds (as per the RFC1122 standard) before moving on to the
next slave device.

See the Modbus and ION Technology technical note for more information.

Using Power Monitoring Expert
Use Designer to configure Modbus master functionality on your meter.

1. Open the master meter in Designer.
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2. Navigate to the Modbus Master Options module. Right-click on the center of the 
module icon to access the ION Module Setup dialog box. 

3. Configure the setup registers by selecting the setup register you want to change 
and clicking Modify, or by double-clicking on the register.

– Serial Connections: Select the appropriate port from the dropdown list.

– TCP Connections: Enter the IP address of the Modbus slave device, followed by 
a colon (:) and the IP port (502), for example, 192.168.0.1:502. You can enter up 
to 10 unique IP addresses. 

NOTE: For Modbus mastering over RTU, the total number of possible serial
connections is limited by the number of physical serial ports on the meter that can
Modbus master. The meter has two physical serial ports that support Modbus master
(COM1 and COM4).
To Modbus master over Ethernet, the meter must have the optional Ethernet
connection.

4. Create a new Modbus Master Map module for each slave device. The Modbus 
Master Map module has two setup registers:

– Device Type: Enter the type of device that you want to map. This value is 
referenced by the Modbus Master Device module.

– Device Map: This is the data that you want to access from the Modbus slave 
device, in the form of text strings containing the parameter label, register value, 
data format, etc.

5. Create a new Modbus Master Device module for each slave device. Configure the 
following setup registers in the Modbus Master Device module:

– Connection: Select the serial or TCP connection being used to communicate with 
the slave device.

– Slave Addr: Type the unit ID of the slave device.

– Device type: Type a device type string. Ensure that this is the same as the device 
type entered in the Modbus Master Map module.

– Slave name: Type a name for the slave device.

6. Link the module inputs and outputs as required.

7. Select File > Send & Save when you are finished.

See the online Power Monitoring Expert Help for more information on creating, 
modifying and linking modules in Designer and the ION Reference for details of module 
setup and output registers.
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Using the DNP 3.0 protocol
The Distributed Network Protocol Version 3.0 (DNP 3.0) is an open protocol used in the 
electric utility industry for communications and interoperability among substation 
computers, remote terminal units (RTUs), intelligent electronic devices (IEDs; for 
example, meters), and master stations.

Your meter can be integrated into a DNP network as a DNP slave, using the DNP Slave 
Import, DNP Slave Export and DNP Slave Options modules. For more information on 
the various DNP modules, see the ION Reference.

Your meter supports a maximum of three concurrent connections (or “sessions”) using 
the DNP 3.0 protocol; one for each serial port, up to three using Ethernet, or a 
combination of both. Combinations available depend on the meter's communications 
options. A session consists of all incoming and outgoing DNP master/slave traffic on 
one of the meter's communications ports.

In addition to the standard DNP Slave Export modules with update rates of once per 
second, high-speed versions of these modules with typical update rates of once per 8 
milliseconds are available. Additionally, millisecond time-stamping is supported for 
DNP events.

Consult the DNP User’s Group at http://www.dnp.org/ to learn more about the protocol.

The factory DNP 3.0 configuration
Your meter is preconfigured with a DNP framework that allows for basic DNP slave 
functionality. DNP Slave Export modules are used to send data to the DNP master 
while DNP Slave Options modules provide per-session settings such as 
communications options. Although some minor setup of the framework is necessary 
before it is enabled (assigning the DNP protocol to the communications ports, for 
example), most module settings should not require alteration.

For information on your meter’s default DNP map and factory configuration, see the 
ION8650 DNP 3.0 Device Profile.

Importing data using DNP 3.0

Data can be imported into the meter from a DNP control relay or analog output device. 
DNP Slave Import modules are used to take a DNP Analog output or Binary output 
object and map them into ION registers.

NOTE: DNP Slave Import modules are not part of the factory DNP framework and must
be added manually. Refer to the DNP Slave Import module description in the ION
Reference for details. Refer to the DNP 3.0 Device Profile protocol document for a
description on the DNP 3.0 communications protocol used by the meter. 

Configuring DNP 3.0

If the factory DNP configuration does not suit your needs, you can relink the existing 
DNP Slave Export modules to access a different set of parameters through DNP. 
Alternately, you can add additional DNP Slave Export modules and link the desired 
parameters to them.

If your DNP network requires data in a format different than that provided by the factory 
DNP configuration, you can edit the setup registers in the DNP Slave Export modules 
and the DNP Slave Options modules. Do not make any changes to the DNP Slave 

http://www.dnp.org/
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Options modules’ setup registers unless you understand the effects each change will 
cause. Refer to the ION Reference for complete details on DNP Slave Export and DNP 
Slave Options module function.

For detailed information on configuring your meter to use DNP, see the Multiport DNP 
3.0 and ION Technology technical note.

Using the front panel
You cannot configure DNP through the meter’s front panel. You can only assign the 
DNP 3.0 protocol to communication ports. See “Communications” on page 81.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > 3rd Party Protocols and click on the DNP 3.0 tab.

3. Select the DNP feature you want to configure (for example, Parameter Map) and 
click Edit.

The Setup Assistant wizard guides you through DNP configuration. See the 
ION Setup Help for more information.
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Using the DLMS protocol
The Device Language Message Specification (DLMS) provides an interoperable 
environment for structured modeling and meter data exchange. DLMS supports 
applications such as remote meter reading, remote control, and value-added services 
for metering different kinds of energy, such as electricity, water, gas or heat.

DLMS is an international standard published as IEC 62056.

DLMS configuration

DLMS-enabled meters come preconfigured with frameworks that allow the meter to 
provide selected values to a DLMS master. You need to configure the meter’s 
communication settings before you can access values using DLMS master software.

DLMS is available on Ethernet and all serial ports, including the front optical port. Use 
the front panel or ION Setup to set the protocol for the serial communication port you 
want to use for DLMS. Use ION Setup to enable DLMS over Ethernet and assign the 
port.

Serial configuration using the front panel
1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu 

appears.

2. Use the navigation buttons to highlight the COM port that you want to configure 
(COM1 SETUP - COM4 SETUP) and press ALT/ENTER to select.

3. Use the navigation buttons to highlight the Protocol setting and press ALT/ENTER 
to select.

4. Select DLMS from the list of available protocols. 

5. Select YES to confirm the change.

Serial configuration using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Serial Settings and click on the COM tab that 
corresponds to the communication port you want to configure.

3. Select the Protocol parameter and click Edit.

4. Select DLMS from the dropdown list and click OK.

Ethernet configuration using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Advanced Ethernet and click on the Protocols tab.

3. Select DLMS in the Protocols list and click Edit.

4. Select the Enabled checkbox to enable DLMS over Ethernet, enter the port you 
want to use and click OK.

Changing the data exported to DLMS client software
You can configure your meter to export the values from the Data Recorder modules to 
DLMS client software. To do this, you need to map the applicable data recorder to a 
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DLMS Log Export module and configure that module’s setup registers with the 
appropriate OBIS codes.

NOTE: Changing these modules and any of their inputs from the default template is an
advanced setup procedure that requires an understanding of the protocol and your
meter’s internal operations.

1. Start ION Setup and open your meter in Advanced mode. See the online ION Setup 
help for more information.

2. Navigate to the DLMS Log Export Module Modules folder.

3. Create a new module or edit an existing module. Double-click the module to edit its 
configuration.

4. Select the Inputs tab to link the module to a Data Recorder module.

– Select the input and double-click (or click Edit).

– Navigate to the Data Recorder module that you want to link to the DLMS Log 
Export module and click OK.

NOTE: You can link a Data Recorder module to multiple DLMS Log Export modules but
you can only link each DLMS Log Export module to one Data Recorder module.

5. Select the Setup Registers tab and double-click a register to edit it:

6. Click Send to save your changes to the meter. Use your DLMS client software to 
validate that you are receiving the expected values.

Related topics
• See the DLMS User Association website at www.dlms.com for information about 

the DLMS protocol.
• See DLMS/COSEM and ION technology for more information about how DLMS is 

implemented on your meter.
• See ION reference for module settings and operation.

Setup register Description

Profile Generic OBIS Enter the Profile Generic OBIS code you want to assign to the values 
associated with the module.

Status Register

Setting this register to ENABLED includes the status field in the Profile 
Generic object. 
If the Record input of the associated Data Recorder module is linked to a 
Periodic Timer, the status of the DLMS Log Export module is updated at 
that recording interval. If the Data Recorder Record input is not linked to a 
Periodic Timer, the value of the status register is 0xFFFF.

OBIS Code Source 1 – 
OBIS Code Source 16

Enter the register attribute OBIS codes for each input of the linked Data 
Recorder module that you want to export.
Each OBIS Code Source setup register maps to the equivalent input 
register of the linked Data Recorder module. If you do not want to export a 
particular value, enter NONE for that OBIS Code Source setup register (this 
is the default value for a newly created DLMS Log Export module).
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IEC 61850
IEC 61850 is an Ethernet-based protocol designed for electrical substations. It is a 
standardized method of communications, developed to support integrated systems 
composed of multi-vendor, self-describing IEDs (intelligent electronic devices) that are 
networked together to perform monitoring, metering, and real-time, non-critical 
protection and control. 

Your meter can be integrated into an IEC 61850 system as an IED (or server), 
supporting concurrent IEC 61850 client connections and an FTP connection (used for 
transferring data or configuration files). 

IEC 61850 configuration assumes that you have an advanced understanding of IEC 
61850 protocol, your communications network and the power system that your meter is 
connected to.

Related topics
• See the IEC (International Electrotechnical Commission) website at www.iec.ch for 

general information about the IEC 61850 protocol.
• See the IEC 61850 and ION Technology protocol document for more information 

about how IEC 61850 is implemented on your meter.
• See the ION Reference for a description of the IEC 61850 ION modules. 

Implementation

Your meter comes configured with a default set of meter data available to IEC 61850. 
This default set of meter data is used in the default data sets and reports in the ICD 
file(s) available for download at www.schneider-electric.com.

NOTE: Select the ICD file that matches your meter’s option module configuration, and
either Edition 1 or Edition 2 of the IEC 61850 protocol.

You must load a valid IEC 61850 configuration (CID) file into the meter in order to 
activate the IEC 61850 features of your meter.

NOTE: Your meter can have only one IEC 61850 configuration (CID) file loaded onto
its internal FTP site. If additional CID files are loaded, IEC 61851 functions are
deactivated until the additional files are removed.

Your meter has five dedicated IEC 61850 client connections.

You can load the IEC 61850 configuration file and configure the IEC 61850 custom 
modules using ION Setup.

Configuring IEC 61850

No meter port configuration is required for IEC 61850, but the meter must have an 
operating Ethernet connection for IEC 61850 client connections and for FTP 
transmission of configuration and data files.

Configuring additional ION data into IEC 61850
The IEC 61850 ICD file for your meter contains a comprehensive set of default data 
values. Additional meter data values can be made available in IEC 61850 by mapping 
the ION data to the GGIO Custom Analog or GGIO Custom Digital modules.
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Using the front panel

You cannot configure IEC 61850 through the meter’s front panel.

Using ION Setup

1. Start ION Setup.

2. Open the Setup Assistant for your meter. 

3. Navigate to Communications > 3rd Party Protocols and select the IEC 61850 
tab. 

The CID status line indicates whether the meter has received and validated an 
IEC 61850 CID file and is operating as an IEC 61850 server:

– IEC 61850 stack running: the meter has received and validated an IEC 61850 
CID file and is operating as an IEC 61850 server.

– Missing CID file: no IEC 61850 CID file is loaded into the meter.

– Invalid CID file: the IEC 61850 CID file is invalid

4. Select the information type that corresponds to the data you want to map and click 
Edit. Custom Analog and Custom Digital allow you to map additional numeric 
(analog) or Boolean/binary (digital) values into IEC 61850.

NOTE: Because Custom Analog and Custom Digital are ION modules, they can be
configured at any time, regardless of CID status.

5. Expand the Available registers list and select the custom analog or digital value that 
you want to map into IEC 61850. Highlight the IEC 61850 leaf you want to map onto 
and click the >> button to map the value. Click the << button to remove the value. 
Select Show all available registers to show all the ION modules and their 
registers. Click OK to send your changes to the meter.
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Configuring meter digital I/O control via IEC 61850
By default, your meter’s I/O status values are available via IEC 61850. You can 
configure the meter to provide IEC 61850 control of the meter’s optional digital output 
hardware ports by configuring the GGIO Onboard ION module and the Digital Output 
module.

NOTE: Refer to “Inputs / Outputs” on page 143 for details on how to configure your
meter’s digital inputs and outputs.

To control your meter’s digital outputs via IEC 61850, you must configure the Digital 
Output module’s Source register to be the IEC 61850 digital status value (SPCS.stVal) 
output register. This output register is written by the IEC 61850 system into the 
IEC 61850 GGIO Onboard module. You must also disconnect the Digital Input 
module’s Status output register from the IEC 61850 GGIO Onboard Digital Output 
Status input register or else you will create a circular reference and the modules will go 
offline. Refer to the ION Reference for details of the IEC 61850 GGIO Onboard module.

Using ION Setup

1. Start ION setup.

2. Connect to your meter in Advanced Mode.

3. Navigate to the GGIO Onboard folder and double-click on the module in the right-
hand pane.

WARNING
HAZARD OF UNINTENDED OPERATION
• Do not use the meter for critical control or protection applications where human 

or equipment safety relies on the operation of the control circuit.
• Be aware that an unexpected change of state of the digital outputs may result 

when the supply power to the meter is interrupted or after a meter firmware or 
template upgrade.

Failure to follow these instructions can result in death, serious injury or 
equipment damage.
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4. Select the Setup Registers tab.

5. Select the SPCS Control Mode register that corresponds to the digital output you 
want to control through IEC 61850 and click Edit. A dialog box appears.

6. Select IEC 61850 CTLVAL from the dropdown list and click OK.

7. Select the Inputs tab.

8. Select the digital output Status register for the digital output that you want to control 
through IEC 61850. Click Delete.

NOTE: This digital input register must be deleted in order to prevent a circular reference
that will cause the affected modules to go offline.

9. Click Send to send your changes to the meter.

10. Select the Setup Registers tab and confirm that the Digital Output module’s setup 
registers are appropriately configured.

11. Navigate to the Digital Output folder.

12. Double-click on the Digital Output module that you want to control through 
IEC 61850. 

13. Select the Setup Registers tab and confirm that the Digital Output module’s setup 
registers are appropriately configured.

14. Select the Inputs tab.

15. Select the Source register and click Edit.

16. Navigate to the IEC 61850 GGIO Onboard module and select the SPCS.stVal 
output register that corresponds to the digital output.
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17. Click OK and Send to save your changes to the meter.
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Configuring MV-90
ION8650 meters can provide energy values to an MV-90 data management system. In 
order to recognize and communicate with your meter, the MV-90 software requires 
meter configuration data to create a master (master.dat) file for your meter.

Use ION Setup to:

• generate a meter configuration (master.dat) file for your meter that can be imported 
directly into your MV-90 system or printed for manual data entry.

• configure your meter’s revenue data in MV-90 E-File or P-File data formats.

• export an .hhf file to transfer revenue data from your meter to your MV-90 system 
using a handheld device.

For more information, see the MV-90 and ION Technology technical note, available 
from the website.
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Chapter 9 Time
This chapter covers the meter’s clock and time synchronization, including IRIG-B GPS 
time synchronization.

NOTE: References to NTP in ION devices or documentation should be interpreted as
SNTP. 

In this chapter
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Meter clock configuration
The Clock module controls the meter’s internal clock, which provides timestamps for 
data logged by the device. The clock needs to be configured properly to ensure that 
internally logged data has accurate timestamp information. The clock settings do not 
affect any data logs that are stored external to the meter. The Clock module also 
receives the time synchronization signals sent to it by a workstation running Power 
Monitoring Expert or ION Setup, updating the device’s clock when required.

The Clock module’s Clock Source setup register defines how the meter’s internal clock 
auto-corrects drift from its internally calculated time. A separate time source (such as a 
GPS receiver or a DNP Master) can be used to synchronize the clock through a 
communications channel. By default, the clock is set to synchronize from the line 
frequency.

See the ION Reference for more information on the Clock module and the Time 
Synchronization & Timekeeping technical note for more information about time and ION 
meters.
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Time synchronization
Time synchronization lets you synchronize your meter’s internal clock with all of the 
other meters, devices, and software in a network. After the meter is synchronized, all 
the data logs stored on the meter have timestamps that are relative to a uniform time 
base. This allows you to achieve precise sequence-of-events and power quality 
analyses using the data logged on the meter. Use Power Monitoring Expert or 
ION Setup to broadcast time signals across the network, or utilize an external source 
(such as a DNP Master or IRIG-B) to synchronize your meter’s clock.

Refer to the Time Synchronization & Timekeeping technical note for more information 
on implementing time synchronization. 

Refer to the DLMS/COSEM and ION technology protocol document for information on 
time synchronization with DLMS.

IRIG-B time synchronization

ION8650 meters come with an IRIG-B connection for GPS time synchronization using 
unmodulated IRIG-B time code data. The meter is configured to synchronize via IRIG-
B GPS, after you wire the meter to a GPS receiver and set the clock Time Sync Source 
and Clock Source parameters.

Any GPS receiver that outputs unmodulated IRIG-B time code data can be used as a 
time synchronization source. 

You can configure IRIG-B time synchronization to update if the GPS receiver is locked 
onto a satellite source or to update regardless of whether or not the GPS receiver is 
locked onto a satellite source. Refer to the Clock module description in the ION 
Reference for more information on this setting.

NOTE: When using a GPS receiver for time synchronization, the recommended setting
for baud rate and 8N1 for stop bits/parity.

IRIG-B standard and specifications

The standard is outlined in the IRIG-STANDARD 200-04 “IRIG Serial Time Code 
Formats” prepared by the Timing Committee, Telecommunications and Timing Group, 
Range Commanders Council.

1Coded expressions 0 to 7 are supported but the year data is not used by the meters.

Diagnostic module outputs and event log entries

The Diagnostic module output registers and event log entries update as described in 
the Time Synchronization & Timekeeping technical note, with the following exceptions:

• The GPS Receiver Status output register in the Diagnostics module is set to 
N/A.

• The GPS locked and GPS unlocked event log entries are not generated.

Accuracy +/- 1 ms

Format IRIG-B00x1 format (unmodulated IRIG-B time code)
Nominal Voltage 5 Vdc +/- 10%
Maximum Voltage 8 Vdc
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Configuring the meter clock
Use Power Monitoring Expert or ION Setup to change the meter’s clock settings.

Using the front panel
You cannot configure the time using the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions

2. Select the Clock screen.

3. Click the Timezone tab to configure your meter’s clock settings. Select a parameter 
and click Edit to change.

NOTE: For IRIG-B, set the Time Sync Source to IRIG-B and the Clock Source to
COMM. 

4. Click on the DST Settings tab to configure your meter’s daylight savings periods for 
up to 20 years. Select a parameter and click Edit to change.

5. Connect the meter to the time sync source (such as a GPS receiver output) if 
applicable.

Using Designer
Open your meter in Designer and navigate to the Meter Clock Setup framework. Right-
click on the Clock module to edit.

Clock module settings

The setup registers in the Clock module specify timezone and Daylight Savings Time 
(DST) parameters and time synchronization functions. Refer to the Clock module 
description in the ION Reference for information on advanced settings you can 
configure.
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When modifying setup registers of the Clock module in Designer, use the Format option to 
convert between UNIX and conventional time. Refer to the description of the Clock module in the 
online ION Reference for more details.

Typically, the DST Start and DST End registers do not need to be reconfigured for users 
in North America. The factory defaults are the DST start and end dates for 20 years, in 
UNIX time (the number of seconds since 00:00:00 UTC on Jan. 1, 1970).

Refer to the Time Synchronization & Timekeeping technical note for further details on 
using the meter’s time synchronization functions. Refer to the ION Reference for more 
information on the Clock module and its registers.

Setup register Function Default
Timezone Sets the timezone the device is in, relative to Greenwich Mean Time. 0
DST Start 1 …
DST Start 20 The date and time when DST begins for 20 separate years. Refer to the ION Device Template 

Reference for the DST Start and 
DST End defaults for the twenty 
separate years.

DST End …
DST End 20 The date and time when DST ends for 20 separate years.

DST Offset The amount of time the clock is changed when DST begins or ends. 3,600 seconds

Time Sync Source Specifies the communications port that receives time sync signals. For Ethernet, 
it also specifies which protocol can time sync the meter. COM3

Time Sync Type Specifies the type of time sync signal (Local or Universal time). UTC

Clock Source Specifies the clock’s time synchronization signal source (line frequency, 
communications signals, or internal crystal). Line Frequency

Percent Battery 
Remaining

The setting displays the approximate percentage of battery life remaining. You 
should only need to edit this parameter if you have replaced the battery. Not applicable

Time Set Count This setting displays the number of instances that the meter time has been 
updated. Not applicable

Time Sync Count This setting displays the number of time update requests received via 
communications. Not applicable

Local Time The parameter is shown for information purposes only. It displays the current 
local time on the meter. To change this, you must time sync the meter. Not applicable
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Replacing the battery
See the ION8600/ION8650 battery replacement instructions for more information.
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Chapter 10 Demand
This chapter explains how to configure and view demand values on your meter.

In this chapter
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Introduction
Demand is a measure of average power consumption over a fixed time interval. Peak 
(or maximum) demand is the highest demand level recorded over the billing period. 
Demand is measured using Sliding Window Demand modules. These modules are 
configured to calculate the average current demand and kW, kVAR and kVA demand. 
The setup registers in the demand module defines time intervals for demand 
calculations, setting the sensitivity of the module’s operation.

The meter has a default demand framework that is suitable for most utility applications. 
However, if needed, you can customize it for your specific application.

Sliding window demand
Sliding window demand is often referred to as rolling block demand. To compute sliding 
window demand values, the meter uses the sliding window averaging (or rolling 
interval) technique which divides the demand interval into sub-intervals.

The demand is measured electronically based on the average load level over the most 
recent set of sub-intervals. This method offers better response time than fixed interval 
methods.

The meter uses the Sliding Window Demand module to calculate sliding window 
demand.

Peak demand
Power utilities generally bill commercial customers based on their peak usage levels, 
called peak demand (in kW) and energy consumption (in kWh). Demand is a measure 
of average power consumption over a fixed time interval, typically 15 minutes. Peak (or 
maximum) demand is the highest demand level recorded over the billing period. Sliding 
window demand is one method of measuring demand. 

Illustration of the basic demand framework
In the following diagram, the Sliding Window Demand module labeled “Demand” 
calculates demand from the power input by measuring and averaging the power over a 
set interval. The demand value is then output to a Maximum module labeled “Peak 
Demand” that records the highest demand value over time (peak demand). 
   

For more information on ION modules, refer to the online ION Reference.

Power
DEMAND

Sliding Window 
Demand module

Power output 
averaged 
(Demand)

PEAK DEMAND

Maximum module

Maximum 
value (Peak)
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Configuring demand
Use Power Monitoring Expert or ION Setup to change your meter’s demand settings.

Using the front panel
You cannot use the front panel to configure demand.

Using ION Setup
The Demand screen in the Setup Assistant helps you configure sliding window (or 
rolling block) demand. This screen also contains two registers used for configuring 
sliding window demand while the meter is in TEST mode.

In ION Setup: 

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select the Demand screen.

3. Select a register and click Edit to configure.

Using Designer
Open your meter in Designer and navigate to the Demand Setup framework. Click on 
Demand Setup to access the Sliding Window Demand modules. Right-click on a 
module to edit.

Sliding Window Demand module settings
The following table outlines the sliding window demand settings. See the ION 
Reference for more information about the Sliding Window Demand module.

Setup register Function Default
Sub Intvl The time, in seconds, in the sliding window demand sub-interval. 900
#SubIntvls The number of sub-intervals in the sliding window. 1

Pred Resp The speed of Predicted Demand calculations; use higher values 
for faster prediction (70 to 99 recommended). 70

Update Rate Defines the update rate of the SWinDemand output register Varies depending 
on the module
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Configuring demand reset lockout time

The demand reset lockout time sets the minimum time allowed between consecutive 
demand resets; the meter ignores any attempts to reset demand that occur within the 
lockout time. The default demand lockout time is 25 days (2160000 seconds).

Using the front panel

1. Hold down the ALT/ENTER button to access the SETUP menu.

2. Use the up and down arrows to highlight DISPLAY SETUP then press the ALT/
ENTER button.

3. Use the up and down arrows to highlight DMD LOCK TO then press the ALT/
ENTER button.

4. Use the up and down arrows to enter a demand lockout time in seconds. Press ALT/
ENTER to apply the value.

Using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions

2. Select the Demand screen and click the Rolling Block tab.

3. Select Demand Lockout and click Edit. Enter a demand lockout time in days (in 
Elapsed Interval Format) or seconds (in Numeric Bounded Format). Click OK.



7EN02-0306-03 139

ION8650 User Manual Chapter 10 - Demand 

Demand Forgiveness
Demand Forgiveness is the time programmed to the meter during which demand (and 
therefore peak demand) will not be calculated in the power restoration period following 
a total power outage. 

During power-up following a complete power outage, customer equipment consumes a 
higher than normal amount of power. Demand Forgiveness lets a utility forgive the 
customer for peak demand penalties that can arise from power-up following a power 
outage (should the outage exceed a user-specified period of time). 

Demand and Peak Demand module behavior during Demand Forgiveness

A peak demand value is the highest demand value since the last peak demand reset. 
The Demand Forgiveness framework sets the Sliding Window Demand module inputs 
to zero during a Demand Forgiveness period. This method allows demand interval data 
to accurately reflect a complete interval that includes data:

• prior to an outage

• during the Demand Forgiveness period (zero values)

• after the Demand Forgiveness period

NOTE: During a Demand Forgiveness period, Sliding Window Demand module inputs
are set to zero and do not reflect actual demand. These values should not be used to
calculate energy for billing purposes. Energy values are not affected and reflect actual
energy consumption during the Demand Forgiveness period. 

The settings listed below must be made configured for Demand Forgiveness 
functionality. These settings can be accessed from ION Setup; refer to “Using 
ION Setup” on page 141.   

• Minimum Outage Duration lets you specify the amount of time (in seconds) that the 
power must be out before the Demand Forgiveness period begins. 

• Demand Forgiveness Duration lets you specify the amount of time (in seconds) that 
demand is forgiven (demand inputs are zero). 

• Update Rate lets you define the update rate of the SWinDemand output register. It is 
set to Every Second by default for revenue-related demand modules; with this 
setting, demand value measured is updated once per second.

• Outage Voltage (line-to-line average in unscaled meter units) lets you define a 
voltage level that is considered an outage. This is set to 20 volts by default.
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The preceding diagram shows an example of a meter that is set up for Demand 
Forgiveness. The Sliding Window Demand module is averaging demand values at 15 
minute intervals. During interval #1, the meter has a power outage that lasts for 18 
minutes. The power outage is defined by a system voltage of 20 volts which is specified 
in the Outage Voltage setting. The Minimum Outage Duration setting is specified as 10 
minutes, so this is the amount of time that the power must be out before demand can 
be forgiven. The Demand Forgiveness Duration setting is specified as 1800 seconds 
(30 minutes), so for 30 minutes following power restoration, demand inputs are zero. 
The power is restored during interval #2, where the surge of power consumption during 
power-up is included in the Demand Forgiveness period and has a value of zero. 

Additional Information 
The following points are important to note:

• The following demand input values are zero for kQ, kW, kVA, and kVAR during the 
Demand Forgiveness period:

– Delivered

– Received

– Delivered + received

– Delivered – received

– Q1, Q2, Q3, Q4

• If a new peak is set prior to a power outage, it persists.

• Even though demand is zero during the Demand Forgiveness period, a new peak 
can be set if the demand was very high prior to the power outage or after the 
Demand Forgiveness period ends.

• Demand Forgiveness works for auxiliary and blade powered meters.

• All ION modules in the Demand Forgiveness framework are fully locked. 

• If a Demand Forgiveness period is initiated, and another power outage occurs that 
is less than the time specified in the Minimum Outage Duration setting, the Demand 
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Forgiveness period continues. If a second outage is greater than the time specified 
in the Minimum Outage Duration setting, the Demand Forgiveness period restarts.

• Both the power outage downtime and the Demand Forgiveness downtime are 
stored within the Demand Forgiveness framework. The Store modules preserve a 
timestamp that is viewable in Vista.

• The Sliding Window Demand module Update Rate setup register must be set to 
EVERY SECOND (this is the default for revenue-related demand modules). 

• If Demand Forgiveness is enabled on an auxiliary-powered meter and there is no 
power on the blades, the meter assumes that this is an outage. When power is 
applied to the blades, demand is forgiven for the specified time. 

• If Demand Forgiveness is enabled and the meter is unplugged for servicing or other 
reasons, the Demand Forgiveness framework assumes there was an outage and 
demand is forgiven for the specified time.

• For meters where Demand Forgiveness is enabled at the factory (for example, 
certain certified revenue-sealed meters), demand is not measured when the meter is 
first put into service. Instead demand is forgiven for the specified time. 

Configuring Demand Forgiveness

Demand Forgiveness is disabled by default. Use ION Setup to enable Demand 
Forgiveness.

NOTE: If Demand Forgiveness is enabled, do not use demand values to calculate
energy for billing purposes. Energy values are not affected and reflect actual energy
consumption during the Demand Forgiveness period.

Using the Front Panel
You cannot enable or edit Demand Forgiveness settings using the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select the Demand screen and click the Demand Forgiveness tab.

3. Select Demand Forgiveness Enable. Click Edit and select ON. This enables 
Demand Forgiveness. 

4. Select Min Outage Duration and click Edit. 

Type the amount of time (in seconds) that the power must be out before the Demand 
Forgiveness period starts. Click OK.

5. Select Demand Forgiveness Duration and click Edit.

Type the amount of time (in seconds) that demand is forgiven (demand inputs are 
zero). Click OK.

6. Select Outage Voltage if required and click Edit. 

Type the minimum voltage (line-to-line average in unscaled meter units) that is 
considered an outage; this is set to 20 V by default but you can adjust this. Click OK. 
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Chapter 11 Inputs / Outputs
This chapter provides information on the meter’s various digital and analog inputs and 
outputs (I/O).

Refer to your ION8650 Installation Guide for instructions on wiring inputs and outputs 
and for the general meter I/O specifications.

You can use the ION8650’s onboard I/O for a variety of applications.

For example, you can use a Form A digital input to monitor a breaker to verify how many 
times the breaker trips. When the breaker reaches its limit for the number of trips, you 
can use the digital output to light an LED next to the breaker so field personnel are 
alerted. You can also use a Form C digital output to send KYZ pulsing information to 
third-party system equipment. 

NOTE: The Ethernet outage notification card uses the same physical slot as the I/O
option board, which means that you cannot have both optional I/O and outage
notification on the same meter. 

In this chapter

Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  144
Specifying an I/O port in a module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145
Using the onboard digital outputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  146
Using the optional onboard digital inputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  148
Using the optional analog outputs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  149
Configuring inputs and outputs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  150
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Introduction
The meter’s digital and analog I/O ports simplify data gathering by importing a variety 
of data types into a single, common system. You need to configure the following 
modules in order to use the meter’s for digital and analog I/O capabilities.

• Digital Input: Digital (status) inputs can be used for monitoring external contacts or 
pulse counting applications, and are controlled by Digital Input modules. This 
module tells the meter how to interpret incoming signals.

• Digital Output: Digital outputs are used for hardware relay control or pulse counting 
applications. The outputs can be controlled by Digital Output modules, Pulser 
modules, or Calibration Pulser modules, depending on the application (relay 
switching or energy pulsing). An example of a commonly used application for each 
module is listed below.

– Digital Output module: monitors a change of state to control relay operation 
via a hardware output device.

– Pulser module: transfers high-speed pulses to a hardware pulse counting 
device that is used to track energy usage.

– Calibration Pulser module: integrates instantaneous power inputs, then 
outputs high-speed pulses to an LED that can be monitored to verify revenue 
meter calibration.

All of these modules can act as intermediaries between the hardware port and the 
other modules in the meter. They define the characteristics of outgoing signals.

• Analog Output: Analog outputs can deliver a continuous DC signal, and are 
controlled by the Analog Output modules.

See the ION8650 Installation guide for I/O wiring instructions.
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I/O Expander for ION8650 meters

For analog or additional digital I/O with the meter, you can use an external 
I/O Expander. Information for the analog and digital I/O Expander options is available 
in the I/O Expander Installation Guide.

Specifying an I/O port in a module

For detailed information and instructions on configuring Analog and Digital I/O modules, 
see the ION Reference.

Expanded I/O (and serial 
COMs): Molex Micro-Fit 
24 pin male connector. 

Optional Onboard 
I/O: 16 pin male 
connector.

Socket or switchboard meter connections

Onboard I/O breakout cable with female 
connector and sixteen bare-ended wires. 

See your meter’s Installation Guide for 
installation instructions and information on 
determining the I/O configuration available on 
your meter.

Onboard I/O

Onboard I/O

Optional I/O Expander for serial communications 
and expanded I/O. For more information, see the 
PowerLogic I/O Expander Installation Guide. 

Serial COMs 
COM1: RS-232 or 
RS-485.
COM4: RS-485, 
depending on the 
options ordered for 
your meter.

Depending on the version 
of the I/O Expander that 
you ordered, you can have:
Eight Form A digital inputs.
Four Form C digital outputs. 
Four Form A digital outputs 
or four analog outputs. 
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Configure the Digital Output, Digital Input, Analog Output, Pulser, and Calibration 
Pulser modules to specify which port handles the outgoing or incoming signals. To 
assign a port to one of these modules, simply modify the Port setup register by picking 
a port from the enumerated list. This can be done with both ION Setup and the Designer 
component of Power Monitoring Expert.

The following table describes the ports that can be configured (in the Digital Output, 
Digital Input, Analog Output, and Calibration Pulser modules) to handle outgoing or 
incoming signals. 

NOTE: You must confirm the meter I/O options (onboard and/or I/O Expander) to
determine which of the following apply to your meter. 

Configuring energy pulsing applications

To configure the LED outputs for energy pulsing applications (for example, kVAh), see 
“Energy pulsing” on page 153. 

Using the onboard digital outputs

Digital outputs are used for hardware relay control or pulse counting applications. For 
example, the meter’s digital outputs can provide on/off control signals for capacitor 
banks, generators, and other equipment. The digital output ports can also send out 
status signals or kWh pulses, if the receiving device determines energy usage by 
counting pulses. 

A meter with the optional onboard I/O provides four Form C digital outputs and a Form 
A digital output. All digital outputs can deliver a continuous signal or a pulse. 

Contact Schneider Electric for complete information regarding relay applications.

ION module type ION module name Hardware port
(device label)

Port setup register 
name Description

Onboard digital output ports

Digital Output (DO)
DO Onbrd RA-1 A1 On-Board FormA Out 1 Digital Output port 1 (Form A Solid State)
DO Onbrd RC-1 to 
DO Onbrd RC-4 C1 to C4 On-Board FormC 1 to 

On-Board FormC 4 Digital Output port 1to 4 (Form C Relay)

Calibration Pulser
VARh Pulse LED1 Watt LED WATT LED LED Output 

Wh Pulse LED1 VAR LED VAR LED LED Output

Onboard digital input ports
Digital Input (DI) DI-S9 S1 On-Board FormA 1 Digital Input port 1 (Form A)

DI-S10, DI-S11 S2, S3 On-Board FormA2 to 
On-Board FormA3 Digital Input port 2 to 3 (Form A)

I/O Expander digital output ports

Digital Output (DO)
DO RC-1 to
DO RC-4

C-1 to C-4 I/O Exp FormC 1 to
I/O Exp FormC 4 Digital Output port 1 to 4 (Form C)

DO RA-1 to
DO RA-4

A-1 to A-4 I/O Exp FormA 1 to
I/O Exp FormA 4 Digital Output port 1 to 4 (Form A)

I/O Expander digital input ports

Digital Input (DI) DI-S1 to DI-S8 A-1 to A-4 I/O Exp In 1 to
I/O Exp In 8 Digital Input port 1-8 (Form A)

I/O Expander analog output ports

Analog Output (AO)
Analog Out 1 to
Analog Out 4

A1 to A4 I/O Exp AnOut 1 to
 I/O Exp AnOut 4 Analog Output port 1 to 4
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Digital Output modules

These outputs can be controlled with Digital Output modules, Pulser modules, or 
Calibration Pulser modules, depending on the application. For relay and control, the 
Digital Output module is used. For pulsing applications, the Pulser or Calibration Pulser 
modules are generally used. 

You must configure these modules in order to use the output ports.

• Calibration Pulser modules allow you to generate high accuracy energy pulses for 
verifying meter accuracy. They integrate instantaneous power inputs.

• Digital Output modules accept Boolean inputs, and output a continuous signal or 
pulses.

• Pulser modules convert instantaneous pulses to pulses or transitions.

Configure the settings of the controlling module to match your requirements. Ensure 
that the module’s Port setup register matches the meter’s output that you want to 
control. 

For detailed information and instructions on configuring these modules, see the ION 
Reference. For information on the default settings for the modules, see the ION Device 
Template Reference. 

WARNING
HAZARD OF UNINTENDED OPERATION
• Do not use the meter for critical control or protection applications where human 

or equipment safety relies on the operation of the control circuit.
• Be aware that an unexpected change of state of the digital outputs may result 

when the supply power to the meter is interrupted or after a meter firmware or 
template upgrade.

Failure to follow these instructions can result in death, serious injury or 
equipment damage.



Chapter 11 - Inputs / Outputs  ION8650 User Manual

148 7EN02-0306-03

The available settings for these modules are as follows:

Using the optional onboard digital inputs

Digital inputs are used for status monitoring or pulse counting applications. Status 
monitoring can help you prevent equipment damage, improve maintenance, or track 
security breaches. Common status monitoring applications include monitoring:

• closed/open positions of breakers.

• on/off status of generators.

• armed/unarmed conditions in a building alarm system.

• over/under pressures of transformers.

ION module Setup registers Available settings Description

Digital Output

Port

Not Used
WATT LED
VAR LED
I/O Exp FormC 1
I/O Exp FormC 2
I/O Exp FormC 3
I/O Exp FormC 4
I/O Exp FormA 1
I/O Exp FormA 2
I/O Exp FormA 3
I/O Exp FormA 4
On-Board Form C 1
On-Board Form C 2
On-Board Form C 3
On-Board Form C 4
On-Board FormA Out 1

Determines the output hardware channel

Pulse Width 0 to 2000000 Pulse Width, in seconds (0 for continuous pulse)

Polarity Fixed at NON-INVERTING Specifies a non-inverted (or level) pulse

EvLog Mode Log on or Log off Determines whether or not to log status changes in the 
Event Log

Pulser

Port As per Digital Output, above Determines the output hardware channel

PulseWidth 0.020 to 2000000 Pulse width, in seconds

OutputMode Pulse or KYZ Full pulse or KYZ (transition pulse)

Polarity Fixed at NON-INVERTING Specifies a non-inverted (or level) pulse

Calibration 
Pulser

Port As per Digital Output, above The output hardware channel

Pulse Width 0.010 to 1.000 Pulse Width, in seconds 

Kt 0.01 to 1000000000 Watts per pulse

Int Mode Forward, Reverse, Absolute, or Net Integration modes that can be selected

OutputMode Pulse or KYZ Full pulse or KYZ (transition pulse)
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The function of each status input is controlled by a Digital Input module; this module 
tells the meter how to interpret incoming signals. Digital Input modules can be linked 
with other modules for counting status changes.

For detailed information and instructions on configuring these modules, see the ION 
Reference. For information on the default settings for the modules, see the ION Device 
Template Reference. 

The available settings in the Digital Input modules are as follows:

Using the optional analog outputs

Analog outputs let you output real-time power to an RTU or perform equipment control 
operations. The analog outputs provide industry standard 0 to 20 mA current signals. 
These outputs are only available with the optional I/O Expander.
 

Four Analog Output modules control the optional I/O Expander’s analog outputs. These 
modules are not linked by default. Link the numeric output of another ION module to the 
Source input of the Analog Output module—this value is represented on the I/O 
Expander’s analog output port. Setup the Zero Scale and Full Scale setup registers of 
the Analog Output module to the numeric range you want to emulate. 

For detailed information and instructions on configuring these modules, see the ION 
Reference. For information on the default settings for the modules, see the ION Device 
Template Reference. 

NOTICE
VOLTAGES OVER 130 VDC CAN DAMAGE DIGITAL INPUTS
Do not use digital inputs for voltage sensing applications.

Failure to follow these instructions can result in equipment damage.

Setup register Available settings Description
Input Mode Pulse, KYZ Specifies complete pulse or KYZ transition pulse

EvLog Mode Log On, Log Off
Specifies whether or not to log status changes.
Digital Input status changes have an event priority of 20.

Debounce numeric Setting for the mechanical contact bounce, in seconds
Polarity Fixed at NON-INVERTING Specifies a non-inverted (or level) pulse

Port

I/O MODULE IN1 to I/O MODULE IN 8, NOT USED

I/O Exp In 1 to 8
On-Board FormA 1 to 3

Specifies which hardware port the module controls

WARNING
HAZARD OF UNINTENDED OPERATION
Do not use the meter for critical control or protection applications where human 
or equipment safety relies on the operation of the control circuit.
The electrical signal on the output is DC. Make sure proper polarity is observed 
when wiring external devices to the analog output ports.

Failure to follow these instructions can result in death, serious injury or 
equipment damage.
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The available settings in the Analog Output module is as follows:

Ensure that the module’s Port setup register matches the I/O Expander’s output that 
you want to control. If the port you want to use does not appear in the Port setup register 
list, that port is in use by another module. Edit the Port setup register of the module 
using that port and set it to NOT USED – the port is then available to other modules. 

See the I/O Expander Installation Guide for more information on the I/O Expander and 
the ION Reference for more information on the Analog Output module, including details 
are setting the zero and full scales. Both documents are available from www.schneider-
electric.com.

Configuring inputs and outputs

Use Power Monitoring Expert or ION Setup to configure the meter’s I/O framework.

Using the front panel
You cannot configure I/O using the meter’s front panel.

Using ION Setup
The Setup Assistant helps you configure your meter’s optional (onboard and I/O 
Expander) analog and digital inputs and outputs. 

NOTE: See “Energy pulsing” on page 153 for information on configuring the Calibration
Pulser modules in ION Setup.

In ION Setup:

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions. 

2. Select either the Onboard I/O or the Expander I/O folder and select the screen for 
the I/O type that you want to configure.

Setup registers Available settings Description

Port
I/O EXP AnOut 1 to
I/O EXP AnOut 4,
NOT USED

Specifies the output hardware channel.

Full Scale -1 x 109   to   1 x 109
Sets the measured value that will create the 
maximum possible output on the analog output 
hardware port.

Zero Scale -1 x 109   to   1 x 109
Sets the measured value that will create the 
minimum possible output on the analog output 
hardware port.
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The tabs on the I/O screens correspond to the associated modules (for example, 
Onboard I/O > Digital Outputs > A1 allows you to configure Digital Output module 
RA-1). Click the tab you want to edit.

3. Select the parameter and click Edit to edit a value.

4. Select Source and click Edit to link a module to a source. Navigate to the source 
register you require and click OK.

Using Designer
Open your meter in Designer and navigate to the Advanced Setup framework. Click on 
the appropriate grouping object (Digital Inputs, Digital Outputs or Analog I/O) and right-
click the module that you want to edit.
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Chapter 12 Energy pulsing
This chapter provides instructions for configuring energy pulsing on your meter.

In this chapter
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Introduction
Your meter uses Calibration Pulser modules and Pulser modules for energy pulsing.

• Pulser module: The Pulser module serves as an intermediary between other 
modules’ pulse output registers (accepting them as pulse inputs) and a hardware 
output channel on the device. These modules are capable of sending pulses or 
pulse transitions to any hardware output channel.

• Calibration Pulser module: The Calibration Pulser module is a highly accurate 
energy pulser used for verifying accuracy on meters employed in billing applications. 
This module type serves as an intermediary between the power (kW, kVAR or kVA) 
outputs of the Power Meter module and a device’s hardware output channel. Refer 
to the PowerLogic ION8650 accuracy verification technical note for instructions on 
verifying the accuracy of your meter. By default, two Calibration Pulser modules are 
configured and linked to the front panel LEDs.

See the ION Reference for more information on these modules.



7EN02-0306-03 155

ION8650 User Manual Chapter 12 - Energy pulsing 

Energy pulsing with LEDs
The two LEDs on the front panel are preconfigured for energy pulsing. The adjacent 
smaller infrared outputs are connected to the LEDs and pulse at the same rate.

The pulse rate of the LEDs can be adjusted by modifying the Kt setup register in the 
associated Calibration Pulser module. The value entered defines how much energy the 
module accumulates before a pulse is sent to the hardware channel. The front panel 
WATT and VAR LEDs are factory set to the same pulse rate. The Kt value is shown on 
your meter’s front panel label; the default setting for Kt depends on the form factor of 
your meter.

WATT – LED and VAR – LED

The WATT – LED is controlled by a Calibration Pulser module that has its Source input 
linked to the kW del+rec output of the Arithmetic module labeled “KW del, rec”. 

The VAR – LED is controlled by a Calibration Pulser module that has its Source input 
linked to the kVAR del+rec output of the Arithmetic module labeled “kVAR del, rec”. 

• For meters with 9S, 36S and 29S form factors, the default pulse rate of the front 
panel WATT LED is 1.8 (1.8 Watt-hours per pulse). The kt value of the VAR LED is 
also 1.8.

• For Form Factor 35S meters, the default pulse rate of the front panel WATT LED is 
set at 1.2 (1.2 Watt-hours per pulse). The Kt value for the VAR LED is also 1.2.

Customizing energy pulsing

Changing the value for the Kt setup register of the associated Calibration Pulser module 
lets you modify the pulsing rate of either channel. If you want to configure the LED port 
for a different pulsing application, you must re-link the Source input to the output 
register of a different instantaneous power quantity in one of the Arithmetic modules. 
Ensure that the quantity you select originates from the MU (meter units) Power Meter 
module.

Infrared pulsers

Kt value for the 
meter

LED pulse indicators
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Configuring energy pulsing
Use Power Monitoring Expert or ION Setup to change your meter’s energy pulsing 
settings.

Using the front panel
You cannot configure energy pulsing using the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions. 

2. Select LED Pulsing.

3. Click on the tab that corresponds to the LED that you want to configure.

4. Configure the settings as required. See “Calibration Pulser module settings” on 
page 157 for more information on the settings other than Pulser Mode.

Pulser Mode determines whether the LED pulsing occurs always or only when the 
meter is in TEST mode.

The appropriate Kt value depends on Scaled Rev Param (located on the Basic Setup 
tab). 

– If Scaled Rev Param is OFF, the Kt value must be the primary value and the 
Calibration Pulser module pulses based on primary kWh and kVARh

WARNING
HAZARD OF UNEXPECTED DIGITAL OUTPUT PULSE
• Do not use the meter for critical control or protection applications where human 

or equipment safety relies on the operation of the control circuit.
• Be aware that an unexpected pulse on the digital outputs can result when the 

supply power to the meter is interrupted or after a meter firmware or template 
upgrade.

Failure to follow these instructions can result in death, serious injury or 
equipment damage.
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– If Scaled Rev Param is ON, the Kt value must be the secondary value, and the 
Calibration Pulser module pulses based on secondary kWh and kVARh.

5. Select the Energy Pulsing screen to configure the other default Calibration Pulser 
modules for energy pulsing applications, if required. By default, these modules are 
not linked to an output.

6. Click the End of Interval tab to configure the end of energy pulsing.

Using Designer
Open your meter in Designer and navigate to the Energy Pulsing Setup folder. Right-
click a module to edit.

Calibration Pulser module settings

The setup registers available in the Calibration Pulser module are listed in the table 
below. The defaults listed are for the two pre-configured Calibration Pulser modules 
that control the front panel LEDs (these modules are labelled Wh Pulse LED and VARh 
Pulse LED).

1 The default Kt value varies depending on the template. For meters with the 9S/29S/36S template, the 
default is 1.8. For meters with the 35S template, the default is 1.2. 

Pulser module settings

Only the End of Interval Pulser module is available by default. The defaults below reflect 
the defaults in this module.

Setup register Function Default

Pulse Width
This register specifies the width of the pulses sent to the hardware 
channel (in seconds). The Calibration Pulser module maintains a 
minimum duty cycle of 50% on the output pulse train.

0.05

Kt

The numeric bounded register defines how much energy the 
module accumulates before a pulse is sent to the hardware 
channel. An industry standard for energy pulsing is 1.8, or one 
pulse per 1.8 energy-hours.

varies1

Int Mode Specifies the modes of integration that can be selected. Absolute

OutputMode This register specifies whether the output is a complete pulse 
(Pulse) or a change of state transition (KYZ). Pulse

Port
This register specifies which hardware port the pulse/KYZ transition 
appears on. Only those hardware channels that are still available 
appear in this list.

Not Used

Setup register Function Default

Pulse Width This register specifies the width of the pulses sent to the hardware 
channel (in seconds). 0.1

OutputMode This register specifies whether the output is a complete pulse 
(Pulse) or a change of state transition (KYZ). Pulse

Port This register specifies which hardware port the pulse/KYZ transition 
appears on. Not Used



Chapter 12 - Energy pulsing  ION8650 User Manual

158 7EN02-0306-03



7EN02-0306-03 159

Chapter 13 Logging
The ION8650 meter has powerful data logging and event recording capabilities. Data 
and event logs recorded by the meter are prioritized and stored onboard. Data is 
retrieved periodically by Power Monitoring Expert (or another third party application). 

If you use Power Monitoring Expert, all retrieved data from your system is stored in an 
ODBC-compliant database. The information in the database can be viewed and 
analyzed using Power Monitoring Expert components such as Vista (for viewing) or 
Web Reporter (for organizing and presenting data). 

In this chapter

Data logging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160
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Event logging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  168
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Logging and recording capacity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  170
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Data logging
The meter has a default, comprehensive data-logging configuration. Information 
regarding the default logging capacity and default logging configuration can be found in 
“Default logging capacity” on page 163.

To learn more about the Data Recorder modules in your meter, refer to the 
ION Reference.

Configuring data logging

Use Power Monitoring Expert or ION Setup to change your meter’s logging settings.

Using the front panel
You cannot configure logging using the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions. 

2. Select the Logging folder. 

Use the Memory, Load Profile and Event Log screens to configure your logging 
settings.

Memory screen

1. Select the Memory screen to re-allocate meter memory. 

2. Select the log you want to configure and click Edit. You can change both the Log 
Duration (days) and the Log Size (records). Changing these parameters affects the 
meter memory allocated to that log.

Load Profile screen

1. Select the Load Profile screen to configure the Revenue Log.
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2. Click the Channels tab to access the Revenue Log sources. Select a source. 

– Click Unlink to unlink the parameter from the source. 

– Click Edit to edit the parameter. The Parameter Selection dialog box appears, 
showing source register groupings. Click on the ‘+’ symbol beside the register 
group to view the individual registers. Select the register that you want to connect 
to the source and click OK.

Select the Show all available registers checkbox for a complete list of all 
possible registers.

3. Click the Interval/Depth tab to edit the Revenue Log interval and duration and 
missing record handling.

Events screen

1. Select the Event Log screen to configure what events are logged and the 
notification settings.

2. Click the Events tab, select a parameter and click Edit:

– Depth: This parameter sets the number of events the event log contains. 
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– Cutoff: This parameter determines the minimum priority level for events to be 
logged; events with a lower priority are not logged. 

– EvPriority: This parameter sets the event priority of Sag/Swell events. See 
“Configuring power quality event logging” on page 182 for more information.

– PhaseLossEnable: This parameter enables or disables phase loss event 
recording. 

3. Click the Notifications tab to configure the event log notification settings based on 
the number of unread entries. These settings allow you to define the designated 
reader and set a limit to the number of unread event log entries. Select a parameter 
and click Edit to change.

– Designated Reader: This parameter allows you to select a user to be the 
designated reader of the event log. An entry in the event log is designated unread 
until reviewed or backed up to external storage by the designated reader. This 
feature can assist in ensuring that event log entries are not overwritten before 
they can be reviewed.

– SMTP Server: This parameter displays the IP address of the SMTP Server. The 
value can only be displayed under this tab. Navigate to Communications > 
Advanced Ethernet> SMTP to change this setting. See “Configuring Ethernet 
connections” on page 93 for information on configuring network settings.

– Depth: This parameter displays the number of events the event log can contain. 
The value can only be displayed under this tab. Navigate to Logging > 
Event Log > Events to change this setting.

– Unread Events: This parameter displays the number of event log entries that 
have not been reviewed or backed up to external storage by the designated 
reader. When the designated reader reviews the event log, this value returns to 
zero. If any user other than the designated reader reviews the event log, the 
unread events value does not change. This value is not configurable.

Changing waveform recording
The Waveform Recorder modules do not require changes to their default settings. If you 
want to change the format of the recorded waveforms, refer to the Waveform Recorder 
module description in the ION Reference.

NOTE: If you are generating COMTRADE waveform data records, the associated
Waveform Recorder modules cannot be modified unless the COMTRADE module’s
Module Enable register is set to DISABLED. If the Waveform Recorder modules are not
configured identically (have the same setup register values) the COMTRADE module
will not go online.

The default logging framework

The following sections outline the default logging capacity and configuration.

NOTE: The default logging configuration may be used by other components of your
power monitoring system (for example, the reporting components of Power Monitoring
Expert). Before you change the default configuration of any of the logs, ensure you
understand the impact on the change on these components and the data they display.
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Default logging capacity
The following table summarizes the default recording depths and recording intervals of 
the various Data recorders and Waveform recorders in the meter.

1 See the COMTRADE and ION Technology technical note for more details.
2 See the Power Quality: ION Meters and EN50160 technical note for more details.
3 See the IEC 61000-4-30 Compliance and ION meters technical note for more details.

Changing the log depths
Change the value in a Data Recorder module’s Depth setup register to increase the 
number of records stored in the recorder. The RecordMode setup register controls how 
the Data Recorder overwrites old records; refer to the Data Recorder module 
description in the ION Reference before changing this setup register.

Changing the frequency of logging
The five Periodic Timer modules that control the frequency of different data recording 
are as follows:

• “Revenue Log Trg” controls the frequency of the logging of revenue values

• “Loss Log Trg” controls the frequency of Loss Compensation Data logging

• “EgyDmd Log Trg” controls the frequency of logging for the Energy and Demand 
Log (this log is used for generating reports using Web Reporter)

• “Hist Log Trg” controls the frequency of Historic Data logging

• “Harm Log Trg” controls the frequency of Harmonics logging

Log types ION8650A 
default depth

ION8650B 
default depth

ION8650C 
default depth Interval

Energy Logs
Revenue Log 9120 6240 3360 900 seconds
Loss Log 9120 6240 N/A 900 seconds
EgyDmd Log 9120 6240 N/A 900 seconds

Daily nominal log DailyNom Log 450 450 N/A Daily
Historic Logs Hist Logs 9120 6240 N/A 900 seconds
Harmonic Logs Harm Logs 2280 1560 N/A 3600
Disturbance Recorders Transient Log 3000 N/A N/A Triggered on demand

Sag/Swell Log 3000 3000 3000 Triggered on demand
SagSwellState Log 3000 3000 N/A Triggered on demand

COMTRADE1 1 N/A N/A Triggered by Waveform 
Recorder

EN50160 Logs (ION8650A 
and ION8650B only) 14 Data Recorders Varies2 Varies2 N/A Daily, weekly, 10 minutes...2

4-30 Logs (ION8650A and 
ION8650B only) 8 Data Recorders Varies3 Varies3 N/A 3 second, 10 minute, 2 hour
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Programming your meter to write to any data recorder at continuous intervals lower 
than 60 seconds (heavy logging configuration) can cause loss of data in the event of a 
power failure.

Change the value in the Period setup register to change the frequency of data logging 
(in seconds). Do not change the Sync Mode setup register.

Default logging configuration
The following sections describe each Data Recorder module and the parameters they 
log. Your meter may not have all of the logs described and the settings may vary 
depending on the meter, its firmware and its template.

Revenue logging

The Revenue Log is configured for use with UTS MV-90 billing software. The default 
values logged by the Revenue Log are as follows:

Historic data logging

Three data recorders are used to record standard power system quantities, such as 
phase current, phase voltage and power factor. By default, they log the following output 
register values:

Loss Log

One Loss Log recorder is configured to record loss values. By default, it logs the 
following parameters – note that the parameters differ depending on the meter 
template:

NOTICE
DATA LOSS
Use an uninterruptible power supply (UPS) if you program your meter for heavy 
logging.

Failure to follow these instructions can result in data loss.

Parameter Description
kWh del int Interval kWh delivered
kWh rec int Interval kWh received
kVARh del int Interval kVARh delivered
kVARh rec int Interval kVARh received

Hist Mean Log Hist High Log Hist Low Log
Vll ab mean I avg mean Vll ab high I avg high Vll ab low I avg low
Vll bc mean kW tot mean Vll bc high kW tot high Vll bc low kW tot low
Vll ca mean kVAR tot mean Vll ca high kVAR tot high Vll ca low kVAR tot low
Vll avg mean kVA tot mean Vll avg high kVA tot high Vll avg low kVA tot low
V unbal mean PF lag mean V unbal high PF lag high V unbal low PF lag low
Ia mean PF lead mean Ia high PF lead high Ia low PF lead low
Ib mean Freq mean Ib high Freq high Ib low Freq low
Ic mean Ic high Ic low

Template Loss Log parameter Description
All MU Ia^2h int Phase A interval current squared hours
All MU Ib^2h int Phase B interval current squared hours
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Harmonics logging

Two recorders provide various harmonics logs, including K-factor and Total Harmonics 
Distortion (THD). These recorders are labeled Harm Mean Log and Harm High Log. By 
default, they log the following values:

Energy Demand Log

One data recorder is configured to provide power system data for the Web Reporter 
component of Power Monitoring Expert. 

Sag/Swell and Transient logging

Three data recorders provide details of these power quality events. The Sag/Swell and 
Transient data recorders, by default, log the following values

All MU Ic^2h int Phase C interval current squared hours
35S only MU Vll ab^2h int Phase A interval voltage Line-to-Line squared hours
35S only MU Vll bc^2h int Phase B interval voltage Line-to-Line squared hours
35S only MU Vll ca^2h int Phase C interval voltage Line-to-Line squared hours
9S/29S/36S only MU Vln a^2h int Phase A interval voltage Line-to-Neutral squared hours
9S/29S/36S only MU Vln b^2h int Phase B interval voltage Line-to-Neutral squared hours
9S/29S/36S only MU Vln c^2h int Phase C interval voltage Line-to-Neutral squared hours

Harm Mean log Harm High log
V1 THD mean I1 K Fac mean V1 THD high I1 K Fac high
V2 THD mean I2 K Fac mean V2 THD high I2 K Fac high
V3 THD mean I3 K Fac mean V3 THD high I3 K Fac high
I1 THD mean  I1 THD high  
I2 THD mean  I2 THD high  
I3 THD mean  I3 THD high  

EgyDmd Log
kWh del kVAh del+rec
kWh rec kW sd del-rec
kWh del-rec kVAR sd del-rec
kVARh del kVA sd del+rec
kVARh rec PF lag mean
kVARh del-rec PF lead mean

Sag/Swell log (ION8650A and ION8650B)
DistDur DistV1Engy DistV2Engy DistV3Engy
DistV1Min DistV2Min DistV3Min DistNominal
DistV1Max DistV2Max DistV3Max SwellLim
DistV1Avg DistV2Avg DistV3Avg SagLim

Sag/Swell log (ION8650C)
DistDur DistV2Max PT Prim
DistV1Min DistV3Min PT Sec
DistV1Max DistV3Max CT Prim
DistV2Min DistNominal CT Sec
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The SagSwellState data recorder provides additional information required by the Sag/
Swell and Transient logs.

See “Configuring power quality event logging” on page 182 for enabling or disabling 
Sag/Swell and Transient events from being recorded in the Event Log.

NOTE: Modification of the Sag/Swell, Transient and SagSwellState logs is an
advanced procedure that should only be performed by experienced users familiar with
ION and the interaction of these data recorders.

See the COMTRADE and ION Technology technical note for information about 
COMTRADE records.

EN50160 compliance logging (ION8650A and ION8650B only)

By default, 14 Data Recorder modules are used for logging EN50160 compliance 
parameters.

The meter logs EN50160 counter data for present and previous observation periods as 
well as EN50160 events. Enable or disable EN50160 Parameter Logging via the default 
Power Quality diagram in the Vista component of Power Monitoring Expert.

For more information about EN50160 data logging, see the Power Quality: ION Meters 
and EN50160 technical note.

IEC 61000-4-30 logging (ION8650A and ION8650B only)

Eight data recorders are used to log parameters related to 4-30 compliance and to 
create reports.

Transient log
TranV1Dur TranV2Max TranNominal PT Sec
TranV1Max TranV3Dur Threshold CT Prim
TranV2Dur TranV3Max PT Prim CT Sec

Data Recorder EN50160 component logged Data Recorder EN50160 component logged
EN50160 Frq/Mg Power Frequency and Supply Magnitude EN50160 Hrm Vlt

Voltage Harmonics
EN50160 Flicker Flicker EN50160 Ihm Vlt
EN50160 Vlt Dp1

Supply Voltage Dips
EN50160 MSignal Mains Signaling Voltage

EN50160 Vlt Dp2 EN50160 Prm-f/V

Parameter data
EN50160 Intrp Short/Long Interruptions EN50160 Prm-Flk
EN50160 Swell Temporary Overvoltages EN50160 PrmHrm1
EN50160 Vunbal Voltage Unbalance EN50160 PrmHrm2

Data Recorder 4-30 parameters logged

4-30 3s THD Log
4-30 3s RMS Log
4-30 10mRMS Log
4-30 10mTHD Log
4-30 2hTHD Log
4-30 2hRMS Log
4-30 10s Freq
4-30 Intrp Log (disabled by 
default)

– Voltage Disturbances
– V1-RMS (Root-Mean-Square)
– V2-RMS
– V3-RMS
– THD (Total Harmonic Distortion)
– Vneg/Vpos
– Vzero/Vpos
– V-Overdeviation
– V-Underdeviation
– Frequency
– Flicker (only available on A feature set)
– Unbalance
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For more information on 4-30 compliance, see the IEC 61000-4-30 Compliance and 
ION meters technical note.

Viewing data log information

Viewing data in ION Setup

In ION Setup: 

1. Select your meter.

2. Select View > Data Screens > Data Recorders. The following logs are available 
for viewing, depending on your meter:

– Average Harmonics

– Energy & Demand

– Historic Average, Historic Highs, Historic Lows

– Maximum Harmonics

– Revenue Log

– Sags & Swells

– Transformer Losses

– Transients (ION8650A only)

See “Reports” on page 215 for information on running basic reports in ION Setup.

Viewing data in Power Monitoring Expert

You can view information from the data logs in the Vista, WebReach and Web Reporter 
components of Power Monitoring Expert. See the online Power Monitoring Expert Help 
for more information.
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Event logging
Events produced by the meter’s various ION modules are prioritized and grouped to 
facilitate custom logging. Each event is assigned a priority group number based on its 
type and severity.

Event priority groups
Some event groups are preset with a priority number as shown in the table below. You 
can also define your own priority number for some modules. Priority numbers from 128-
191 appear in the global event log viewer in the Vista component of Power Monitoring 
Expert. Priority numbers from 192-255 are also logged, initiate a beep and cause the 
window to flash. You can customize these responses to display messages or perform 
netsend messages, for example.

The Event Log Controller module allows you to set a priority cutoff for event logging. 
Any events with a priority number greater than the cutoff value are logged, and events 
with lower priorities are discarded. Refer to the individual module descriptions and the 
Event Log Controller module description in the ION Reference for more details.

Events external to the module
Some events are not produced by a specific module. These events are generated 
internally by the meter. Their associated priority levels are shown in the table below.

User triggered events
When a user produces an event, such as a reset, successful or unsuccessful login 
attempts, user lockout or setup change, the event log displays the username 
associated with the event. Events created in basic security through the front panel have 
the username USER0. Events created in advanced security through the front panel or 

Event group Description Priority number
Reset Module reset or re-synchronized 5
Setup Change Module setup changes (setup register changes, label changes, input handle changes) 10
Input Register Change Inputs of certain modules change value (for example, input to And/Or module changes) 15
I/O State Change I/O state changes (for example, relay closes) 20
Information Module produces important user information 25
Warning Module produces a warning 30
EN50160 Event (ION8650A 
and ION8650B only)

An EN50160 counter (N1 or N2) increases 50

Loss of Potential Loss of Potential has occurred 128
Error Detected An error has been detected 255

Setpoint Setpoint condition goes Active or Inactive (for example, Sag/Swell module detects a 
disturbance)

programmable via 
module setup 

Event group Description Priority number

Warning

Factory initialize performed

30

Firmware or memory upgrade performed
Meter power-up or power-down
Internal modem not responding or modem recovered
Battery low
Telnet or serial terminal locked out
Security disabled or enabled

Failure Communications not able to allocate required memory 255
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ION Setup are associated with the username that was logged into the meter (USER1 - 
USER50).

Displaying events

View events in the following locations:

Application Menu / screen Navigation
Front Panel Event Log ALT display mode
ION Setup Event Log Setup Assistant > Reports > Event Log
Vista Meter Events Volts/Amps tab > Meter events object
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Logging and recording capacity
The meter provides both data and event logs. The amount of memory required to store 
these logs depends on the number of parameters being logged and the frequency with 
which these parameters are logged. 

The following equation can help determine the amount of memory required to store 
data and event logs:

The meter can also perform waveform recording. To calculate the waveform memory 
usage use the following formula:

NOTE: Round up to the nearest kilobyte after each of the above calculations.

In ION Setup, the Memory tab in the Logging folder of the Setup Assistant displays the 
memory allocated to each log and the meter’s total in-use and available logging 
memory.

each record consumes (in Bytes) = [(number of parameters * 5) + 8]

waveform memory usage (in Bytes) = [2*(number of samples per cycle) + 10]* 
(number of cycles in waveform) + 30
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Chapter 14 Revenue
This chapter provides instructions for configuring PT/CT correction, transformer line 
loss compensation and time of use.

In this chapter
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PT/CT correction
The primary application for PT/CT correction is to apply correction factors for ratio 
errors and phase angle errors to instrument transformers. Instrument transformer 
correction reduces or eliminates the need to replace transformers in installations where 
high accuracy is required.

PT/CT correction is done using the Instrument Transformer Correction (Instr Xformer) 
module. There is an ITC module for each current input (I1, I2, I3) and for each voltage 
input (V1, V2, V3) to the meter. Note that the correction affects only the 1-second 
values in the Power Meter module. No high-speed, harmonics, or waveform values are 
affected by the correction. For more information, see the ITC (Instr Xformer) module 
description in the ION Reference.

Configuring PT/CT correction

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Revenue > PT/CT Correction.

3. Select Active Correction on the ITC Correction tab then click Edit. The Transformer 
Correction Setup wizard appears. 
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4. Select the checkbox beside the Voltage Inputs or Current Inputs and click Next. 
The first correction screen appears. 

5. Select a test point and click Edit to edit the test points. Click OK to return to the 
correction wizard then click Next to move to the next correction screen. Go through 
all the correction screens then click Finish.

NOTE:  You can select a maximum of eight (8) test points. 

6. Select Active Correction on the ITC Correction tab and click Analyze to access 
screens where you can input your wiring configuration and power system information.
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Transformer Line Loss Compensation
Transformer Loss Compensation (TLC) is used when a meter’s actual location is 
different from the electrical location where change of ownership occurs; for example, 
where meters are connected on the low-voltage side of power transformers when the 
ownership change occurs on the high-side of the transformer. This physical separation 
between meter and actual billing point results in measurable losses. Compensating for 
this loss - Loss Compensation - is the means of correcting this meter reading. Losses 
may be added to or subtracted from the meter registration.

Meters are usually installed on the low-voltage side of a transformer because it is more 
cost-effective. There are also cases where change of ownership can occur halfway 
along a transmission line where it is impractical to install a meter. In this case, power 
metering must again be compensated. 

NOTE: Due to the variation in installations, advanced knowledge of power systems
and connection methods is required before transformer loss compensation can
be properly implemented. Data parameters should only be programmed by qualified
personnel that have appropriate training and experience with Transformer Loss
Compensation calculations.

For more information, see the Transformer Line Loss Calculations technical note.

Configuring TLC

Use Power Monitoring Expert or ION Setup to change your meter’s TLC settings.

Using the front panel
You cannot configure Transformer Line Loss Compensation using the front panel.

Using ION Setup
The Transformer Loss screen allows you to enable/disable TLC, choose which method 
you prefer (1 or 2) and configure TLC settings.

In ION Setup:

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions. 

2. Select Revenue > Transformer Loss. Click the Method Selection tab.

3. Select Loss Comp Enble to enable TLC, then click Edit.
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4. Select Comp Enabled from the dropdown list and click OK.

5. Select Comp Mthod Slct and click Edit to choose the TLC method you want to 
use. Select Method 1 to use the Test Sheet method and Method 2 to use the %Loss 
Constants method.

Click OK. 

6. Click the tab of the TLC method you chose in the previous step and configure the 
settings for that method.

Using Vista
1. Open your meter in Vista.

2. Click the Revenue tab.

3. Click the Loss Compensation object. The Loss Compensation window appears:

4. Configure your values as required. 

See the Transformer Line Loss Calculations technical note for more details on this 
feature.

Click here to enable 
Loss Compensation 
calculations.

Choose either the Test 
Sheet or %Loss Constants 
compensation method.

These are the true instrument 
transformer ratios. Normally 
they coincide with the Power 
Meter module’s setup.
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Time of Use
The Time of Use module may only be important if you are using the meter in a billing 
application (for example, you are a power provider), as the module contains the meter’s 
seasonal rate schedules. Typically, power consumers do not require Time Of Use 
configuration.

See the ION Reference for more information on the Time of Use module.

Configuring Time of Use

Use Power Monitoring Expert or ION Setup to change your meter’s Time of Use 
settings.

Using the front panel
You cannot configure Time of Use using the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions

2. Select Revenue > Time of Use.

3. Select a Time of Use program from the list (for example, Sample TOU) and click 
Edit.

4. Follow the Time of Use Wizard to configure your program. Click Send to save the 
TOU program on your meter.

Time Of Use settings

The Time of Use module’s setup registers define your seasons’ start and end dates, the 
day types where your rates differ, and the rate schedules for each season’s day types. 
The module compares the meter’s internal clock with the season, day, and time of day 
settings in these registers and changes its output registers to reflect the current state of 
these settings.

Seasonal settings
The Time of Use module supports up to four separate seasons. Each seasons’ start 
and end dates are set into the appropriate Season setup register.
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NOTE: Ensure that there is no date overlapping when defining seasons and that every
day of the year is covered by your seasons. If there are gaps between seasons, the
module returns an exception message and will not function.

If your rates do not change between seasons, you do not need to configure the Season 
setup registers — by default, all Season 1 rates are in effect all year.

If you have different seasons, enter their start and end dates into the appropriate setup 
registers. If your season is active on the same dates every year, you only need to enter 
a single range of dates in the appropriate Season setup register. If the active dates are 
different each year (for example, Season 3 becomes active every first Monday in 
August), the start dates must be individually specified for each year.

NOTE: Changes to the TOU seasons are noted in the meter’s event log.

Time of Use module settings
The Time of Use module is partially configured at the factory. Check the setup registers 
to ensure that the settings match your Time of Use schedules.

Displaying Time of Use

View Time of Use values in the following locations:

Setup register Function

Season 1- 4 These setup registers define the dates for each active season. When a season is active, the Time of Use module 
uses the applicable rate schedules.

Season 1 - 4
Weekday Rates These setup registers specify seasonal weekday rates.

Season 1 - 4
Weekend Rates These setup registers specify seasonal weekend rates.

Season 1 - 4
Alt 1 Rates These setup registers specify a season's daily rates during the days specified in the Alt 1 Days setup register.

Season 1 - 4
Alt 2 Rates These setup registers specify a season's daily rates during the days specified in the Alt 2 Days setup register.

Season 1 - 4
Holiday Rates These setup registers specify a season's daily rates during the days specified in the Holidays setup register.

Weekdays This register defines the days of the week for all seasons. The rates in the Season (1, 2, 3, or 4) Weekday Rates 
setup registers are used on these days.

Weekends This register defines the weekend days for all seasons. The rates in the Season (1, 2, 3, or 4) Weekend Rates 
setup registers are used on these days.

Alt 1 Days This register defines a set of alternative dates for all seasons. These dates generally have different rates from 
weekdays, weekends, or holidays.

Alt 2 Days This register is similar in function to Alt 1 Days, but contains a different set of dates.

Holidays This register defines the holidays for all seasons. The rates defined in the Season (1, 2, 3, or 4) Holiday Rates 
setup registers are used on these days.

Self Read Days This setup register defines the dates and times that the Self Read output register pulses. If no time is entered in this 
register, the Self Read output register pulses on the date specified at 12:00 AM.

Application Menu Navigation

Front Panel Active TOU Rate and Active TOU 
Season screens ALT Display mode

Vista Time of Use Screen Revenue tab > Time of use object
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Chapter 15 Power quality
This chapter explains how to configure your meter’s power quality functionality.

NOTE: To help ensure meter accuracy:
Your meter must have adequate power; for power quality applications with inadequate
line power, an auxiliary power supply for the meter is recommended. 
Your meter must have a properly connected protective earth ground since insufficient
earth grounding of the meter can adversely affect meter accuracy.

In this chapter
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Power quality configuration
Power quality configuration is provided by a number of modules and frameworks, 
depending on your meter type, such as the Sag/Swell module, the Transient module, 
the Mains Signalling Evaluation module, and the IEC 61000-4-30 framework, among 
others.

See the ION Reference for more information on these modules.

For a description of the scaled operational values (SOV) feature and the alternate 
scaling registers on the Power Quality page in the Vista component of Power 
Monitoring Expert, refer to “Scaled operational values” on page 79.

Configuring power quality settings

Use Power Monitoring Expert or ION Setup to change your meter’s power quality 
settings.

NOTE: The Sag/Swell module’s Nom Volts setting is used by the Transient module, as
well as in other power quality features such as EN50160 and 4-30 calculations. You
must set this register to enable these power quality features. If the Sag/Swell module’s
Nom Volts setup register is set to zero, these functions are disabled. Nom Volts is
typically set when the meter is put into service. If Nom Volts has not been set, enter a
value for your system’s nominal voltage (i.e., 120, 277, or 347).

Using the front panel
You cannot configure power quality from the front panel.

Using ION Setup
NOTE: COMTRADE must be DISABLED in order to configure Sag/Swell or Transients. 

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select the Power Quality > Sag/Swell.

3. Select a setting and then click Edit. Configure the settings as required.

NOTE: The Sag/Swell module’s Nom Volts setting is used by the Transient module, as
well as in other power quality features such as EN50160 and 4-30 calculations. All
power quality functions are disabled if the nominal voltage is set to 0 (zero).

4. Click the Transient tab to set the voltage deviation threshold, set the transient 
waveform recorder depth and frequency, enable COMTRADE waveform records 
and set other transient settings.

NOTE: The ION8650A features dual waveform capture: Sags are recorded at 32
samples x 54 cycles. Transients waveform capture at 512 samples x 4 cycles.

5. Re-enable COMTRADE, if necessary.

Using Designer
Open your meter in Designer and navigate to the Power Quality folder. Right-click a 
module to edit.

Sag/Swell module settings
The Sag/Swell module monitors voltage waveforms for sags and swells (i.e., 
ITI [CBEMA] Type 2 and Type 3 disturbances). It then reports each disturbance’s 
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magnitude and duration. The Sag/Swell module can also detect sub-disturbances 
during a Sag/Swell event. Settings are as follows:
 

1 The primary power system voltage is sometimes different than the PT Primary setup register value (for 
example, when the PT Primary is used to indicate winding ratio rather than primary voltage).

You also need to set the EvPriority register value if you want Sag/Swell events to be 
recorded in the Event Log. To enable Sag/Swell events, the EvPriority value must be 
greater than the Event Log Controller module’s Cutoff value (the recommended Sag/
Swell EvPriority value is 200). To disable Sag/Swell events so they are not recorded in 
the Event Log, set EvPriority to 0 (zero).

You can change Swell Lim and Sag Lim, but most applications are served by the default 
values entered into these registers. The Change Crit setup register does not need to be 
changed for normal operation.

Transient module settings (ION8650A only)
The Transient module monitors voltage waveforms for transient activity (i.e. 
ITI [CBEMA] Type 1 disturbances). The Threshold setup register defines what voltage 
disturbance magnitude is considered as transient activity. Threshold is interpreted as a 
percentage of the nominal system voltage, plus 100. For example, if you want 
transients recorded when voltage deviates from nominal by 20%, enter 120 into the 
Threshold setup register.

1 By default, Transient events are not recorded in the Event Log.

You also need to set the EvPriority register value if you want Transient events to be 
recorded in the Event Log. To enable Transient events, the EvPriority value must be 
greater than the Event Log Controller module’s Cutoff value (the recommended 
Transient EvPriority value is 200). To disable Transient events so they are not recorded 
in the Event Log, set EvPriority to 0 (zero).

Setup register Function Default

Swell Lim This is the magnitude above which a voltage deviation is considered a 
swell. 110

Sag Lim This is the magnitude below which a voltage deviation is considered a 
sag. 90

Change Crit This is the amount a voltage signal must change during a disturbance 
to be considered a new sub-disturbance. 10

Nom Volts1
This is the nominal power system voltage (used for all power quality 
functions). Set Nom Volts to 0 (zero) to disable power quality 
monitoring.

0

Hysteresis

This is the difference in magnitude between the start and end limits for 
a Sag/Swell. For example, if the sag limit is set to 90% and the 
hysteresis is set to 2%, the voltage needs to reach 92% before the sag 
is considered over.

2

EvPriority The priority assigned to Sag/Swell module events 
(0 to 255, 255 is highest). 0

Setup register Function Default

Threshold This is the magnitude at which a voltage deviation is considered a 
transient. 125

EvPriority1 The priority assigned Transient module events 
(0 to 255, 255 is highest). 0
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Configuring power quality event logging

Use Power Monitoring Expert or ION Setup to change your meter’s power quality event 
log settings. 

NOTE: By default, Power Quality events are not included in the Event Log.

Using the front panel
You cannot configure Power Quality event logging from the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Logging > Event Log. 

3. Select Sag/Swell Event Priority (SS1 EvPriority) or Transient Event Priority (TR1 
EvPriority) on the Event tab and click Edit.

– To stop Sag/Swell or Transient events from being recorded in the Event Log, set 
event priority to zero (0).

– To include Sag/Swell or Transient events in the Event Log, the event priority must 
be greater than the Event Log Cutoff (EL1 Cutoff) value. The recommended 
EvPriority value for enabling event logging is 200.

Using Designer
Open your meter in Designer and navigate to the Power Quality Setup Framework. 
Right-click the Sag/Swell or Transient module to edit.

Power quality standards compliance

The ION8650 has additional frameworks and settings related to the power quality 
standards below.

EN50160 settings (ION8650A and ION8650B)
The EN50160 framework is composed of numerous ION modules including: Mains 
Signaling Evaluation, Harmonics Evaluation, Voltage Harmonics, Flicker, and more.

NOTE: To avoid missing data in your EN50160 reports, use a meter with an auxiliary
power option connected to a UPS (Uninterruptible Power Supply) so that the EN50160
framework continues to operate during power outage situations.
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See “EN50160 compliance logging (ION8650A and ION8650B only)” on page 166 for 
information on EN50160 parameter logging.

See the Power Quality: ION Meters and EN50160 technical note for details.

4-30 settings (ION8650A and ION8650B only)
IEC 61000-4-30 power quality standard compliance is provided by a variety of ION 
modules including: Power Quality Aggregator, Harmonics Measurement, Disturbance 
Analyzer, Symmetrical Components, Mains Signaling Evaluation, Sag/Swell and more.

See the IEC 61000-4-30 Compliance and ION Meters technical note for details.

COMTRADE settings (ION8650A only)
The meter can provide waveforms in COMmon format for TRAnsient Data Exchange 
(COMTRADE) format. COMTRADE records are created from the existing Waveform 
Recorder modules, which are connected to the COMTRADE module.

See the COMTRADE and ION Technology technical note for details.

Disturbance Direction Detection

Your meter has disturbance direction detection capabilities to help you determine the 
location of a power system disturbance. When a disturbance occurs, the meter 
analyzes the disturbance information to determine the direction of the disturbance 
relative to the meter. This analysis includes a confidence level indicating the level of 
certainty that the disturbance is in the determined direction, and is stored in your 
meter’s event log.

Disturbance direction detection can help locate the source of a disturbance when used 
in a system of disturbance direction detection devices, as shown in the diagram below.

The arrows show the direction the meters have determined for the disturbance. With 
this information, you can focus on the section between meter #1 and meter #2 to find 
the cause of the disturbance.

A Disturbance location

B Meter #1 reports downstream disturbance

C Meter #2 reports upstream disturbance

D Meters report upstream disturbance

E Meter reports downstream disturbance

Utility

Meter #1

Meter #2

Power consumer

A

B

C

D

E
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NOTE: The disturbance direction detection feature is only available on the ION8650A
and ION8650B meter models.

Viewing disturbance direction detection events
The results of the disturbance direction detection algorithm appear in the meter’s event 
log. The image below shows an example of how the Disturbance Direction Detection 
event appears in your meter’s event log when viewed using ION Setup.

NOTE: You can view your meter’s event log through the display, ION Setup or using
the meter’s webpages.

Related topics
• See the ION Reference for more detailed information about the Disturbance 

Direction Detection module.
• See “Event logging” on page 168 for more information about your meter’s event 

log.
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Chapter 16 Displays
This chapter explains the available front panel displays. It also includes procedures for 
customizing displays using Power Monitoring Expert or ION Setup.

In this chapter
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Introduction
The meter ships with preconfigured front panel display screens designed to suit the 
data needs of most users. Different types of screens are available depending on the 
meter’s current mode of operation (see “Modes of operation” on page 27 for details).

Front panel displays can also be customized on your meter to show virtually any 
measurement or calculation. For example, you can:

• change displayed parameters, such as from Vll to Vln or Vllab to Vlna

• adjust character size to be different on each screen

• change data display settings such as backlight timeout, automatic display scrolling, 
parameter update rate, display mode and display units.
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Configuring front panel displays
Using the front panel
You cannot configure displays from the front panel.

Using ION Setup
The following sections explain how to add or edit a display screen, and how to set up 
scaling for a display.

Adding or editing a display screen

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select the Displays screen.

3. Select Displays on the Front Panel tab and click Edit.

ION Setup uploads your meter’s display information to the Display Editor. This can 
take a few moments.

4. Edit, rename, delete or rearrange displays as needed. 

5. Click New to add a new display or click Edit to change an existing display. The 
Display Setup wizard appears. There are three basic steps for creating or editing 
display screens. 
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– Select a Screen Type: Choose the screen type you want from the dropdown list.

– Select Parameters: Link or unlink the parameters available for your chosen 
screen type. Assign your preferred display units (if required); see “Considerations 
when assigning display units” on page 188 for considerations and examples of 
display unit scaling.

– Select Digit Display Properties: Select your display qualities, including digit 
resolution and truncated or rounded last digits.

6. Click Send to save the changes in the meter.

Considerations when assigning display units

NOTE: If you want to scale all front panel values by the same scaling factor, you do not
need to assign display units to individual parameters. Instead configure the display
scaling settings under the DISPLAY SETUP menu on the front panel; see “DISPLAY
SETUP menu” on page 37. You can also configure the display scaling settings by
accessing the Display Options module; see the ION Reference for more information. 

For most values, the meter determines and displays the correct units for the source 
measurement, and automatically scales displayed values for readability. If these units 
meet your needs, you do not need to configure display unit scaling. Assigning display 
units allows you to: 1) override the default units and force a certain scaling or 2) to 
display units when the meter cannot determine the correct units (for example, when the 
source is an output from an Arithmetic module).

For the purposes of the display units, the source parameter is assumed to be in the 
base units of the Power Meter module (in other words, V, A, kW, etc.). If the source 
parameter is not in the base units of the Power Meter module, the parameter may be 
scaled incorrectly or display incorrect units.

NOTE: You can only assign display units to One, Two, Three and Four Parameter
screens and One, Two and Three Parameter with Timestamp screens.

The available units are:

– Default – V, kV, MV – A, kA, MA – kw, MW, GW
– kVAR, MVAR, 

GVAR
– kVA, MVA, GVA – Vh, kVh, MVh – Ah, kAh, MAh
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1 Power factor related units will not scale or change based on the input value. They are always assumed to 
be coming from a lagging source or a leading source.

The following example illustrates display unit scaling on a three parameter screen, 
including the case when the parameter is not in the base units from the Power Meter 
module. In the example, the kW tot value from the Power Meter module is 10000.

• Parameter 1 = kW tot directly from the Power Meter module

• Parameter 2 = kW tot from an Arithmetic module that has divided the Power Meter 
module value by 1000, converting it to MW. 

• Parameter 3 = kW tot from an Arithmetic module that does not scale the value from 
the Power Meter module.

Using Designer
NOTE: Before you reconfigure or delete a framework, it is recommended that you make
a copy. This ensures that you can restore the framework, if necessary, without having
to reinitialize the factory configuration.

To remove a data display screen

1. Open your meter in Designer.

2. Select the Display module responsible for the screen.

3. Press DELETE. This also deletes all links to that particular Display module.

If the display screen you are deleting is part of the automatic scrolling cycle, you must 
reconfigure the links from the Scroll module’s Trigger outputs to the remaining Display 
modules so that the following considerations hold true:

• The first Display module in the scrolling cycle is linked to the Trigger 1 output of the 
Scroll module.

• The last Display module in the scrolling cycle (module n) is linked to the Trigger n 
output of the Scroll module. For example, if your scrolling cycle consists of 5 
screens, Trigger 5 should be linked to the fifth module in the cycle.

• The Wraparound setup register of the Scroll module designates the last trigger 
output (Trigger n). Expanding on the previous example, since Trigger 5 is the last 
trigger, the Scroll module’s Wraparound setup register would have a value of 5.

To add a new display screen

1. Create a Display module.

– kWh, MWh, GWh – kVARh, MVARh, 
GVARh

– kVAh, MVAh, GVAh – LD/LG1

– IND/CAP1 – Hz – % – Blank

Configuration Displayed value Notes

Default
Parameter 1 = 10000 kW
Parameter 2 = 10
Parameter 3 = 10000

Parameter 2 and 3 do not display units because they 
come from Arithmetic modules

kW
Parameter 1 = 10000 kW
Parameter 2 = 10 kW
Parameter 3 = 10000 kW

Parameter 2 and 3 do not change since they are 
assumed to be in the base units of the Power Meter 
module. However, parameter 2 is shown as 10 kW 
when it has already been scaled to 10 MW.

MW
Parameter 1 = 10 MW
Parameter 2 = 0.01 MW
Parameter 3 = 10 MW

All three parameters are scaled. However, 
parameter 2 has been scaled twice. 
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2. Define the modules characteristics (display format) by adjusting its setup registers.

3. Link any required data to the Source inputs of the Display module.

If you want your new screen to appear in the automatic scrolling cycle, you must link 
the Show input of the Display module to a Trigger output of a Scroll module. 

To create a Disk Simulator screen

1. Create a new Display module and set the type as Disk Simulator.

2. Connect the new Display module’s first input to the Calibration Pulser module’s 
Disk Position output that you want to monitor for its pulsing interval.

3. To include the newly added screen to the ALT screen list, connect the Display 
module’s Show1 and Show2 inputs to the Scroll module’s last available Trigger 
outputs in ALT SCROLL UP and ALT SCROLL DOWN (respectively).

You can determine the last available Trigger by right-clicking on the output to 
discover the Triggers’ owners.

4. Increase the Scroll module’s Wraparound setup register by 1 to include the new 
screen.

5. Configure the remaining display settings according to your needs.

Although the Disk Simulator display is intended to show the disk behavior of mechanical 
watt-hour meters, this feature can be used to monitor any accumulated meter quantity 
over the time. To do this, connect the Display module’s first input to the meter quantity 
and connect the second input to the maximum value that you expect the displayed 
quantity to be bounded by (this can be any output register or an External Numeric 
module register). In a case where the Display module is not connected to a Calibration 
Pulser module, the Disk Simulator revolves from left to right.

If the associated Calibration Pulser module is set for NET accumulation, and a negative 
value is accumulated and sent to the Disk Simulator display, the negative number on 
the display will be a negative accumulation, but the display disk will still go from left to 
right (forwards). To make the display disk go from right to left (backwards), set the 
associated Calibration Pulser module’s Int Mode register to reverse.

NOTE: The inputs to the Disk Simulator display are always positive. If the value
exceeds the maximum scale value assigned in the second input, nothing is displayed
except labels and the disk rectangle.

To configure leading zeros

The leading zeros and decimal point in a numeric display can be configured with the 
Display module setup register Screen Resolution. For example, the number 276.3443 
can be configured in one of the following ways, depending on the selection you make 
in the Screen Resolution setup register:

If the Screen Resolution setup register is set to DEFAULT, the Display module uses the 
resolutions defined in the Display Options module.

Value Screen resolution

276.3443 1.x = 276.3
1234.xx = 0276.34
123456. = 000276.
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Last digit mode

The Display module setup register Last Digit Mode lets you specify whether to truncate 
or round a value’s last digit. Numbers round up at 5 or greater and round down from 1 
to 4. A truncated value disposes of any digits after the number of decimal places that 
you specified in the Screen Resolution setup register. 

To configure parameter titles

The parameter value on a display screen is the value of an output connected to the 
Display module Source input register. By default, the displayed parameter’s title is the 
name of the output connected to the Source input. The Display module Source Title 
setup register lets you change the default to a title that better describes your system. 
For example, if “KWh Net” is linked to the first Source input, you can change its display 
name by setting Source 1 Title to “KWh Net West”. A maximum of 25 characters is 
permitted.

See “Changing TEST mode timeout” on page 201 for information on configuring TEST 
mode display timeouts.

Screen resolution = 1.xxx 

Value = 276.35192
Rounded = 276.352
Truncated = 276.351
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Default front panel display screens
Each mode of operation (NORM, ALT and TEST) has its own display screens, providing 
various power system data and meter properties screens. 

NORM mode display screens
The meter comes factory-configured with the NORM mode displays detailed below. If 
the settings in the Scroll module have not been altered, each screen is displayed for 
five seconds (if no front panel buttons are pressed). 

Display scrolling is suspended when a front panel button is pressed, allowing you to 
manually scroll through the display screens using the up or down arrow buttons. If 
required, refer to “Front panel features” on page 22 for more instructions on using the 
front panel buttons.

• kWh: This screen displays kWh delivered and received values.

• kVARh: This screen displays kVARh delivered and received values.

• kVAh: This screen displays kVAh delivered and received values.

• Peak Demand Delivered: This screen displays the maximum delivered kW, kVAR, 
kVA values and a timestamp of when the peak occurred. These values are sliding 
window (rolling block) demand calculations.

• Peak Demand Reset Count: This screen displays a count of the number of demand 
resets executed as well as a timestamp of the latest peak demand reset.

• Q Metering: This screen displays approximated VARh measurements, one phase 
(60 degrees) behind the normal watthour connection (90° - 330° and 150° - 270°).

• Disk Simulator: This display simulates the behavior of a mechanical watt-hour meter 
indicating power received or delivered by the direction of the pulse.

• All Segments: This is a screen test where a black screen showing all segments (all 
pixels on) indicates that the display is functioning properly.

ALT mode default display screens
The meter comes factory-configured with the ALT mode displays detailed below. If the 
settings in the Scroll module have not been altered, each screen is displayed for five 
seconds if no front panel buttons are pressed (until five minutes have elapsed).

Viewing ALT display modes

1. Press the Alt/Enter button once to toggle between the NORM and ALT display 
modes.

2. Press the up or down arrow buttons to scroll back or forth through the displays.

If no buttons are pressed, the meter reverts back to NORM mode after five minutes.

NOTE: These screens vary depending on the firmware version on the meter and
custom display configuration.

• Name Plate 1: The Name Plate 1 screen contains information on owner, TAG1, 
TAG2, battery life, and firmware version and feature set of the meter. 
TAG1 and TAG2 typically identify the meter’s user and installed location. The 
Owner and TAG registers are located in the Factory module and are configurable 
with Power Monitoring Expert or ION Setup. See “How to TAG your meter” on 
page 40.
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• Name Plate 2: This screen displays the following information for the current sliding 
window (rolling block) demand settings:

1 The MAX (kW) value is a maximum allowable demand level based on installed transformer configurations 
and nominal voltages and currents.

• Event Log: The Event Log screen displays up to four of the most recent, high priority 
events (priority 255 only). The date, a timestamp, an event description, and an event 
code are provided for each event displayed. If more than four high priority events 
have been recorded, the Event Log screen indicates additional logs exist. Refer to 
“Data logging” on page 160 for more details.

• Phasor Diagram: This screen shows phasors and numeric values for each phase 
current and phase voltage measurement. 

• Instantaneous Voltage: This screen shows the phase voltage and average voltage 
(line-to-neutral or line-to-line voltage, depending on the meter’s service type).

• Instantaneous Current: This screen shows the phase current and average current 
values.

• Instantaneous Power: This screen shows kW total, kVAR total, kVA total and signed 
Power Factor total values.

• Instantaneous Demand: This screen shows kW delivered and received from the 
sliding window (rolling block) demand calculation.

• Voltage Harmonics: These screens show per-phase voltage harmonic histograms.

• Current Harmonics: These screens show per-phase current harmonic histograms.

• Instantaneous Demand: This screen shows kW delivered and received.

• Flicker (ION8650A and ION8650B only): This screen displays flicker measurements 
from V1, V2 and V3.

• Frequency: This screen displays frequency information.

ALT mode Time of Use (TOU) display screens

The ALT mode TOU display screens are factory-configured to show Time of Use (TOU) 
data. The measurements displayed originate from frameworks of modules that are 
linked to a TOU module. By default, only one season is configured in the sample TOU 
schedule; until you configure other seasons, all data appears under that one season. 
For details about the TOU module, refer to the ION Reference.

By default, all demand values result from sliding window (rolling block) calculations. 

NOTE: The following abbreviations are used on the TOU display screens:
PB = Past Billing period. A billing period is the time between two consecutive meter
readings for billing purposes by a utility.
PS = Previous Season. Billing Seasons are defined in the TOU module description in
the ION Reference.

• Active TOU Rate: This screen shows which of the valid TOU billing rates is active.

Sliding Window (Rolling Block)

CONFIG Length of the demand period multiplied by the number of demand periods

UPDATE Length of the demand period

SYNC Clock synchronization source

MAX (kW) Maximum kW Demand1
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• Active TOU Season: This screen shows which TOU billing season is currently 
active.

• TOU Energy by Rate: This screen shows kWh delivered values for each TOU rate.

• kW Peak Demand: These screens display the maximum kW delivered value for 
each TOU rate. These values result from sliding window (rolling block) demand 
calculations.

• Past Billing Energy: This screen displays the kWh delivered values for each TOU 
rate in the previous billing period. 

• Past Billing Peak Demand: These screens display the maximum kW delivered value 
for each TOU rate in the previous billing period. These values result from sliding 
window (rolling block) demand calculations.

• Past Season Energy: This screen displays the kWh delivered for each TOU rate in 
the past billing season. These values result from sliding window (rolling block) 
demand calculations.

• Past Season Peak Demand: These screens display the maximum kW delivered for 
each TOU rate in the past billing season.

• Past Billing/Season Energy: These screens display the kWh delivered and received 
values in the past billing period and billing season.

• Past Bill/ Season Pk Demand: These screens show the maximum kW received 
values in the past billing period and billing season. These values result from a sliding 
window (rolling block) demand calculation.

• Past Billing/Season Energy: These screens display the kVARh delivered and 
received values in the past billing period and billing season.

• Past Bill/Season Pk Demand: These screens display the maximum kVAR delivered 
and received values in the past billing period and billing season. These values result 
from a sliding window (rolling block) demand calculation.

• Past Billing/Season Energy: These screens display the kVAh delivered and received 
values in the past billing period and billing season.

• Past Bill/Season Pk Demand: These screens display the maximum kVA delivered 
and received values in the past billing period and billing season. These values result 
from a sliding window (rolling block) demand calculation.

TEST mode default display screens
The values shown in the TEST mode display screens represent different accumulators 
than those shown in NORM mode (although they perform some of the same basic 
measurements). The TEST mode display values are for the purpose of checking 
accuracy; they only accumulate while the meter is in TEST mode. 

Viewing TEST mode

There are two ways to switch the meter into TEST mode depending on the type of meter 
you have:

• Standard meter (without hardware lock): You must use Power Monitoring Expert or 
ION Setup; refer to “Switching to TEST mode” on page 199.

• Standard hardware-locked meter: You must remove the cover from the meter and 
press the TEST mode button; refer to “Performing a master reset from the front 
panel” on page 207 for detailed instructions on removing the meter’s cover.
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When the meter is in TEST mode, the front panel cycles through four TEST mode 
display screens: 

• kWh Test: This screen shows TEST mode kWh delivered and received values.

• kVARh/KVAh Test: This screen shows TEST mode kVARh/KVAh delivered and 
received values.

• Instantaneous Demand Test: This screen shows TEST mode kW delivered and 
received values. Both quantities are produced from a sliding window (rolling block) 
demand calculation. This value is reset if the demand reset switch is turned while the 
device is in TEST mode.
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Display brightness control
The Brightness setup register in the Display Options module allows you to set the 
display to one of four different brightness levels. The brightness level is controlled 
through ION Setup.

1. Start ION Setup.

2. Connect to your meter in Advanced Mode.

3. Navigate to the Display Option Modules folder and double-click on the Display 
Option module in the right-hand pane.

4. Select the Setup Register tab.

5. Select the Brightness register and click Edit.

6. Select a brightness level (Dim, Standard, Bright, Extra Bright) from the dropdown 
list and click OK.

7. Click Send to save your changes to the meter.



7EN02-0306-03 197

Chapter 17 TEST mode
This chapter describes your meter’s TEST mode and explains how to switch from 
Normal mode to TEST mode. 

In this chapter
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Introduction
TEST mode is typically used for verifying meter function. The meter is usually reading 
data from a test power supply while these functions are performed. 

Several things to note about TEST mode:

• All of the billing quantities that are recorded when the meter is in Normal mode stop 
accumulating when the meter is switched to TEST mode — the data is sent to 
special TEST mode registers instead. 

• The values accumulated in these test registers are displayed on the front panel and 
in Power Monitoring Expert or ION Setup. 

• The regular normal mode billing registers are unaffected while the meter is in TEST 
mode; accumulation of this data continues as soon as you exit TEST mode. 

• All test registers are reset to zero when you exit TEST mode.

NOTE: The meter always returns to NORM mode when you exit TEST mode, even if
you entered TEST mode from ALT mode.

You cannot place a hardware-locked meter in TEST mode using Power Monitoring 
Expert or ION Setup. The meter must be placed in TEST mode using the front panel.

Refer to the PowerLogic ION8650 accuracy verification technical note for final accuracy 
verification test details and procedure.
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Switching to TEST mode
Place the meter into TEST mode using the front panel, ION Setup or Vista. The meter’s 
front panel informs you when the meter is in TEST mode with a special display screen.

Using the front panel
The TEST mode button on the meter is located beneath the outer cover. You must first 
remove the cover to access the button. Refer to the ION8650 Installation guide for 
instructions and safety precautions.

After you remove the outer cover, press the TEST mode button.

NOTE: If you have a hardware-locked meter, only the basic communications
parameters can be changed in NORM mode. You must enter TEST mode to change
other meter parameters on the hardware-locked meter. See “Additional revenue
metering security” on page 77 for more details.

Using ION Setup
NOTE: You cannot place a hardware-locked meter in TEST mode using ION Setup.
The meter must be placed in TEST mode using the front panel. See “Using the front
panel” above.

In ION Setup:

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select the Verification screen.

3. Select Test Mode on the Verification tab and click Edit. Enter your meter password 
if prompted. A dialog box informs you that the meter is in Test mode. Click OK.

The Test Mode screen appears and test values are displayed.

DANGER
HAZARD OF ELECTRIC SHOCK
Wear PPE and take precautions not to touch the meter’s lever contact switches 
if accessing the front panel buttons of a switchboard meter.

Failure to follow these instructions will result in death or serious injury.

TEST
MODE
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Click on the tabs to perform various test-related tasks. See the ION Setup online help 
for more information.

4. Click Scaling on the Energy tab if you want to apply PT/CT scaling to the values 
displayed in Test mode. The default is OFF (no scaling is applied). 

5. Click Loss Mode on the Volts, Amps and Power tab if you want any transformer 
loss compensation that you have configured applied to values in TEST mode.

6. Click Close. A dialog box informs you that the meter is back in Normal mode.

Using Vista
NOTE: You cannot place a hardware-locked meter in TEST mode using Power
Monitoring Expert. The meter must be placed in TEST mode using the front panel. See
“Using the front panel” on page 199.

1. Open your meter in Vista.

2. Select the Setup/Diagnostics tab and click General Setup.

3. Select the Test Mode option for Meter Mode. You are prompted for the Power 
Monitoring Expert user password. If meter security is enabled, you are also 
prompted for the meter password. For more information see the Vista section of the 
online Power Monitoring Expert Help.
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Changing TEST mode timeout
If no front panel buttons are pressed, the meter exits TEST mode after 30 minutes 
(1800 seconds) by default, if the default TEST mode timeout value has not been 
changed. The timeout value resets to 30 minutes each time you press any front panel 
button. While in TEST mode, the value on the bottom right of the status bar indicates 
the amount of time before TEST mode times out. The meter always returns to NORM 
mode when the TEST mode timeout elapses.

You can change the value of the TEST mode timeout using Power Monitoring Expert, 
ION Setup or the front panel. 

Using the front panel
Follow these steps to change the TEST mode timeout using the front panel:

NOTE: You must be in TEST mode to change the TEST mode timeout if your meter is
hardware-locked.

1. Enter the SETUP menu by holding down the ALT/ENTER button.

2. Scroll through the menu items, highlight DISPLAY OPTIONS, and press the ALT/
ENTER button.

3. Scroll down and highlight the TEST MODE TO menu item. Press ALT/ENTER. The 
current TEST mode timeout is displayed.

4. Enter the new value of the TEST mode timeout in seconds. Use the up or down 
arrow buttons to change the value of the highlighted digit. Press the up or down 
arrow button to change the position of the highlight cursor. Press the ALT/ENTER 
button.

5. Select YES to confirm the change. Enter the meter password if prompted.

Using ION Setup
1. Connect to the meter in Advanced Mode. See the ION Setup Help for instructions.

2. Locate the Display Options module in the module list and double-click to open the 
module.

3. Click the Setup Registers tab and double-click the Test Mode Timeout setup 
register.

4. Set the Test Mode Timeout to the desired time. You can choose from a numeric 
bounded format or an elapsed interval format.

5. Click Send to save the changes to the meter.

Using Designer
1. Open your meter in Designer. 

2. Double-click the Display Setup folder.

The timer indicates 
the TEST mode 
timeout.
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3. Right-click on the Display Options module to access the setup registers. Select the 
Test Mode Timeout setup register and click Modify to edit.

4. Set the Test Mode Timeout to the desired time.

5. Click OK to send the changes to the meter.
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TEST mode default display screens
The values shown in the TEST mode display screens represent different accumulators 
than those shown in NORM mode (although they perform some of the same basic 
measurements). The TEST mode display values are for accuracy checking purposes; 
they only accumulate while the meter is in TEST mode. 

In TEST mode, the front panel cycles through four TEST mode display screens:

• kWh TEST: This screen shows TEST mode kWh delivered and received values.

• kVARh/KVAh TEST: This screen shows TEST mode kVARh/KVAh delivered and 
received values.

• Instantaneous Demand TEST: This screen shows TEST mode kW delivered and 
received values. Both quantities are produced from a sliding window (rolling block) 
demand calculation. This value is reset if the demand reset switch is turned while the 
device is in TEST mode.
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TEST mode LED energy pulsing
Above the display screen are two pairs of energy pulsing LEDs and infrared outputs. 
The LEDs and IR outputs are factory-configured to pulse while the meter is in TEST 
mode.

The energy pulsing LEDs provide an interface for accuracy checking instruments. The 
Kt label indicates the factory-configured pulsing rate. (You can change the energy 
pulsing frequency with Power Monitoring Expert or ION Setup.) See “Configuring 
energy pulsing” on page 156 for more information on configuring the LED settings. 

WATT infrared 
output

VAR infrared 
output

VAR LEDWATT LEDThe Kt label 
indicates the 
default pulsing 
rate
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Chapter 18 Resets
This chapter provides instructions for performing various meter resets.
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Performing a reset
Resets allow you to clear various accumulated parameters stored by the meter.

Performing a master reset

To perform a master reset on a hardware-locked meter, you must remove the front 
cover and press the master reset button. See “Master resets and hardware-locked 
meters” on page 209 for more information.

With a meter that is not hardware-locked, you can perform a master reset via software. 
It does not have to be in TEST mode.

Parameters affected by a master reset
The master reset deletes most accumulated values and all derived revenue 
measurements from the meter, clears the meters event and waveform logs, and clears 
COMTRADE waveform records from the meter’s internal FTP server. The mode that the 
meter is in (NORM mode or TEST mode - see “Modes of Operation” on page 31) 
defines the values that are reset.

NORM or ALT mode

In NORM or ALT mode, the following parameters are reset to zero:

• Energy and Demand

• Peak Demand 

• Loss Calculation

• Long-term Min/Max

• Power Quality disturbance counters 

• Time of Use 

The following are cleared:

• Event Log

• All Data Recorders

• All Waveform Recorders

• All COMTRADE files

TEST mode

All TEST mode Energy and Demand measurements are set to zero.

NOTICE
DATA LOSS
Ensure all important data from the device has been retrieved before you perform 
a master reset.

Failure to follow these instructions can result in data loss.
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Performing a demand reset

Parameters affected by a demand reset
The mode that the meter is in (for example, NORM mode or TEST mode) defines the 
values that will be reset.

• NORM mode: resets the peak demand values logged in the meter.

• TEST mode: resets the test demand parameters to zero. 

Demand Lockout Time
The setup register labeled Demand Lockout Time (Display Options module) sets the 
minimum time allowed between consecutive demand resets; the meter ignores any 
attempts to reset the demand outside the bounds of the register. 

The default value for the Demand Lockout time is 25 days. For details on the Demand 
Lockout Time setup register, refer to “Configuring demand reset lockout time” on 
page 138.

For more details on the Display Options module, see the ION Reference.

Using the front panel

Performing a master reset from the front panel
The master reset button is recessed to avoid accidental activation. You must first 
remove the meter’s cover before you can perform a master reset.

1. Remove the front cover of the meter. Refer to the ION8650 Installation guide for 
instructions and safety precautions.

2. Using a pin or similar instrument, press and hold the master reset button. The 
message All recorded data will be lost HOLD TO CONTINUE is displayed. Hold 
the master reset button for 5 seconds to continue with the reset.

NOTE: Do not configure or power down your meter until the meter’s front panel displays
a message stating that the master reset is complete. If you configure or power down
your meter during a master reset, the affected parameters may not be completely reset. 

Performing a demand reset from the front panel 
The demand reset switch can be activated with the cover on or off. 

DANGER
HAZARD OF ELECTRIC SHOCK
Wear PPE and take precautions not to touch the meter’s lever contact switches 
if accessing the front panel buttons of a switchboard meter.

Failure to follow these instructions will result in death or serious injury.

MASTER
RESET

All recorded data will be lost
HOLD TO CONTINUE
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In most applications, the demand reset switch is sealed with an anti-tamper 
mechanism; a through-hole in the switch can accommodate either an external seal or 
a locking mechanism. See “Demand reset switch seal” on page 78 for details of anti-
tamper sealing.

NOTE: A Demand Lockout Time register sets the minimum time allowed between
consecutive demand resets; the meter ignores any attempts to reset the demand
outside the bounds of the register. The default value for the Demand Lockout Time is
25 days (2160000s).

Using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions. 

2. Select the Verification screen.

3. Select Normal Mode and click Display.

4. Select the desired tab in the Normal Mode dialog box. Two resets are available: 
Peak Reset and Master Reset. Click the appropriate button to perform the reset 
(Peak Demand in the example below).
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A dialog box informs you when the reset is complete.

NOTE: Do not configure or power down your meter until a message appears stating
that the master reset is complete. If you configure or power down your meter during a
master reset, the affected parameters may not be completely reset. 

Using Vista

Open your meter in Vista. You can perform several resets from within Vista.

Performing a master reset

NOTE: The master reset is not accessible via software in a hardware-locked meter,
whether the meter is in TEST, ALT or NORM mode. A master reset on a hardware-
locked meter can only be performed from the front panel. See “Master resets and
hardware-locked meters” on page 209 for details. 
With a meter that is not hardware-locked, you can perform a master reset via software.
It does not need to be in TEST mode.

1. Click the Setup/Diagnostics tab and click the General icon.

2. Click the Master Reset icon.

NOTE: Do not configure or power down your meter until a message appears stating
that the master reset is complete. If you configure or power down your meter during a
master reset, the affected parameters may not be completely reset. 

Performing a peak demand reset

1. Click the Revenue tab and click the Demand Max icon.

2. Click the Peak demand reset icon.

Performing a Min/Max reset

1. Click the Volts/Amps tab and click the Long-term min/max icon.

2. Click the Reset Min/Max icon.

Performing a Sag/Swell or Harmonics Min/Max reset

1. Click the Power Quality tab

2. Click Reset counters to reset the disturbance counters. Click the Harmonics 
Details icon then click Reset Min/Max to reset the harmonics min/max values.

NOTE: The master reset is not accessible via software in a hardware-locked meter,
whether the meter is in TEST, ALT or NORM mode. A master reset on a hardware-
locked meter can only be performed from the front panel. See “Master resets and
hardware-locked meters” on page 209 for details. 
With a meter that is not hardware-locked, you can perform a master reset via software.
It does not need to be in TEST mode.

Master resets and hardware-locked meters

The master reset is not accessible via software in a hardware-locked meter, whether 
the meter is in TEST, ALT or NORM mode. A complete master reset on a hardware-
locked meter can only be performed by pressing the master reset button on the meter’s 
front panel. See “Performing a master reset from the front panel” on page 207.
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TEST mode

In TEST mode, a screen is displayed stating that the master reset is unavailable:

Normal mode, Locked

In this case the meter attempts the master reset, but revenue and event logs are not 
cleared. The rest of the master reset is successful.
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Chapter 19 Setpoints
This chapter provides instructions for configuring meter setpoints.

In this chapter
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Introduction
The Relative Setpoint module provides extensive non-critical control, secondary 
protection, and analysis capabilities by allowing you to initiate an action in response to 
a specific condition. It is particularly useful for performing actions based on differences 
between a value (for example, kW on phase A) relative to a reference value (for 
example, kW demand for all three phases). Use this module’s outputs for demand 
control of equipment or any other applications requiring setpoint activity relative to a 
varying value. See the ION Reference for more information on the Relative Setpoint 
module.

WARNING
HAZARD OF UNINTENDED OPERATION
• Do not use the meter for critical control or protection applications where human 

or equipment safety relies on the operation of the control circuit.
• Be aware that an unexpected change of state of the digital outputs may result 

when the supply power to the meter is interrupted or after a meter firmware or 
template upgrade.

Failure to follow these instructions can result in death, serious injury or 
equipment damage.
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Configuring setpoints
Use Power Monitoring Expert or ION Setup to change your meter’s setpoints.

Using the front panel
You cannot configure setpoints using the front panel.

Using ION Setup
1. Connect to your meter in Advanced Mode. 

2. Click on the Relative Setpoint module you want to configure.

Using Vista
Open your meter in Vista and click on the Setpoints tab. Click the Setup icon. Use the 
switches to turn various monitoring on and off (see circled below). Click the numeric 
boxes to edit condition settings.

Relative Setpoint module settings

By default, the following Relative Setpoint modules are configured:

NOTE: There is usually no need to change any of the Relative Setpoint modules’ setup
registers for normal operation of the meter.

See the ION Reference for more information on the Relative Setpoint module.

Fine tuning over condition monitoring
If you want to fine-tune over condition monitoring, the only setup registers you should 
change are SusUntlON and SusUntlOFF. 

SusUntlON determines how long the modules wait after an over condition is detected 
before reporting it. This gives the monitored value a short period to correct itself before 
the event is registered with the module so that very brief over conditions are ignored. 
Similarly, SusUntlOFF is the amount of time a normal value must be present before the 
module considers normal operation to be restored. Both SusUntlON and SusUntlOFF 
values are entered in seconds.

Label Description

Over KW sd When active, this annunciates when the total kW sliding window demand 
exceeds a specified amount.

Over I a When active, this annunciates when the current on phase A exceeds a 
specified amount.

Over I b When active, this annunciates when the current on phase B exceeds a 
specified amount.

Over I c When active, this annunciates when the current on phase C exceeds a 
specified amount.

Over V unbal When active, this annunciates if the voltage unbalance exceeds a specified 
amount.

Phase 1 loss, Phase 2 
loss, Phase 3 loss

When active, these annunciate if the phase voltage drops below the Sag/
Swell module’s Nom Volts register by a specified amount.

V1, V2, V3 (+/- 15%) for 
10m, 10s, 3s

When active, these annunciate when the phase voltage deviates from the 
Sag/Swell module’s Nom Volts register by a specified amount.
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Chapter 20 Reports
This chapter provides instructions for viewing various meter reports and logs.

In this chapter
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Introduction
Accumulated meter values are saved in logs. These logs can be acquired by your 
energy management software and saved in its database for analysis and reporting. 

The Web Reporter component of Power Monitoring Expert is a database reporting 
application that lets you define, generate, and manage comprehensive reports based 
on the information in your system database. It processes selected data and generates 
a finished report. 

For more information on reports, see the Web Reporter section of the online Power 
Monitoring Expert Help.
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Viewing meter logs
View meter logs using Power Monitoring Expert, ION Setup or the front panel.

Using the front panel
The front panel only displays recent high priority events (Event Log). 

Press ALT/ENTER to access the ALT display then press the up and down arrow 
buttons to navigate to the Event Log.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions. 

2. Select the Reports screen.

3. Select one of the logs or comparisons in the list and click Display to view the 
associated log. 

Below is an example of an Events Log. 
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4. You can view, save or print the log. Click Close to exit.

See also “Viewing data log information” on page 167 for information on viewing data log 
information in ION Setup.

Using Vista
Open your meter in Vista and click on the various tabs available. Click an icon to view 
the associated logs. The following logs are available in Vista:

• Volts/Amps tab:

– Meter Events

– Voltage

– Current

– Power

– Frequency/PF

• Revenue tab:

– Logged Interval data

• Power Quality tab:

– Harmonics Trending

– Transient & Sag/Swell Statistics CBEMA

– Waveforms/Sequence of Events

– EN50160
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